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Preface

1. Foreword

Wireshark is one of those programs that many network managers would love to be able to use, but
they are often prevented from getting what they would like from Wireshark because of the lack of
documentation.

This document is part of an effort by the Wireshark team to improve the usability of Wireshark.

We hope that you find it useful, and look forward to your comments.
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2. Who should read this document?

Theintended audience of this book is anyone using Wireshark.

This book will explain all the basics and also some of the advanced features that Wireshark
provides. As Wireshark has become a very complex program since the early days, not every feature
of Wireshark might be explained in this book.

This book is not intended to explain network sniffing in general and it will not provide details about
specific network protocols. A lot of useful information regarding these topics can be found at the
Wireshark Wiki at http://wiki.wireshark.org

By reading this book, you will learn how to install Wireshark, how to use the basic elements of the
graphical user interface (like the menu) and what's behind some of the advanced features that are
maybe not that obvious at first sight. It will hopefully guide you around some common problems
that frequently appears for new (and sometimes even advanced) users of Wireshark.
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4. About this document

This book was originally developed by Richard Sharpe with funds provided from the Wireshark
Fund. It was updated by Ed Warnicke and more recently redesigned and updated by UIf L amping.

It iswritten in DocBook/XML.
Y ou will find some specially marked partsin this book:
Thisisawarning!

Y ou should pay attention to a warning, as otherwise data loss might occur.

—a Thisisa notel

A note will point you to common mistakes and things that might not be obvious.

Thisisatip!
%
Tipswill be helpful for your everyday work using Wireshark.
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5. Where to get the latest copy of this
document?

The latest copy of this documentation can always be found at: http:// www.wireshark.org/ docs/
#usersquide.
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6. Providing feedback about this document

Should you have any feedback about this document, please send them to the authors through wire-
shark-dev[AT]wireshark.org.
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Chapter 1. Introduction
1.1. What is Wireshark?

1.1.1.

1.1.2.

Wireshark is a network packet analyzer. A network packet analyzer will try to capture network
packets and tries to display that packet data as detailed as possible.

You could think of a network packet analyzer as a measuring device used to examine what's going
on inside a network cable, just like a voltmeter is used by an electrician to examine what's going on
inside an electric cable (but at a higher level, of course).

In the past, such tools were either very expensive, proprietary, or both. However, with the advent of
Wireshark, al that has changed.

Wireshark is perhaps one of the best open source packet analyzers available today.

Some intended purposes

Here are some examples people use Wireshark for:

» network administrators use it to troubleshoot network problems
» network security engineers use it to examine security problems
» developersuseit to debug protocol implementations

e people useittolearn network protocol internals

Beside these examples, Wireshark can be helpful in many other situations too.

Features

The following are some of the many features Wireshark provides:

* Available for UNIX and Windows.

» Capturelive packet data from a network interface.

» Display packets with very detailed protocol information.

* Open and Save packet data captured.

* Import and Export packet data from and to alot of other capture programs.
» Filter packets on many criteria.

» Search for packets on many criteria.

» Colorize packet display based on filters.

+ Createvarious statistics.

* ..andalot more!

However, to really appreciate its power, you have to start using it.

Figure 1.1, “ Wireshark captures packets and allows you to examine their_content. ” shows Wire-
shark having captured some packets and waiting for you to examine them.




1.1.3.

1.1.4.

1.1.5.

1.1.6.

1.1.7.

Introduction

Figure 1.1. Wireshark captures packets and allows you to examine their
content.
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Live capture from many different network media
Despite its name, Wireshark can capture traffic from network media other than Ethernet. Which me-
dia types are supported, depends on many things like the operating system you are using. An over-

view of the supported media types can be found at: http://wiki.wireshark.org/ CaptureSetup/ Net-
workMedia.

Import files from many other capture programs

Wireshark can open packets captured from a large number of other capture programs. For a list of
input formats see Section 5.2.2, “Input File Formats’.

Export files for many other capture programs

Wireshark can save packets captured in alarge number of formats of other capture programs. For a
list of output formats see Section 5.3.2, “ Output File Formats’.

Many protocol decoders

There are protocol decoders (or dissectors, as they are known in Wireshark) for a great many proto-
cols: see Appendix B, Protocols and Protocol Fields.

Open Source Software



http://wiki.wireshark.org/CaptureSetup/NetworkMedia
http://wiki.wireshark.org/CaptureSetup/NetworkMedia

Introduction

Wireshark is an open source software project, and is released under the GNU_General Public Li-
cence (GPL). You can freely use Wireshark on any number of computers you like, without worrying
about license keys or fees or such. In addition, al source codeis freely available under the GPL. Be-
cause of that, it is very easy for people to add new protocols to Wireshark, either as plugins, or built
into the source, and they often do!

1.1.8. What Wireshark is not

Here are some things Wireshark does not provide:

*  Wireshark isn't an intrusion detection system. It will not warn you when someone does strange
things on your network that he/she isn't allowed to do. However, if strange things happen, Wire-
shark might help you figure out what is really going on.

e Wireshark will not manipulate things on the network, it will only "measure" things from it.
Wireshark doesn't send packets on the network or do other active things (except for name resolu-
tions, but even that can be disabled).
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1.2. Platforms Wireshark runs on

1.2.1.

1.2.2.

Wireshark currently runs on most UNIX platforms and various Windows platforms. It requires
GTK+, GLib, libpcap and some other librariesin order to run.

If a binary package is not available for your platform, you should download the source and try to
build it. Please report your experiences to wireshark-dev[ AT]wireshark.org.

Binary packages are available for at least the following platforms:

Unix

* AppleMac OS X
e BeOS

* FreeBSD

«  HP-UX

 [IBM AIX

* NetBSD

e OpenBSD

»  SCO UnixWare/OpenUnix
oSGl Irix

e Sun Solarig/Intel

* Sun Solaris/Sparc

e True4 UNIX (formerly Digital UNIX)

Linux

» Debian GNU/Linux

* Gentoo Linux

* IBM S/390 Linux (Red Hat)
* Mandrake Linux

e PLD Linux

* RedHat Linux

* Rock Linux

» Sackware Linux

e SuselLinux
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1.2.3. Microsoft Windows

Maintained:

»  Windows Server 2003/ XP/ 2000/ NT 4.0

*  WindowsMe/ 98
Unsupported/Unmaintained (because lack of required libraries):

*  Windows CE
*  Windows NT / XP Embedded

*  Windows 95 is no longer actively maintained by WinPcap, but still may work perfectly
No experiences (fresh versions):

*  Windows XP 64-bit Edition
»  Windows Vista (aka Longhorn)

Please provide your experiences about these fresh versions to: wireshark-dev[AT]wireshark.org.
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1.3. Where to get Wireshark?

You can get the latest copy of the program from the Wireshark website; ht-
tp://www.wireshark.org/download.html. The website allows you to choose from among several mir-
rors for downloading.

A new Wireshark version will typically become available every 4-8 weeks.

If you want to be notified about new Wireshark releases, you should subscribe to the wireshark-an-
nounce mailing list. Y ou will find more detailsin Section 1.6.4, “Mailing Lists’.
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1.4. A brief history of Wireshark

In late 1997, Gerald Combs needed a tool for tracking down networking problems and wanted to
learn more about networking, so he started writing Ethereal (the former name of the Wireshark
project) as away to solve both problems.

Ethereal was initially released, after several pauses in development, in July 1998 as version 0.2.0.
Within days, patches, bug reports, and words of encouragement started arriving, so Ethereal was on
its way to success.

Not long after that Gilbert Ramirez saw its potential and contributed a low-level dissector to it.

In October, 1998, Guy Harris of Network Appliance was looking for something better than tcpview,
so he started applying patches and contributing dissectors to Ethereal.

In late 1998, Richard Sharpe, who was giving TCP/IP courses, saw its potential on such courses,
and started looking at it to see if it supported the protocols he needed. While it didn't at that point,
new protocols could be easily added. So he started contributing dissectors and contributing patches.

The list of people who have contributed to Ethereal has become very long since then, and almost all
of them started with a protocol that they needed that Ethereal did not already handle. So they copied
an existing dissector and contributed the code back to the team.

In 2006 the project moved house and re-emerged under a new name: Wireshark.
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1.5. Development and maintenance of
Wireshark

Wireshark was initially developed by Gerald Combs. Ongoing development and maintenance of
Wireshark is handled by the Wireshark team, a loose group of individuals who fix bugs and provide
new functionality.

There have also been a large number of people who have contributed protocol dissectors to Wire-
shark, and it is expected that this will continue. You can find a list of the people who have contrib-
uted code to Wireshark by checking the about dialog box of Wireshark, or at the authors page on the
Wireshark web site.

Wireshark is an open source software project, and is released under the GNU General Public Li-
cence (GPL). All source code is freely available under the GPL. Y ou are welcome to modify Wire-
shark to suit your own needs, and it would be appreciated if you contribute your improvements back
to the Wireshark team.

Y ou gain three benefits by contributing your improvements back to the community:

* Other people who find your contributions useful will appreciate them, and you will know that
you have helped people in the same way that the devel opers of Wireshark have helped people.

» The developers of Wireshark might improve your changes even more, as there's always room for
improvements. Or they may implement some advanced things on top of your code, which can be
useful for yourself too.

e The maintainers and developers of Wireshark will maintain your code as well, fixing it when
API changes or other changes are made, and generally keeping it in tune with what is happening
with Wireshark. So if Wireshark is updated (which is done often), you can get a new Wireshark
version from the website and your changes will already be included without any effort for you.

The Wireshark source code and binary kits for some platforms are all available on the download
page of the Wireshark website: http://www.wireshark.org/download.html.
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1.6. Reporting problems and getting help

1.6.1.

1.6.2.

1.6.3.

1.6.4.

If you have problems, or need help with Wireshark, there are several places that may be of interest
to you (well, beside this guide of course).

Website

You will find lot's of useful information on the Wireshark homepage at http://www.wireshark.org.
WiKi

The Wireshark Wiki at http://wiki.wireshark.org provides a wide range of information related to
Wireshark and packet capturing in general. You will find alot of information not part of this user's
guide. For example, there is an explanation how to capture on a switched network, an ongoing effort
to build a protocol reference and alot more.

And best of al, if you would like to contribute your knowledge on a specific topic (maybe a net-
work protocol you know well), you can edit the wiki pages by simply using your webbrowser.

FAQ

The "Frequently Asked Questions' will list often asked questions and the corresponding answers.

Read the FAQ!
Before sending any mail to the mailing lists below, be sure to read the FAQ, as it will

often answer the question(s) you might have. Thiswill save yourself and others alot of
time (keep in mind that alot of people are subscribed to the mailing lists).

You will find the FAQ inside Wireshark by clicking the menu item Help/Contents and selecting the
FAQ page in the upcoming dialog.

An online version is available at the Wireshark website: http://www.wireshark.org/fag.html. You
might prefer this online version, asit's typically more up to date and the HTML format is easier to
use.

Mailing Lists

There are several mailing lists of specific Wireshark topics available:

wireshark-announce This mailing list will inform you about new program releases, which
usually appear about every 4-8 weeks.

wireshark-users This list is for users of Wireshark. People post questions about build-
ing and using Wireshark, others (hopefully) provide answers.

wireshark-dev Thislist is for Wireshark developers. If you want to start developing a
protocol dissector, join thislist.

You can subscribe to each of these lists from the Wireshark web site: http://www.wireshark.org.
Simply select the mailing lists link on the left hand side of the site. The lists are archived at the
Wireshark web site aswell.

Tip!

%
You can search in the list archives to see if someone asked the same question some
time before and maybe already got an answer. That way you don't have to wait until
SOmeone answers your question.
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1.6.5. Reporting Problems

—h Note!
Before reporting any problems, please make sure you have installed the latest version
of Wireshark.

When reporting problems with Wireshark, it is helpful if you supply the following information:

1. The version number of Wireshark and the dependent libraries linked with it, eg GTK+, etc.
Y ou can obtain this with the command wireshark -v.

2. Information about the platform you run Wireshark on.
3. A detailed description of your problem.

4. If you get an error/warning message, copy the text of that message (and also afew lines before
and after it, if there are some), so others may find the place where things go wrong. Please don't
give something like: "I get a warning while doing x" as this won't give a good idea where to
look at.

— Don't send largefiles!
Do not send large files (>100K B) to the mailing lists, just place a note that further data

is available on request. Large files will only annoy a lot of people on the list who are
not interested in your specific problem. If required, you will be asked for further data
by the persons who really can help you.

@ Don't send confidential infor mation!

If you send captured data to the mailing lists, be sure they don't contain any sensitive
or confidential information like passwords or such.

1.6.6. Reporting Crashes on UNIX/Linux platforms

When reporting crashes with Wireshark, it is helpful if you supply the traceback information
(besides the information mentioned in "Reporting Problems").

Y ou can obtain this traceback information with the following commands:

$ gdb “whereis wireshark | cut -f2 -d: | cut -d" ' -f2° core >& bt.txt
backtrace

"D

$

_ﬁ Note
Typethe charactersin the first line verbatim! Those are back-tics there!
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Note

backtrace is a gdb command. You should enter it verbatim after the first line shown
above, but it will not be echoed. The ~D (Control-D, that is, press the Control key and
the D key together) will cause gdb to exit. This will leave you with a file called
bt . t xt inthe current directory. Include the file with your bug report.

Note
If you do not have gdb available, you will have to check out your operating system's
debugger.

Y ou should mail the traceback to the wireshark-dev[AT]wireshark.org mailing list.

Reporting Crashes on Windows platforms

The Windows distributions don't contain the symbol files (.pdb), because they are very large. For
this reason it's not possible to create a meaningful backtrace file from it. You should report your
crash just like other problems, using the mechanism described above.

11
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Chapter 2. Building and Installing
Wireshark

2.1. Introduction

As with all things, there must be a beginning, and so it is with Wireshark. To use Wireshark, you
must:

e Obtain abinary package for your operating system, or

» Obtain the source and build Wireshark for your operating system.

Currently, only two or three Linux distributions ship Wireshark, and they are commonly shipping an
out-of-date version. No other versions of UNIX ship Wireshark so far, and Microsoft does not ship
it with any version of Windows. For that reason, you will need to know where to get the latest ver-

sion of Wireshark and how to install it.

This chapter shows you how to obtain source and binary packages, and how to build Wireshark
from source, should you choose to do so.

The following are the general steps you would use:

1. Download the relevant package for your needs, e.g. source or binary distribution.
2. Build the sourceinto abinary, if you have downloaded the source.
This may involve building and/or installing other necessary packages.

3. Install the binariesinto their final destinations.

13
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2.2. Obtaining the source and binary
distributions

You can obtain both source and binary distributions from the Wireshark web site: ht-
tp://www.wireshark.org. Simply select the download link, and then select either the source package
or binary package of your choice from the mirror site closest to you.

_ﬁ Download all required files!

In general, unless you have aready downloaded Wireshark before, you will most
likely need to download several source packages if you are building Wireshark from
source. Thisis covered in more detail below.

Once you have downloaded the relevant files, you can go on to the next step.

Notel

While you will find a number of binary packages available on the Wireshark web site,
you might not find one for your platform, and they often tend to be several versions
behind the current released version, as they are contributed by people who have the
platforms they are built for.

For this reason, you might want to pull down the source distribution and build it, as the
processisrelatively simple.
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2.3. Before you build Wireshark under UNIX

Before you build Wireshark from sources, or install a binary package, you must ensure that you
have the following other packages installed:
e GTK+, The GIMP Tool Kit.
Y ou will also need Glib. Both can be obtained from www.gtk.org
 libpcap, the packet capture software that Wireshark uses.

Y ou can obtain libpcap from www.tcpdump.org

Depending on your system, you may be able to install these from binaries, e.g. RPMs, or you may
need to obtain them in source code form and build them.

If you have downloaded the source for GTK+, the instructions shown in Example 2.1, “Building
GTK+ from source” may provide some help in building it:

Example 2.1. Building GTK+ from source

gzip -dc gtk+-1.2.10.tar.gz | tar xvf -
<much out put renoved>

cd gtk+-1.2.10

./ configure

<much out put renoved>

make

<much out put renoved>

make install

<much out put renoved>

Notel

[

Y ou may need to change the version number of gtk+ in Example 2.1, “Building GTK+
from source” to match the version of GTK+ you have downloaded. The directory you
change to will change if the version of GTK+ changes, and in all cases, tar xvf - will
show you the name of the directory you should change to.

Notel

W

If you use Linux, or have GNU tar installed, you can use tar zxvf gtk+-1.2.10.tar.gz.
It is also possible to use gunzip -c or gzcat rather than gzip -dc on many UNIX sys-
tems.

Notel

[

If you downloaded gtk+ or any other tar file using Windows, you may find your file
caled gtk+-1 2 8 tar.gz.

You should consult the GTK+ web site if any errors occur in carrying out the instructions in Ex-
ample 2.1, “Building GTK+ from source”.

If you have downloaded the source to libpcap, the general instructions shown in Example 2.2,
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“Building and installing libpcap” will assist in building it. Also, if your operating system does not
support tcpdump, you might also want to download it from the tcpdump web site and install it.

Example 2.2. Building and installing libpcap

gzip -dc libpcap-0.9.4.tar.Z | tar xvf -
<nmuch out put renoved>

cd libpcap-0.9.4

./ configure

<much out put renoved>

make

<much out put renoved>

make install

<much out put renoved>

—h Notel

The directory you should change to will depend on the version of libpcap you have
downloaded. In all cases, tar xvf - will show you the name of the directory that has
been unpacked.

Under RedHat 6.x and beyond (and distributions based on it, like Mandrake) you can ssimply install
each of the packages you need from RPMs. Most Linux systemswill install GTK+ and GLib in any-
case, however, you will probably need to install the devel versions of each of these packages. The
commands shown in Example 2.3, * Installing required RPMs under RedHat Linux 6.2 and beyond
” will install al the needed RPMsiif they are not already installed.

Example 2.3. Installing required RPMsunder RedHat Linux 6.2 and beyond

cd / mt/ cdr om RedHat / RPNVS

rpm-ivh glib-1.2.6-3.i386.rpm
rpm-ivh glib-devel-1.2.6-3.i386.rpm
rpm-ivh gtk+-1.2.6-7.i386.rpm
rpm-ivh gtk+-devel-1.2.6-7.i386.rpm
rpm-ivh |ibpcap-0.4-19.i386.rpm

— Note
If you are using a version of RedHat later than 6.2, the required RPMs have most
likely changed. Simply use the correct RPMs from your distribution.

Under Debian you can install Wireshark using apt-get. apt-get will handle any dependency issues
for you. Example 2.4, “Installing debs under Debian” shows how to do this.

Example 2.4. Installing debs under Debian

apt-get install wreshark-dev
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2.4. Building Wireshark from source under

UNIX

Use the following general steps if you are building Wireshark from source under a UNIX operating
system:

1.

Unpack the source from its gzip'd tar file. If you are using Linux, or your version of UNIX
uses GNU tar, you can use the following command:

tar zxvf wireshark-0.99.3-tar.gz

For other versions of UNIX, Y ou will want to use the following commands:

gzip -d wreshark-

0.99.3-tar.gz
tar xvf wireshark-0.99.3-tar

ﬁ Notel
The pipeline gzip -dc wireshark-0.99.3-tar.gz | tar xvf - will work here as well.

4 Notel

If you have downloaded the Wireshark tarball under Windows, you may find that
your browser has created a file with underscores rather than periods in its file
name.

Change directory to the Wireshark source directory.

Configure your source so it will build correctly for your version of UNIX. You can do this with
the following command:

./configure

If this step fails, you will have to rectify the problems and rerun configure. Troubleshooting
hints are provided in Section 2.6, “ Troubleshooting during the install on Unix”.

Build the sourcesinto a binary, with the make command. For example:

nmake

Install the software in itsfinal destination, using the command:

make install
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Once you have installed Wireshark with make install above, you should be able to run it by enter-
ing wireshark.
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2.5. Installing the binaries under UNIX

2.5.1.

2.5.2.

In general, installing the binary under your version of UNIX will be specific to the installation meth-
ods used with your version of UNIX. For example, under AlX, you would use smit to install the
Wireshark binary package, while under Tru64 UNIX (formerly Digital UNIX) you would use setld.

Installing from rpm's under RedHat and alike

Use the following command to install the Wireshark RPM that you have downloaded from the
Wireshark web site:

rpm-ivh wreshark-0.99. 3.i386.rpm

If the above step fails because of missing dependencies, install the dependencies first, and then retry
the step above. See Example 2.3, * Installing required RPMs under RedHat Linux 6.2 and beyond ”
for information on what RPMs you will need to have installed.

Installing from deb's under Debian

Use the following command to install Wireshark under Debian:
apt-get install wreshark

apt-get should take care of al of the dependency issues for you.
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2.6. Troubleshooting during the install on
Unix

A number of errors can occur during the installation process. Some hints on solving these are

provided here.

If the configure stage fails, you will need to find out why. Y ou can check thefileconfi g. 1 ogin
the source directory to find out what failed. The last few lines of this file should help in determining

the prablem.

The standard problems are that you do not have GTK+ on your system, or you do not have a recent
enough version of GTK+. The configure will also fail if you do not have libpcap (at least the re-

quired include files) on your system.

Another common problem is for the final compile and link stage to terminate with a complaint of:
Output too long. Thisis likely to be caused by an antiquated sed (such as the one shipped with Sol-
aris). Since sed is used by the libtool script to construct the final link command, this leads to mys-
terious problems. This can be resolved by downloading a recent version of sed from http://direct-

ory.fsf.org/GNU/sed.html.

If you cannot determine what the problems are, send mail to the wireshark-dev mailing list explain-
ing your problem, and including the output from conf i g. | og and anything else you think is rel-

evant, like atrace of the make stage.
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2.7. Building from source under Windows

It is recommended to use the binary installer for Windows, until you want to start devel oping Wire-
shark on the Windows platform.

For further information how to build Wireshark for Windows from the sources, have a look at the
Development Wiki: http://wiki.wireshark.org/Development for the latest available development
documentation.
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2.8. Installing Wireshark under Windows

In this section we explore installing Wireshark under Windows from the binary packages.

2.8.1. Install Wireshark

You may acquire a binary instaler of Wireshark named something like: wi r eshar k-
set up-Xx.y. z. exe.

Simply download the Wireshark installer from: http://www.wireshark.org/download.htmi#rel eases
and execute it.

_ﬁ Note!
The WinPcap installer has become part of the main Wireshark installer, so you
don't need to download and install two separ ate packages

2.8.1.1. Command line options

You can simply start the Wireshark installer without any command line parameters, it will show you
the usual interactive installer.

There are some command line parameters available:

* /NCRC disablesthe CRC check

* /Srunsthe installer or uninstaller silently with default values. Please note: The silent installer
won't install WinPCap!

» /desktopicon installation of the desktop icon, =yes - force installation, =no - don't install, other-
wise use defaults/ user settings. This option can be useful for asilent installer.

» /quicklaunchicon installation of the quick launch icon, =yes - force installation, =no - don't in-
stall, otherwise use defaults / user settings.

» /D sets the default installation directory ($INSTDIR), overriding InstallDir and InstallDir-
RegKey. It must be the last parameter used in the command line and must not contain any
quotes, even if the path contains spaces.

Example:

Wi reshar k- set up- 0. 99. 3. exe / NCRC /S / deskt opi con=yes
/ qui ckl aunchi con=no / D=C:\ Program Fi | es\ Foo

2.8.1.2. Components

Beside the usual installer options like where to install the program, there are several optional com-
ponents.

Tip!
%
If you are unsure which settings to select, just keep the default settings.

The Components (both Wireshark GTK 1 and 2 cannot be installed at the same time):
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e Wireshark GTK1 - Wireshark isa GUI network protocol analyzer.

* Wireshark GTK2 - Wireshark is a GUI network protocol analyzer (using the modern GTK2
GUI toolkit, recommended).

e GTK-Wimp - GTKWimp is the GTK2 windows impersonator (native Win32 look and feel, re-
commended).

» TShark - TShark is acommand-line based network protocol analyzer.

The dissection extensions for Wireshark and TShark:

» Dissector Plugins - Plugins with some extended dissections.
» Tree Statistics Plugins - Plugins with some extended statistics.

 Mate- Meta Analysis and Tracing Engine (experimental) - user configurable extension(s) of
the display filter engine, see http://wiki.wireshark.org/Mate for details.

e Lua Plugin (experimental) - a language for prototyping and scripting, see ht-
tp://wiki.wireshark.org/L ua for details.

* SNMP MIBs- SNMP MIBsfor amore detailed SNMP dissection.

The Tools:

» Editcap - Editcap is aprogram that reads a capture file and writes some or all of the packetsinto
another capturefile.

o Text2Pcap - Text2pcap is a program that reads in an ASCII hex dump and writes the datainto a
libpcap-style capturefile.

e Mergecap - Mergecap is a program that combines multiple saved capture files into a single out-
put file.

» Capinfos- Capinfosis aprogram that provides information on capture files.

The Additiona Tasks:

e Start Menu Shortcuts - add some start menu shortcuts.
» Desktop Icon - add an Wireshark icon to the desktop.
e Quick Launch Icon - add an Wireshark icon to the Explorer quick launch toolbar.

» Associatefile extensionsto Wireshark - Associate standard network trace files to Wireshark.

Install WinPcap

M— Notel

As mentioned above, the Wireshark installer takes care of theinstallation of Win-
Pcap, so usually you don't have to worry about WinPcap at all!

If you do not have WinPcap installed you will be able to open saved capture files, but you will not
be able to capture live network traffic.

While running, the Wireshark installer detects which WinPcap version is currently installed and will
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install WinPcap, if none or an older version is detected.

More WinPcap info:

*  Wireshark related: http://wiki.wireshark.org/WinPcap

*  General WinPcap info: http://www.winpcap.org

2.8.2.1. Manual WinPcap Installation

2.8.3.

2.8.4.

2.8.5.

The following is only necessary if you want to try a different version than the one included in the
Wireshark installer, e.g. because a new WinPcap (beta) version was released.

Additional WinPcap versions (including newer alpha or beta releases) can be downloaded from the
following locations:

e The main WinPcap site; http://www.winpcap.org

* The Wiretapped.net mirror: http://www.mirrors.wiretapped.net/security/packet-capture/winpcap

At the download page you will find a single installer exe called something like "auto-installer”,
which can be installed under various Windows systems, including 9x/Me/NT4.0/2000/XP.

Update Wireshark

From time to time you may want to update your installed Wireshark to a more recent version. If you
join Wireshark's announce mailing list, you will be informed about new Wireshark versions, see
Section 1.6.4, “Mailing Lists” for details how to subscribeto thislist.

New versions of Wireshark usually become available every 4-8 weeks. Updating Wireshark is done
the same way as installing it, you simply download and start the installer exe. A reboot is usualy
not required and all your personal settings remain unchanged.

Update WinPcap

New versions of WinPcap are less frequently available, maybe only once in a year. You will find
WinPcap update instructions where you can download new WinPcap versions. Usually you have to
reboot the machine after installing a new WinPcap version.

@ Warning!
If you have an older version of WinPcap installed, you must un-install it before in-
stalling the current version. Recent versions of the WinPcap installer will take care of
this.

Uninstall Wireshark

Y ou can uninstall Wireshark the usual way, using the "Add or Remove Programs' option inside the
Control Panel. Select the "Wireshark" entry to start the uninstallation procedure.

The Wireshark uninstaller will provide several options which things to be uninstalled, the default is
to remove the core components but keep the personal settings, WinPcap and alike.

WinPcap won't be uninstalled by default, as other programs than Wireshark may useit as well.
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Building and Installing Wireshark

2.8.6. Uninstall WinPcap

You can uninstall WinPcap independantly of Wireshark, using the "WinPcap" entry in the "Add or
Remove Programs" of the Control Panel.

ﬁ Note!
After uninstallation of WinPcap you can't capture anything with Wireshark.

It might be a good idea to reboot Windows afterwards.
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Chapter 3. User Interface

3.1. Introduction

By now you have installed Wireshark and are most likely keen to get started capturing your first
packets. In the next chapters we will explore:
* How the Wireshark user interface works
How to capture packets in Wireshark
» How to view packetsin Wireshark
How to filter packets in Wireshark

» ... and many other things!
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3.2. Start Wireshark

Y ou can start Wireshark from your shell or window manager.

Q
4

Tip!

When starting Wireshark it's possible to specify optional settings using the command
line. See Section 9.2, “ Start Wireshark from the command line” for details.

Notel

In the following chapters, alot of screenshots from Wireshark will be shown. As Wire-
shark runs on many different platforms and there are different versions of the underly-
ing GUI toolkit (GTK 1.x / 2.X) used, your screen might look different from the
provided screenshots. But as there are no real differences in functionality, these
screenshots should still be well understandable.
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3.3. The Main window

Lets look at Wireshark's user interface. Figure 3.1, “The Main window” shows Wireshark as you
would usually seeit after some packets captured or loaded (how to do thiswill be described later).

Figure 3.1. The Main window
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Wireshark's main window consist of parts that are commonly known from many other GUI pro-
grams.

1. Themenu (see Section 3.4, “The Menu”) is used to start actions.

2. Themain toolbar (see Section 3.13, “The "Main" toolbar”) provides quick access to frequently
used items from the menu.

3. Thefilter toolbar (see Section 3.14, “The "Filter" toolbar”) provides away to directly manipu-
late the currently used display filter (see Section 6.3, " Filtering packets while viewing”).

4. The packet list pane (see Section 3.15, “The "Packet List" pane”) displays a summary of each
packet captured. By clicking on packets in this pane you control what is displayed in the other
two panes.

5. The packet details pane (see Section 3.16, “The "Packet Details' pane”) displays the packet se-
lected in the packet list pane in more detail.

6. The packet bytes pane (see Section 3.17, “The "Packet Bytes' pane”) displays the data from the
packet selected in the packet list pane, and highlights the field selected in the packet details
pane.
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7. The statusbar (see Section 3.18, “The Statusbar”) shows some detailed information about the
current program state and the captured data.

Tip!

%
The layout of the main window can be customized by changing preference settings.
See Section 9.5, “Preferences’ for details!
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3.4. The Menu

The Wireshark menu sits on top of the Wireshark window. An exampleis shown in Figure 3.2, “The

Menu”.

Notel

Menu items will be greyed out if the corresponding feature isn't available. For ex-
ample, you cannot save a capture file if you didn't capture or load any data before.

Figure 3.2. The Menu

File Edit Miew Go Capture  Analyze  Statistics  Help

It contains the following items:

File

Edit

View

Go

Capture

Analyze

Statistics

Help

This menu contains items to open and merge capture files, save / print / export
capture filesin whole or in part, and to quit from Wireshark. See Section 3.5, “The
"File" menu”.

This menu contains items to find a packet, time reference or mark one or more
packets, set your preferences, (cut, copy, and paste are not presently implemented).
See Section 3.6, “ The "Edit" menu”.

This menu controls the display of the captured data, including the colorization of
packets, zooming the font, show a packet in a separate window, expand and col-
lapse trees in packet details, .... See Section 3.7, “The "View" menu”.

This menu contains items to go to a specific packet. See Section 3.8, “The "Go"

menu .

This menu allows you to start and stop captures and to edit capture filters. See Sec-
tion 3.9, “The "Capture” menu”.

This menu contains items to manipulate display filters, enable or disable the dis-
section of protocols, configure user specified decodes and follow a TCP stream.
See Section 3.10, “The "Analyze' menu”.

This menu contains menu-items to display various statistic windows, including a
summary of the packets that have been captured, display protocol hierarchy statist-
ics and much more. See Section 3.11, “The "Statistics' menu”.

This menu contains items to help the user, like access to some basic help, alist of
the supported protocols, manual pages, online access to some of the webpages, and
the usual about dialog. See Section 3.12, “The "Help" menu”.

Each of these menu itemsis described in more detail in the sections that follow.

Q

Tip!

Y ou can access menu items directly or by pressing the corresponding accelerator keys,
which are shown at the right side of the menu. For example, you can press the Control
(or Strg in German) and the K keys together to open the capture dialog.
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3.5. The "File" menu

The Wireshark file menu contains the fields shown in Table 3.1. “File menu items”.

Figure3.3. The" File" Menu
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Table 3.1. File menu items

Menu Item Accelerator Description
Open... Ctrl+O

This menu item brings up the file open dialog box that allows
you to load a capture file for viewing. It is discussed in more
detail in Section 5.2.1, “The "Open Capture File" dialog
box”.

Open Recent
This menu item shows a submenu containing the recently
opened capture files. Clicking on one of the submenu items
will open the corresponding capture file directly.

Merge...
This menu item brings up the merge file dialog box that al-
lows you to merge a capture file into the currently loaded
one. It is discussed in more detail in Section 5.4, “Merging
capture files”.

Close Ctrl+wW
This menu item closes the current capture. If you haven't
saved the capture, you will be asked to do so first (this can be
disabled by a preference setting).
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Accelerator

Description

Ctrl+S

This menu item saves the current capture. If you have not set
a default capture file name (perhaps with the -w <capfile>
option), Wireshark pops up the Save Capture File As dialog
box (which is discussed further in Section 5.3.1, “The "Save

Capture File As' dialog box”).

5
4

If you have aready saved the current capture,
this menu item will be greyed out.

Notel

You cannot save a live capture while it is in
progress. You must stop the capture in order to
save.

Save As...

Shift+Ctrl+S

This menu item allows you to save the current capture file to
whatever file you would like. It pops up the Save Capture
File As dialog box (which is discussed further in Sec-
tion 5.3.1, “The "Save Capture File As" dialog box”).

File Set > List
Files

This menu item allows you to show alist of filesin afile set.
It pops up the Wireshark List File Set dialog box (which is
discussed further in Section 5.5, “File Sets").

File Set > Next
File

If the currently loaded file is part of a file set, jump to the
next file in the set. If it isn't part of afile set or just the last
filein that set, thisitem is greyed out.

File Set > Pre-
vious File

If the currently loaded file is part of a file set, jump to the
previous file in the set. If it isn't part of a file set or just the
first filein that set, thisitem is greyed out.

> as
Text"

Export
"Plain
file...

This menu item alows you to export all, or some, of the
packets in the capture file to a plain ASCII text file. It pops
up the Wireshark Export dialog box (which is discussed fur-
ther in Section 5.6.1, “The "Export as Plain Text File" dialog
box").

Export > as

This menu item allows you to export the (or some) of the
packets in the capture file to a PostScript file. It pops up the
Wireshark Export dialog box (which is discussed further in

Section 5.6.2, “The "Export as PostScript File" dialog box”).

" PostScript"
file...

Export > as
" CSy"
(Comma Sep-
arated Values
packet sum-
mary) file...

This menu item allows you to export the (or some) of the
packet summaries in the capture file to a .csv file (e.g. used
by spreadsheet programs). It pops up the Wireshark Export
dialog box (which is discussed further in Section 5.6.3, “The
"Export as CSV (Comma Seperated Values) File" dialog
box").
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Menu Item Accelerator Description

Export > as

"PSML" file.. This menu item allows you to export the (or some) of the
packets in the capture file to a PSML (packet summary
markup language) XML file. It pops up the Wireshark Export
dialog box (which is discussed further in Section 5.6.4, “The
"Export as PSML File" dialog box”).

Export > as

"PDML" file.. This menu item allows you to export the (or some) of the
packets in the capture file to a PDML (packet details markup
language) XML file. It pops up the Wireshark Export dialog
box (which is discussed further in Section 5.6.5, “The "Ex-
port as PDML File" dialog box™).

Export > Selec-|Ctrl+H

ted Packet This menu item allows you to export the currently selected

Bytes... bytes in the packet bytes pane to a binary file. It pops up the
Wireshark Export dialog box (which is discussed further in
Section 5.6.6, “The "Export selected packet bytes' dialog
box”)

Print Ctrl+P
This menu item allows you to print al (or some of) the pack-
ets in the capture file. It pops up the Wireshark Print dialog
box (which is discussed further in Section 5.7, “Printing
packets’).

Quit Ctrl+Q

This menu item allows you to quit from Wireshark. Wire-
shark will ask to save your capture file if you haven't saved it
before (this can be disabled by a preference setting).
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3.6. The "Edit" menu

The Wireshark Edit menu contains the fields shown in Table 3.2, “ Edit menu items”.

Figure3.4. The" Edit" Menu
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Table 3.2. Edit menu items

Menu Item Accelerator Description
Find Packet... |Ctrl+F

This menu item brings up a dialog box that allows you to find
a packet by many criteria. There is further information on
finding packetsin Section 6.7, “Finding packets’.

Find Next Ctrl+N
This menu item tries to find the next packet matching the set-
tings from "Find Packet...".

Find Previous |Ctrl+B
This menu item tries to find the previous packet matching the
settings from "Find Packet...".

Mark  Packet|Ctrl+M
(toggle) This menu item "marks" the currently selected packet. See
Section 6.9, “Marking packets’ for details.

Find Next | Shift+Ctrl+N
Mark Find the next marked packet.
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Menu Item

Accelerator

Description

Find Previous
Mark

Shift+Ctrl+B

Find the previous marked packet.

Mark All Pack-

ets This menu item "marks" all packets.

Unmark All

Packets This menu item "unmarks" all marked packets.
Set Time Refer- | Ctrl+T

ence (toggle)

This menu item set a time reference on the currently selected
packet. See Section 6.10.1, “Packet time referencing” for
more information about the time referenced packets.

Find Next Ref-
erence

This menu item tries to find the next time referenced packet.

Find Previous
Reference

This menu item tries to find the previous time referenced
packet.

Shift+Ctrl+P

This menu item brings up a dialog box that allows you to set
preferences for many parameters that control Wireshark. You
can also save your preferences so Wireshark will use them
the next time you start it. More detail is provided in Sec-
tion 9.5, “Preferences’.
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3.7. The "View" menu

The Wireshark View menu contains the fields shown in Table 3.3, “View menu items”.

Figure3.5. The" View" Menu
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Table 3.3. View menu items
Menu Item Accelerator Description
Main Toolbar
This menu item hides or shows the main toolbar, see Sec-
tion 3.13, “The "Main" toolbar”.
Filter Toolbar
This menu item hides or shows the filter toolbar, see Sec-
tion 3.14, “The "Filter" toolbar”.
Statusbar
This menu item hides or shows the statusbar, see Sec-
tion 3.18, “ The Statusbar”.
Packet List
This menu item hides or shows the packet list pane, see Sec-
tion 3.15, “The "Packet List" pane”.
Packet Details
This menu item hides or shows the packet details pane, see
Section 3.16, “The "Packet Details" pane”.
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Menu Item Accelerator Description

Packet Bytes
This menu item hides or shows the packet bytes pane, see
Section 3.17, “The "Packet Bytes' pane”.

Time Display

Format > Date
and Time of
Day:
1970-01-01
01:02:03.12345
6

Selecting this tells Wireshark to display the time stamps in
date and time of day format, see Section 6.10, “Time display
formats and time references’.

E Notel

The fields "Time of Day", "Date and Time of
Day", "Seconds Since Beginning of Capture"
and " Seconds Since Previous Packet" are mutu-

aly exclusive.

Time Display
Format > Time
of Day:

01:02:03.12345
6

Selecting this tells Wireshark to display time stamps in time
of day format, see Section 6.10, “Time display formats and
time references’.

Time Display
Format > Selecting this tells Wireshark to display time stamps in
Seconds Since seconds since beginning of capture format, see Section 6.10
Beginning  of “Time display formats and time references’.
Capture:
123.123456
Time Display
Format > Selecting this tells Wireshark to display time stamps in
Seconds Since seconds since previous packet format, see Section 6.10
Previous Pack- “Time display formats and time references”.
et: 1.123456
Time Display
Format > ------
Time Display
Format > Auto- Selecting this tells Wireshark to display time stamps with the
matic (File precision given by the capture file format used, see Sec-
Format Preci- tion 6.10, “Time display formats and time references’.
sion)
Note!
The fields "Automatic', "Seconds' and
"...seconds' are mutually exclusive.
Time Display
For mat > Selecting this tells Wireshark to display time stamps with a
Seconds: 0 precision of one second, see Section 6.10, “Time display
formats and time references’.
Time Display
For mat > Selecting this tells Wireshark to display time stamps with a
...seconds:; O.... precision of one second, decisecond, centisecond, milli-

second, microsecond or nanosecond, see Section 6.10, “Time
display formats and time references”.

Name Resolu-
tion > Resolve
Name

This item alows you to trigger a name resolve of the current
packet only, see Section 7.6, “Name Resolution”.

Name Resolu-

This item allows you to control whether or not Wireshark
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Menu Item

Accelerator

Description

tion > Enable
for MAC Layer

transdates MAC addresses into names, see Section 7.6
“Name Resolution”.

Name Resolu-
tion > Enable
for Networ k
Layer

This item allows you to control whether or not Wireshark
trandlates network addresses into names, see Section 7.6
“Name Resolution”.

Name Resolu-
tion > Enable
for Transport
Layer

This item alows you to control whether or not Wireshark
trandlates transport addresses into names, see Section 7.6
“Name Resolution”.

Colorize Packet
List

This item alows you to control wether or not Wireshark
should colorize the packet list.

a Notel!

Enabling colorization will slow down the dis-
play of new packets while capturing / loading
capturefiles.

Auto Scroll in

Live Capture This item allows you to specify that Wireshark should scroll
the packet list pane as new packets come in, so you are al-
ways looking at the last packet. If you do not specify this,
Wireshark simply adds new packets onto the end of the ligt,
but does not scroll the packet list pane.

Zoom In Ctrl++
Zoom into the packet data (increase the font size).

Zoom Out Ctrl+-

Zoom out of the packet data (decrease the font size).

Normal Size Ctrl+=
Set zoom level back to 100% (set font size back to normal).

Resize All

Columns Resize all column widths so the content will fit into it.

Note!
Resizing may take a significant amount of time,
especialy if alarge capturefile isloaded.

Expand  Sub-

trees This menu item expands the currently selected subtree in the
packet details tree.

Expand All
Wireshark keeps alist of all the protocol subtrees that are ex-
panded, and uses it to ensure that the correct subtrees are ex-
panded when you display a packet. This menu item expands
all subtreesin all packetsin the capture.

Collapse All

This menu item collapses the tree view of al packets in the
capture list.
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Menu Item Accelerator Description
Coloring
Rules... This menu item brings up a dialog box that allows you to col-

or packets in the packet list pane according to filter expres-
sions you choose. It can be very useful for spotting certain
types of packets, see Section 9.3, “Packet colorization”.

Show Packet in

New Window This menu item brings up the selected packet in a separate
window. The separate window shows only the tree view and
byte view panes.

Reload Ctrl-R

This menu item allows you to reload the current capturefile.
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3.8. The "Go" menu

The Wireshark Go menu contains the fields shown in Table 3.4, “Go menu items”.

Figure3.6. The" Go" Menu
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Table 3.4. Go menu items

Menu Item Accelerator Description
Back Alt+Left

Jump to the recently visited packet in the packet history,
much like the page history in aweb browser.

Forward Alt+Right
Jump to the next visited packet in the packet history, much
like the page history in aweb browser.

Goto Packet... |Ctrl-G
Bring up a dialog box that allows you to specify a packet
number, and then goes to that packet. See Section 6.8, “Go to
aspecific packet” for details.

Go to Corres
ponding Packet Go to the corresponding packet of the currently selected pro-
tocol field. If the selected field doesn't correspond to a pack-
et, thisitem is greyed out.

First Packet

Jump to the first packet of the capture file.
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Menuitem  |Accelerator | Description

Last Packet ‘

Jump to the last packet of the capturefile.
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3.9. The "Capture" menu

The Wireshark Capture menu contains the fields shown in Table 3.5, “Capture menu items”.

Figure3.7. The" Capture" Menu
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Table 3.5. Capture menu items

Menu Item Accelerator Description
I nterfaces...

This menu item brings up a dialog box that shows what's go-
ing on at the network interfaces Wireshark knows of, see
Section 4.4, “The "Capture Interfaces’ dialog box”) .

Options... Ctrl+K
This menu item brings up the Capture Options dialog box
(discussed further in Section 4.5, “The "Capture Options'
dialog box”) and allows you to start capturing packets.

Start
Immediately start capturing packets with the same settings
than the last time.

Stop Ctrl+E
This menu item stops the currently running capture, see Sec-
tion 4.9.1, “ Stop the running capture”) .

Restart

This menu item stops the currently running capture and starts
again with the same options, thisisjust for convenience.
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Menu Item Accelerator Description
Capture  Fil-
ters... This menu item brings up a dialog box that allows you to cre-

ate and edit capture filters. Y ou can name filters, and you can
save them for future use. More detail on this subject is
provided in Section 6.6, “ Defining and saving filters’
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3.10. The "Analyze" menu

The Wireshark Analyze menu contains the fields shown in Table 3.6, “Analyze menu items”.

Figure3.8. The" Analyze" Menu
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Table 3.6. Analyze menu items
Menu Item Accelerator Description
Display Fil-
ters... This menu item brings up a dialog box that allows you to cre-

ate and edit display filters. You can name filters, and you can
save them for future use. More detail on this subject is
provided in Section 6.6, “ Defining and saving filters’

Apply as Filter

> . These menu items will change the current display filter and
apply the changed filter immediately. Depending on the
chosen menu item, the current display filter string will be re-
placed or appended to by the selected protocol field in the
packet details pane.

Prepare a Fil-

ter > ... These menu items will change the current display filter but

won't apply the changed filter. Depending on the chosen
menu item, the current display filter string will be replaced or
appended to by the selected protocol field in the packet de-
tails pane.
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Menu Item Accelerator Description

Firewall ACL

Rules This allows you to create command-line ACL rules for many
different firewall products, including Cisco 10S, Linux Net-
filter (iptables), OpenBSD pf and Windows Firewall (via net-
sh). Rules for MAC addresses, |Pv4 addresses, TCP and
UDP ports, and 1Pv4+port combinations are supported.
It is assumed that the rules will be applied to an outside inter-
face.

Enabled Proto-|Shift+Ctrl+R

cols... This menu item allows the user to enable/disable protocol
dissectors, see Section 9.4.1, “The "Enabled Protocols' dia-
log box”

Decode As...
This menu item allows the user to force Wireshark to decode
certain packets as a particular protocol, see Section 9.4.2
“User Specified Decodes”

User Specified

Decodes... This menu item allows the user to force Wireshark to decode
certain packets as a particular protocol, see Section 9.4.3
“Show User Specified Decodes”

Follow TCP

Stream This menu item brings up a separate window and displays all
the TCP segments captured that are on the same TCP connec-
tion as a selected packet, see Section 7.2, “Following TCP
streams’

Follow SSL

Stream Same functionality as "Follow TCP Stream" but for SSL
streams. XXX - how to provide the SSL keys?

Expert Info
Open a dialog showing some expert information about the
captured packets in a log style display. The amount of in-
formation will depend on the protocol and varies from very
detailed to none existing. This is currently a work in pro-
gress. XXX - add anew section about this and link from here

Expert Info

Composite Same information as in "Expert Info" but trying to group

items together for faster anaysis.
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3.11. The "Statistics" menu

The Wireshark Statistics menu contains the fields shown in Table 3.7, “ Statistics menu items”.

Figure3.9. The" Statistics' Menu
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All menu itemswill bring up a new window showing specific statistical information.

Table 3.7. Statistics menu items

Menu ltem Accelerator Description
Summary

Show information about the data captured, see Section 8.2
“The "Summary"” window”.

Protocol Hier-
archy Display a hierarchical tree of protocol statistics, see Sec-
tion 8.3, “The "Protocol Hierarchy" window”.

Conversations
Display a list of conversations (traffic between two end-
points), see Section 8.5.2, “The "Conversations' window”.

Endpoints
Display a list of endpoints (traffic to/from an address), see
Section 8.4.2, “The "Endpoints” window”.

IO Graphs
Display user specified graphs (e.g. the number of packetsin
the course of time), see Section 8.6, “The "1O Graphs' win-
dow”.
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Menu Item Accelerator Description
Conversation
List Display a list of conversations, obsoleted by the combined
window of Conversations above, see Section 8.5.3, “The pro-
tocol specific "Conversation List" windows’.
Endpoint List
Display alist of endpoints, obsoleted by the combined win-
dow of Endpoints above, see Section 8.4.3, “The protocol
specific "Endpoint List" windows’.
Service Re-
sponse Time Display the time between a request and the corresponding re-
sponse, see Section 8.7, “Service Response Time”.
ANS|
See Section 8.8, “The protocol specific statistics windows”
GSM
See Section 8.8, “ The protocol specific statistics windows’
H.225...
See Section 8.8, “The protocol specific statistics windows’
ISUP Message
Types See Section 8.8, “The protocol specific statistics windows”
MTP3
See Section 8.8, “The protocol specific statistics windows”
RTP
See Section 8.8, “ The protocol specific statistics windows’
SCTP
See Section 8.8, “The protocol specific statistics windows’
SIP
See Section 8.8, “The protocol specific statistics windows’
VolP Calls...
See Section 8.8, “The protocol specific statistics windows”
WAP-WSP...
See Section 8.8, “The protocol specific statistics windows”
BOOTP-DHCP
See Section 8.8, “The protocol specific statistics windows”
HTTP
HTTP request/response statistics, see Section 8.8, “The pro-
tocal specific statistics windows’
I SUP M essages
See Section 8.8, “The protocol specific statistics windows”
ONC-RPC Pro-
grams See Section 8.8, “The protocol specific statistics windows’
TCP Stream
Graph See Section 8.8, “The protocol specific statistics windows”
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3.12. The "Help" menu

The Wireshark Help menu contains the fields shown in Table 3.8, “Help menu items”.

Figure3.10. The" Help" Menu
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Table 3.8. Help menu items

Menu ltem Accelerator Description
Contents F1

This menu item brings up a basic help system.

Supported Pro-
tocols This menu item brings up a dialog box showing the suppor-
ted protocols and protocol fields.

Manual Pages
> This menu item starts a Web browser showing one of the loc-
aly installed html manual pages.

Wireshark On-

line> ... This menu item starts a Web browser showing the chosen
webpage from: http://www.wireshark.org.

About  Wire

shark This menu item brings up an information window that

provides some information on Wireshark, such as the plu-
gins, the used folders, ...
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LRIV

Notel

Calling a Web browser might be unsupported in your version of Wireshark. If thisis
the case, the corresponding menu items will be hidden.

Notel

If calling a Web browser fails on your machine, maybe because just nothing happens
or the browser is started but no page is shown, have alook at the webbrowser setting
in the preferences dialog.
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3.13. The "Main" toolbar

The main toolbar provides quick access to frequently used items from the menu. This toolbar cannot
be customized by the user, but it can be hidden using the View menu, if the space on the screen is
needed to show even more packet data.

As in the menu, only the items useful in the current program state will be available. The others will
be greyed out (e.g. you cannot save a capture file if you haven't loaded one).

Figure3.11. The" Main" toolbar
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Table3.9. Main toolbar items

Toolbar |Toolbar Item Corresponding |Description

Icon Menu Item

E Interfaces... Capture/Inter-

' | faces... This item brings up the Capture Interfaces List

dialog box (discussed further in Section 4.3
“ Start Capturing”).

Options... Capture/Options...
This item brings up the Capture Options dialog

box (discussed further in Section 4.3, “ Start Cap-
turing”) and allows you to start capturing pack-

ets.
Start Capture/Start
This item starts capturing packets with the op-
tions form the last time.
Stop Capture/Stop
This item stops the currently running live capture

process Section 4.3, “Start Capturing”).

Restart Capture/Restart
This item stops the currently running live capture
process and restarts it again, for convenience.

Open... File/Open...
This item brings up the file open dialog box that
alows you to load a capture file for viewing. It is

discussed in more detail in Section 5.2.1, “The
"Open Capture File" dialog box”.

ﬁ- Save As... File/Save As...

'ﬁl This item allows you to save the current capture
file to whatever file you would like. It pops up
the Save Capture File As dialog box (which is
discussed further in Section 5.3.1, “The "Save
Capture File As' dialog box”).

Note!
If you currently have a temporary

capture file, the Save icon
(m ]

will be shown instead.
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et

Toolbar |Toolbar Item Corresponding |Description
Icon Menu Item
Close File/Close
This item closes the current capture. If you have
not saved the capture, you will be asked to save it
first.

‘,... - Reload View/Reload

. This item allows you to reload the current cap-
turefile.

=] Print... File/Print...

=== This item alows you to print al (or some of) the

— packets in the capture file. It pops up the Wire-
shark Print dialog box (which is discussed further
in Section 5.7, “Printing packets”).

Find Packet... Edit/Find Packet...
This item brings up a dialog box that allows you
to find a packet. There is further information on
finding packetsin Section 6.7, “Finding packets’.
Go Back Go/Go Back

Thisitem jumps back in the packet history.
Go Forward Go/Go Forward

Thisitem jumps forward in the packet history.

-~ Goto Packet... Go/Go to Packet...

' This item brings up a dialog box that allows you
to specify a packet number to go to that packet.
Go To First|Gol/First Packet
Packet This item jumps to the first packet of the capture
file
Go To Last Pack-|Gol/Last Packet

This item jumps to the last packet of the capture
file.

— Colorize View/Colorize
— Colorize the packet list (or not).
I
= Auto Scroll in|View/Auto Scroll
= Live Capture inLive Capture  |Auto scroll packet list while doing a live capture
(or not).
Zoom In View/Zoom In
Q Zoom into the packet data (increase the font
size).
Zoom Out View/Zoom Out
Zoom out of the packet data (decrease the font
size).
Normal Size View/Normal Size
Set zoom level back to 100%.
+ Resize Columns |View/Resize
Columns Resize columns, so the content fits into them.
-T CaptureFilters... | Capture/Capture
] '.| Filters... This item brings up a dialog box that allows you

to create and edit capture filters. You can name
filters, and you can save them for future use.
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Toolbar |Toolbar Item Corresponding |Description

Icon Menu Item
More detail on this subject is provided in Sec-
tion 6.6, “Defining and saving filters’.

T Display Filters... |Analyze/Display

H Filters... This item brings up a dialog box that allows you

to create and edit display filters. You can name
filters, and you can save them for future use.
More detail on this subject is provided in Sec-
tion 6.6, “Defining and saving filters’.

TE2
5=

Coloring Rules...

View/Coloring
Rules...

This item brings up a dialog box that allows you
color packets in the packet list pane according to
filter expressions you choose. It can be very use-
ful for spotting certain types of packets. More de-
tail on this subject is provided in Section 9.3
“Packet colorization”.

Preferences...

Edit/Preferences

This item brings up a dialog box that allows you
to set preferences for many parameters that con-
trol Wireshark. You can also save your prefer-
ences so Wireshark will use them the next time
you start it. More detail is provided in Sec-
tion 9.5, “Preferences’

Help

Help/Contents

Thisitem brings up help dialog box.
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3.14. The "Filter" toolbar

The filter toolbar lets you quickly edit and apply display filters. More information on display filters
isavailablein Section 6.3, “Filtering packets while viewing”.

Figure3.12. The" Filter" toolbar
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Table 3.10. Filter toolbar items

Toolbar
lcon

Toolbar Item

Description

Filter:

Brings up the filter construction dialog, described in Figure 6.8, “The
"Capture Filters' and "Display Filters' dialog boxes’.

Filter input

The area to enter or edit a display filter string, see Section 6.4
“Building display filter expressions’ . A syntax check of your filter
string is done while you are typing. The background will turn red if
you enter an incomplete or invalid string, and will become green
when you enter a valid string. You can click on the pull down arrow
to select a previously-entered filter string from a list. The entries in
the pull down list will remain available even after a program restart.

Notel
After you've changed something in this field, don't for-

get to press the Apply button (or the Enter/Return key),
to apply thisfilter string to the display.

Notel

W

Thisfield is also where the current filter in effect isdis-
played.

Expression...

The middle button labeled "Add Expression..." opens a dialog box
that lets you edit a display filter from a list of protocol fields, de-

scribed in Section 6.5, “ The "Filter Expression” dialog box”

Clear

Reset the current display filter and clears the edit area.

Apply

Apply the current value in the edit area as the new display filter.

—h Note!
Applying a display filter on large capture files might

take quite along time!
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3.15. The "Packet List" pane

The packet list pane displays all the packetsin the current capture file.

Figure3.13. The" Packet List" pane
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Each line in the packet list corresponds to one packet in the capture file. If you select aline in this
pane, more details will be displayed in the "Packet Details' and "Packet Bytes' panes.

While dissecting a packet, Wireshark will place information from the protocol dissectors into the
columns. As higher level protocols might overwrite information from lower levels, you will typic-
ally see the information from the highest possible level only.

For example, let'slook at a packet containing TCP inside IP inside an Ethernet packet. The Ethernet
dissector will write its data (such as the Ethernet addresses), the IP dissector will overwrite this by
its own (such asthe | P addresses), the TCP dissector will overwrite the IP information, and so on.

There are alot of different columns available. Which columns are displayed can be selected by pref-
erence settings, see Section 9.5, “Preferences’.

The default columns will show:
» No. The number of the packet in the capture file. This number won't change, even if a display
filter is used.

» Time The timestamp of the packet. The presentation format of this timestamp can be changed,
see Section 6.10, “Time display formats and time references’.

» Source The address where this packet is coming from.
» Destination The address where this packet is going to.
» Protocol The protocol name in a short (perhaps abbreviated) version.

e Info Additional information about the packet content.

Thereis acontext menu (right mouse click) available, see detailsin Figure 6.3, “ Pop-up menu of the
"Packet List" pane”.
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3.16. The "Packet Details" pane

The packet details pane shows the current packet (selected in the "Packet List" pane) in a more de-
tailed form.

Figure 3.14. The " Packet Details' pane

+ Frame 1 (42 bytes on wire, 42 bytes captured)
+ Ethernet II, Src: 192.168.0.2 (00:0b:sd:zo:cd:o0z), Dst: Broadcast (ff:ff: )
+ Address Resolution Protocol (request/gratuitous ARP)

This pane shows the protocols and protocol fields of the packet selected in the "Packet List" pane.
The protocols and fields of the packet are displayed using a tree, which can be expanded and col-
lapsed.

Thereis acontext menu (right mouse click) available, see detailsin Figure 6.4, “Pop-up menu of the
"Packet Details' pane”.

Some protocol fields are specially displayed.

» Generated fields Wireshark itself will generate additional protocol fields which are surrounded
by brackets. The information in these fields is derived from the known context to other packets
in the capture file. For example, Wireshark is doing a sequence/acknowledge analysis of each
TCP stream, which is displayed in the [SEQ/ACK analysig] fields of the TCP protocol.

» LinksIf Wireshark detected a relationship to another packet in the capture file, it will generate a
link to that packet. Links are underlined and displayed in blue. If double-clicked, Wireshark
jumps to the corresponding packet.
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3.17. The "Packet Bytes" pane

The packet bytes pane shows the data of the current packet (selected in the "Packet List" pane) in a
hexdump style.

Figure 3.15. The" Packet Bytes' pane

o000 T ff ff ff ff T 00 Ob 5d 20 cd 02 08 06 00 01 ........ ] veenns
o010 0% 00 06 04 00 01 00 ob 5d 20 cd 0Oz cO a% 00 02 ........ ]
0020 00 00 00 00 00 00 cO as 00 02

As usua for a hexdump, the left side shows the offset in the packet data, in the middle the packet
data is shown in a hexadecimal representation and on the right the corresponding ASCII characters
(or . if not appropriate) are displayed.

There is a context menu (right mouse click) available, see detailsin Figure 6.5, “Pop-up menu of the
"Packet Bytes' pane”.

Depending on the packet data, sometimes more than one page is available, e.g. when Wireshark has
reassembled some packets into a single chunk of data, see Section 7.5, “Packet Reassembling”. In
this case there are some additional tabs shown at the bottom of the pane to let you select the page
you want to see.

Figure 3.16. The" Packet Bytes' pane with tabs

0000 0% 00 06 ab 04 52 02 00 0 gb 7T bd 0% 00 45 00 crianaSe. WKW ES e
00l0 01 48 232 c7 00 00 le 11 dd 51 bc as 0% 0a bc as SHELLLLL . OQaeenns
ooz0 0% 3z 41 af OF 04 01 34 00 b4 04 00 Ze 00 10 0O ALl Ll
0030 00 00 00 00 ao de 37 & d1 11 82 71 00 57 80 O ....... T ...0.0.. -

Frame (342 bytes) | Reassembled DCE[RPC (1604 bytes)

_ﬁ Note!
The additional pages might contain data picked from multiple packets.

The context menu (right mouse click) of the tab labels will show alist of all available pages. This
can be helpful if the size in the pane istoo small for all the tab labels.
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3.18. The Statusbhar

The statusbar displays informational messages.

In general, the left side will show context related information, while the right side will show the cur-
rent number of packets.

Figure 3.17. Theinitial Statusbar

[Ready to lnad or capture [ Mo Packets

This statusbar is shown while no capture file is loaded, e.g. when Wireshark is started.

Figure 3.18. The Statusbar with aloaded capturefile

[File: test.cap 14 KB 00:00:02 [PrizoD:1zom:o

The left side shows information about the capture file, its name, its size and the elapsed time while it
was being captured.

The right side shows the current number of packets in the capture file. The following values are dis-
played:

e P: the number of captured packets

» D: the number of packets currently being displayed

e M: the number of marked packets

Figure 3.19. The Statusbar with a selected protocol field

bpcode {arp.oprode), 2 bytes |P: 1200: 120M: 0

Thisisdisplayed if you have selected a protocol field from the "Packet Details' pane.

Tip!

\
The value between the brackets (in this example ar p.opcode) can be used as a display
filter string, representing the selected protocol field.
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Chapter 4. Capturing Live Network
Data

4.1. Introduction

Capturing live network datais one of the major features of Wireshark.

The Wireshark capture engine provides the following features:

o Capture from different kinds of network hardware (Ethernet, Token Ring, ATM, ...).

» Stop the capture on different triggers like: amount of captured data, captured time, captured
number of packets.

e Simultaneoudly show decoded packets while keep on capturing.

» Filter packets, reducing the amount of data to be captured, see Section 4.8, “Filtering while cap-
turing”.

e Capturing into multiple files while doing a long term capture, and in addition the option to form
aringbuffer of these files, keeping only the last x files, useful for a"very long term" capture, see
Section 4.6, “Capture files and file modes”.

The capture engine till lacks the following features:

» Simultaneous capturing from multiple network interfaces (however, you can start multiple in-
stances of Wireshark and merge capture files later).

e Stop capturing (or doing some other action), depending on the captured data.
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4.2. Prerequisites

Setting up Wireshark to capture packets for the first time can be tricky.

Tip!

\
A comprehensive guide "How To setup a Capture” is available at: ht-
tp://wiki.wireshark.org/CaptureSetup.

Here are some common pitfals:

* You need to haveroot / Administrator privilegesto start alive capture.

* You need to choose the right network interface to capture packet data from.

* You need to capture at the right place in the network to see the traffic you want to see.
+ ..andalot morel.

If you have any problems setting up your capture environment, you should have alook at the guide
mentioned above.
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4.3. Start Capturing

One of the following methods can be used to start capturing packets with Wireshark:

* You can get an overview of the available local interfaces using the " Capture Interfaces"

dialog box, see Figure 4.1, “The "Capture Interfaces' dialog box”. You can start a capture from
this dialog box, using (one of) the "Capture" button(s).

* You can start capturing using the I; | Capture Options' dialog box, see Figure 4.2, “The

"Capture Options" dialog box”.

» If you have selected the right capture options before, you can immediately start a capture using
the @ Capture Start" menu / toolbar item. The capture process will start immediately.

» If you already know the name of the capture interface, you can start Wireshark from the com-
mand line and use the following:

wi reshark -i ethO -k

This will start Wireshark capturing on interface ethO, more details can be found at: Section 9.2
“ Start Wireshark from the command line”.
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4.4. The "Capture Interfaces" dialog box

When you select "Interfaces..." from the Capture menu, Wireshark pops up the "Capture Interfaces'
dialog box as shown in Figure 4.1, “The "Capture Interfaces" dialog box”.

@ Warning!
As the "Capture Interfaces" dialog is showing live captured data, it is consuming a lot
of system ressources. Close this dialog as soon as possible to prevent excessive system
load.

Note!

This dialog box will only show the local interfaces Wireshark knows of. As Wireshark
might not be able to detect all local interfaces, and it cannot detect the remote inter-
faces available, there could be more capture interfaces available than listed.

Figure4.1. The" CaptureInterfaces' dialog box

Wireshark: Capture Interfaces

Diescripkion IF Packets Packets)s

l ﬁgptinns dgetails

. Broadcom Netxtreme Gigabit Ethernet Driver I o 110 1 [ﬂgtert l lﬁgptinns l ldgetailsl

g. Adapter For generic dialup and YPM capture [ﬂﬁtart

Description The interface description provided by the operating system.

IP The first IP address Wireshark could resolve from this interface. If
no address could be resolved (e.g. no DHCP server available), "un-
known" will be displayed. If more than one IP address could be re-
solved, only the first is shown (unpredictable which one in that

case).

Packets The number of packets captured from this interface, since this dia-
log was opened. Will be greyed out, if no packet was captured in
the last second.

Packets/s Number of packets captured in the last second. Will be greyed out,
if no packet was captured in the last second.

Stop Stop a currently running capture.

Capture Start a capture on this interface immediately, using the settings
from the last capture.

Options Open the Capture Options dialog with this interface selected, see
Section 4.5, “ The "Capture Options' dialog box”.

Details (Win32 only) Open a dialog with detailed information about the interface.

Close Close this dialog box.
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4.5. The "Capture Options" dialog box

When you select Start... from the Capture menu (or use the corresponding item in the "Main" tool-

bar), Wireshark pops up the "Capture Options' dialog box as shown in Figure 4.2, “The "Capture
Options" dialog box”.

Figure4.2. The" Capture Options" dialog box

Wireshark: Capture Options

Capture

Intetface:  |Froadcom Metstreme Gigabit Ethernet Driver: \Device\MPF_{4C4DBSEB-ACI5-4B46-2 E]
IP address: 157.163.15.25

Buffer size: |1 megabytels)
Capture packets in promiscuous made
[ Limit each packet ko bytes
|E§apture Filker: E]
Capture Filels) Display Options

File: Update list of packets in real ke

[ ] Use multiple Files . o
fuktomatic scrolling in live capture

Hide capture info dialog
Mame Resolukion

Enable MAC name resolution
Stop Capture ...

[ ... after Enable network name resalution
[] ... after

7 .
] .. after Enable transport name resolution

&5&"“ H X Cancel ‘

Tip!
%
- If you are unsure which options to choose in this dialog box, just try keeping the de-
faults as this should work well in many cases.

Y ou can set the following fields in this dialog box:

4.5.1. Capture frame

Interface This field specifies the interface you want to capture on. You
can only capture on one interface, and you can only capture
on interfaces that Wireshark has found on the system. It is a
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IP address

Link-layer header type

Buffer size: n megabyte(s)

Capture packetsin promiscuous
mode

Limit each packet to n bytes

drop-down list, so ssimply click on the button on the right
hand side and select the interface you want. It defaults to the
first non-loopback interface that supports capturing, and if
there are none, the first loopback interface. On some systems,
loopback interfaces cannot be used for capturing (loopback
interfaces are not available on Windows platforms).

This field performs the same function as the -i <interface>
command line option.

The IP address(es) of the selected interface. If no address
could be resolved from the system, "unknown" will be shown.

Unless you are in the rare situation that you need this, just
keep the default. For a detailed description, see Section 4.7

“Link-layer header type”

Enter the buffer size to be used while capturing. This is the
size of the kernel buffer which will keep the captured packets,
until they are written to disk. If you encounter packet drops,
try increasing this value.

— Note
This option is only available on Windows plat-

forms.

This checkbox allows you to specify that Wireshark should
put the interface in promiscuous mode when capturing. If you
do not specify this, Wireshark will only capture the packets
going to or from your computer (not all packets on your LAN

segment).

—h Note
If some other process has put the interface in

promiscuous mode you may be capturing in
promiscuous mode even if you turn off this op-
tion

Note
Even in promiscuous mode you still won't ne-

cessarily see al packets on your LAN segment,

see http:/ / www.wireshark.org/
fag.html#promiscsniff for some more explana-
tions.

Thisfield allows you to specify the maximum amount of data
that will be captured for each packet, and is sometimes re-
ferred to as the snaplen. If disabled, the default is 65535,
which will be sufficient for most protocols. Some rules of
thumb:

e |If you are unsure, just keep the default value.
e If you don't need al of the data in a packet - for example,

if you only need the link-layer, IP, and TCP headers - you
might want to choose a small snapshot length, as less
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CaptureFilter

CPU time is required for copying packets, less buffer
space is required for packets, and thus perhaps fewer
packets will be dropped if traffic is very heavy.

e |If you don't capture all of the data in a packet, you might
find that the packet data you want is in the part that's
dropped, or that reassembly isn't possible as the data re-
quired for reassembly is missing.

This field allows you to specify a capture filter. Capture fil-
ters are discussed in more details in Section 4.8, “Filtering
while capturing”. It defaults to empty, or no filter.

You can aso click on the button labelled Capture Filter, and
Wireshark will bring up the Capture Filters dialog box and al-
low you to create and/or select afilter. Please see Section 6.6
“Defining and saving filters’

Capture File(s) frame

An explanation about capture file usage can be found in Section 4.6, “ Capture files and file modes’.

File

Use multiplefiles

Next file every n megabyte(s)

Next file every n minute(s)

Ring buffer with n files

Stop capture after n file(s)

This field allows you to specify the file name that will be
used for the capture file. This field is left blank by default. If
the field is left blank, the capture data will be stored in atem-

porary file, see Section 4.6, “Capture files and file modes” for
details.

You can also click on the button to the right of this field to
browse through the filesystem.

Instead of using a single file, Wireshark will automatically
switch to anew one, if a specific trigger condition is reached.

Multiple files only: Switch to the next file after the given
number of byte(s)/kilobyte(s)/megabyte(s)/gigabyte(s) have
been captured.

Multiple files only: Switch to the next file after the given
number of  second(s)/minutes(s)/hours(s)/days(s) have
elapsed.

Multiple files only: Form a ring buffer of the capture files,
with the given number of files.

Multiple files only: Stop capturing after switching to the next
file the given number of times.

Stop Capture... frame

... after n packet(s)

... after n megabytes(s)

Stop capturing after the given number of packets have been
captured.

Stop  capturing  after the given number  of
byte(s)/kilobyte(s)/megabyte(s)/gigabyte(s) have been cap-
tured. This option is greyed out, if "Use multiple files' is se-
lected.

68



Capturing Live Network Data

... after n minute(s)

Stop  capturing  after the given number  of
second(s)/minutes(s)/hours(s)/days(s) have el apsed.

4.5.4. Display Options frame

4.5.5.

4.5.6.

Updatelist of packetsinreal time This option allows you to specify that Wireshark should up-

Automatic scrolling in live cap-
ture

Hide captureinfo dialog

date the packet list pane in real time. If you do not specify
this, Wireshark does not display any packets until you stop
the capture. When you check this, Wireshark captures in a
separate process and feeds the captures to the display process.

This option alows you to specify that Wireshark should scroll
the packet list pane as new packets come in, so you are al-
ways looking at the last packet. If you do not specify this,
Wireshark simply adds new packets onto the end of the list,
but does not scroll the packet list pane. This option is greyed
out if "Update list of packetsin real time" is disabled.

If this option is checked, the following capture info dialog
will be hidden.

Name Resolution frame

Enable MAC name resolution

Enable network nameresolution

Enable transport nameresolu-
tion

Buttons

This option alows you to control whether or not Wireshark
translates MAC addresses into names, see Section 7.6. “Name
Resolution”.

This option allows you to control whether or not Wireshark
translates network addresses into names, see Section 7.6
“Name Resolution”.

This option alows you to control whether or not Wireshark
translates transport addresses into protocols, see Section 7.6
“Name Resolution”.

Once you have set the values you desire and have selected the options you need, simply click on
Start to commence the capture, or Cancel to cancel the capture.

If you start a capture, Wireshark allows you to stop capturing when you have enough packets cap-
tured, for details see Section 4.9, “While a Captureisrunning ...".
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4.6. Capture files and file modes

While capturing, the underlying libpcap capturing engine will grab the packets from the network
card and keep the packet data in a (relatively) small kernel buffer. This data is read by Wireshark
and saved into the capture file(s) the user specified.

Different modes of operation are available when saving this packet data to the capture file(s).

Q

4

Q

Tip!

Working with large files (several 100 MB's) can be quite low. If you plan to do along
term capture or capturing from a high traffic network, think about using one of the
"Multiple files" options. This will spread the captured packets over several smaller
files which can be much more pleasant to work with.

Notel

Using Multiple files may cut context related information. Wireshark keeps context in-
formation of the loaded packet data, so it can report context related problems (like a
stream error) and keeps information about context related protocols (e.g. where data is
exchanged at the establishing phase and only referred to in later packets). As it keeps
this information only for the loaded file, using one of the multiple file modes may cut
these contexts. If the establishing phase is saved in one file and the things you would
like to seeisin another, you might not see some of the valuable context related inform-
ation.

Tip!

Information about the folders used for the capture file(s), can be found in Appendix A,
Files and Folders.

Table 4.1. Capturefile mode selected by capture options

"File" option |"Use  multiple|" Ring buffer [Mode Resulting file
files' option with n files' op- name(s) used
tion
- - - Single temporary | etherX XX XXX
file (Wwhere XXXXXX is
a unigue number)
foo.cap - - Single named file |foo.cap
foo.cap X - Multiple  files,|foo_00001_ 2004020
continuous 5110102.cap,
foo_00002_2004020
5110102.cap, ...
foo.cap X X Multiple  files,|foo_00001 2004020
ring buffer 5110102.cap,
foo_00002_2004020
5110102.cap, ...

Singletemporary file

A temporary file will be created and used (this is the default).
After the capturing is stopped, this file can be saved later un-
der auser specified name.
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Single named file

Multiplefiles, continuous

Multiplefiles, ring buffer

A single capture file will be used. If you want to place the
new capture file to a specific folder, choose this mode.

Like the "Single named file" mode, but a new file is created
and used, after reaching one of the multiple file switch condi-
tions (one of the "Next file every ..." values).

Much like "Multiple files continuous', reaching one of the
multiple files switch conditions (one of the "Next file every
.." values) will switch to the next file. This will be a newly
created file if value of "Ring buffer with n files' is not
reached, otherwise it will replace the oldest of the formerly
used files (thus forming a"'ring").

This mode will limit the maximum disk usage, even for an
unlimited amount of capture input data, keeping the latest
captured data.
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4.7. Link-layer header type

In the usual case, you won't have to choose this link-layer header type. The following paragraphs
describe the exceptional cases, where selecting this type is possible, so you will have a guide what
to do:

If you are capturing on an 802.11 device on some versions of BSD, this might offer a choice of "Eth-
ernet" or "802.11". "Ethernet" will cause the captured packets to have fake Ethernet headers;
"802.11" will cause them to have IEEE 802.11 headers. Unless the capture needs to be read by an
application that doesn't support 802.11 headers, you should select "802.11".

If you are capturing on an Endace DA G card connected to a synchronous seria line, this might offer
achoice of "PPP over serial" or "Cisco HDLC"; if the protocol on the serial line is PPP, select "PPP
over serial", and if the protocol on the seria lineis Cisco HDLC, select "Cisco HDLC".

If you are capturing on an Endace DAG card connected to an ATM network, this might offer a
choice of "RFC 1483 IP-over-ATM" or "Sun raw ATM". If the only traffic being captured is RFC
1483 LL C-encapsulated IP, or if the capture needs to be read by an application that doesn't support
SUnATM headers, select "RFC 1483 |P-over-ATM", otherwise select "Sun raw ATM".

If you are capturing on an Ethernet device, this might offer a choice of "Ethernet” or "DOCSIS'. If
you are capturing traffic from a Cisco Cable Modem Termination System that is putting DOCSIS
traffic onto the Ethernet to be captured, select "DOCSIS", otherwise select "Ethernet”.
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4.8. Filtering while capturing

Wireshark uses the libpcap filter language for capture filters. Thisis explained in the tcpdump man
page, which can be hard to understand, so it's explained here to some extent.

Tip!

You will find a lot of Capture Filter examples a  ht-
tp://wiki.wireshark.org/CaptureFilters.

You enter the capture filter into the Filter field of the Wireshark Capture Options dialog box, as
shown in Figure 4.2, “The "Capture Options' dialog box”. The following is an outline of the syntax
of the tcpdump capture filter language. See the expression option at the tcpdump manual page for
details: http://www.tcpdump.org/tcpdump_man.html.

A capture filter takes the form of a series of primitive expressions connected by conjunctions (and/
or) and optionally preceded by not:

[not] primtive [and|or [not] primtive ...]

An exampleis shown in Example 4.1, “ A capture filter for telnet that captures traffic to and from a
particular host ”.

Example 4.1. A capture filter for telnet that captures traffic to and from a
particular host

tcp port 23 and host 10.0.0.5

This example captures telnet traffic to and from the host 10.0.0.5, and shows how to use two primit-
ives and the and conjunction. Another example is shown in Example 4.2, “ Capturing all telnet
traffic not from 10.0.0.5”, and shows how to capture al telnet traffic except that from 10.0.0.5.

Example 4.2. Capturing all telnet traffic not from 10.0.0.5

tcp port 23 and not host 10.0.0.5

XXX - add examples to the following list.

A primitiveis simply one of the following:

[srcldst] host <host> This primitive allows you to filter on a host IP address or
name. You can optionaly precede the primitive with the
keyword srcjdst to specify that you are only interested in
source or destination addresses. If these are not present, pack-
ets where the specified address appears as either the source or
the destination address will be selected.

ether [src|dst] host <ehost> This primitive allows you to filter on Ethernet host addresses.
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gateway host <host>

[srcldst] net <net> [{mask
<mask>}[{len <len>}]

[tcpludp] [srcldst] port <port>

less|greater <length>

iplether proto <protocol>

ether|ip broadcast|multicast

<expr>relop <expr>

You can optionaly include the keyword srcldst between the
keywords ether and host to specify that you are only inter-
ested in source or destination addresses. If these are not
present, packets where the specified address appears in either
the source or destination address will be selected.

This primitive alows you to filter on packets that used host
as a gateway. That is, where the Ethernet source or destina-
tion was host but neither the source nor destination | P address
was host.

This primitive allows you to filter on network numbers. You
can optionally precede this primitive with the keyword
srcldst to specify that you are only interested in a source or
destination network. If neither of these are present, packets
will be selected that have the specified network in either the
source or destination address. In addition, you can specify
either the netmask or the CIDR prefix for the network if they
are different from your own.

This primitive allows you to filter on TCP and UDP port
numbers. You can optionally precede this primitive with the
keywords src|dst and tcp|udp which allow you to specify that
you are only interested in source or destination ports and TCP
or UDP packets respectively. The keywords tcp|ludp must ap-
pear before src|dst.

If these are not specified, packets will be selected for both the
TCP and UDP protocols and when the specified address ap-
pearsin either the source or destination port field.

This primitive alows you to filter on packets whose length
was less than or equal to the specified length, or greater than
or equal to the specified length, respectively.

This primitive allows you to filter on the specified protocol at
either the Ethernet layer or the IP layer.

This primitive alows you to filter on either Ethernet or IP
broadcasts or multicasts.

This primitive allows you to create complex filter expressions
that select bytes or ranges of bytes in packets. Please see the
tcpdump man page at http:/ / www.tcpdump.org/ tcp-
dump_man.html for more details.

Automatic Remote Traffic Filtering

If Wireshark is running remotely (using e.g. SSH, an exported X11 window, a termina server, ...),
the remote content has to be transported over the network, adding a lot of (usually unimportant)
packets to the actualy interesting traffic.

To avoid this, Wireshark tries to figure out if it's remotely connected (by looking at some specific
environment variables) and automatically creates a capture filter that matches aspects of the connec-

tion.

The following environment variables are analyzed:

SSH_CONNECTION (ssh)
SSH_CLIENT (ssh)

<remote | P> <remote port> <local |P> <loca port>

<remote | P> <remote port> <local port>
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REMOTEHOST (tcsh, others?) <remote name>
DISPLAY (x11) [remote name]:<display num>

CLIENTNAME (terminal server)  <remote name>
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4.9. While a Capture is running ...

While a captureis running, the following dialog box is shown:

Figure4.3. The" CaptureInfo" dialog box

& Wireshark: Capture from Broadco...

Zaptured Packets

Takal
SCTP
TP
LiCP
ICMP
ARP
25SPF
GRE
MetBIos
IP%
YIMES
Dther

Funning

This dialog box will inform you about the number of captured packets and the time since the capture
was started. The selection which protocols are counted cannot be changed.

y Tip!
%
- This Capture Info dialog box can be hidden, using the "Hide capture info dialog" op-
tion in the Capture Options dialog box.

4.9.1. Stop the running capture

A running capture session will be stopped in one of the following ways:

1. Usingthe ﬂ Stop" button from the Capture Info dialog box .
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4 Notel
The Capture Info dialog box might be hidden, if the option "Hide capture info

dialog" is used.
2. Using the menu item "Capturelm Stop".
3. Usingthetoolbar item " Stop".

4. Pressing the accelerator keys: Ctrl+E.

5. The capture will be automatically stopped, if one of the Stop Conditions is exceeded, e.g. the
maximum amount of data was captured.

Restart a running capture

A running capture session can be restarted with the same capture options than the last time, this will
remove all packets previously captured. This can be useful, if some uninteresting packets are cap-
tured and there's no need to keep them.

Restart is a convenience function and equivalent to a capture stop following by an immediate cap-
ture start. A restart can be triggered in one of the following ways:

1. Using the menu item "Caotureym Restart".

2. Usingthetoolbar item " | Restart".
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Chapter 5. File Input / Output and
Printing

5.1. Introduction

This chapter will describe input and output of capture data.

e Open/Import capture filesin various capture file formats
Save/Export capture filesin various capture file formats
Merge capture files together

Print packets
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5.2. Open capture files

5.2.1.

Wireshark can read in previously saved capture files. To read them, simply select the menu or tool-
bar item: "File/ Open". Wireshark will then pop up the File Open dialog box, which is dis-

cussed in more detail in Section 5.2.1. " The "Open Capture File" dialog box”.
—h Notel
You can also use drag-and-drop to open afile, by simply dropping the desired file

from your file manager onto Wireshark's main window. However, drag-and-drop is not
available/won't work in all desktop environments.

If you didn't save the current capture file before, you will be asked to do so, to prevent dataloss (this
behaviour can be disabled in the preferences).

In addition to its native file format (libpcap format, aso used by tcpdump/WinDump and other libp-
cap/WinPcap-based programs), Wireshark can read capture files from alarge number of other pack-
et capture programs as well. See Section 5.2.2, “Input File Formats® for the list of capture formats
Wireshark understands.

The "Open Capture File" dialog box

The "Open Capture File" dialog box allows you to search for a capture file containing previously

captured packets for display in Wireshark. Figure 5.1, “The "Open Capture File" Dialog box” shows
an example of the Wireshark Open File Dialog box.

—a Note
Wireshark uses the open dialog box from the version of the GTK+ toolkit that it's us-
ing. This dialog was completely redesigned in GTK version 2.4. Depending on the in-
stalled GTK version, your dialog box might look different. However, as the functional-
ity remains amost the same, much of this description will work with your version of
Wireshark.

Figureb5.1. The" Open Capture File" Dialog box
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@ Ethereal: Open Capture File

{p& Home ~
IbDesktop
m B Eme *  Modified
F2) svstem (i) Pypesrm -y 25,05, 2004
B o By e = @ 10.03.2004
(©)ex [ R 10,03.2004
B - =
% — el 17.09.2003
By O S S - 01.06,2004
By e @)= - 22.03.2004
By ¢ === . 29,10,2003
% f 'Q"' “-ww - Today
? 3 ¢ jewre = Taday

- e boe pwe e - g, Today

&%& —-— "_’,—‘rr -l - - Today P
Filename: Z50000-700.cap
Format: libpcap (tcpdump, Ethereal, etc.)
Enable MAC name resolution Size: 138685 bytes
Enable network name resaolution Packets: 70
Fit st Packet: 2003-12-09 10:32:59
Enable transport name resolution Bl iy 0000132
l [bgpen l X cancel

With this dialog box, you can perform the following actions:

8.

The"+ Add" button allows you to add a directory, selected in the right-hand pane, to the favor-
ites (bookmarks?) list. Those changes are persistent.

The"- Remove" button allows you to remove a selected directory from that list again (the items

like: "Home", "Desktop", and "Filesystem" cannot be removed).
Select files and directories with the list boxes.

View file preview information (like the filesize, the number of packets, ...), while browsing the
filesystem.

Specify adisplay filter with the Filter button and filter field. Thisfilter will be used when open-
ing the new file. Clicking on the Filter button causes Wireshark to pop up the Filters dialog box
(which isdiscussed further in Section 6.3, “Filtering packets while viewing”).

Specify which name resolution is to be performed for all packets by clicking on one of the "En-
able name resolution” check buttons. Details about name resolution can be found in Sec-
tion 7.6, “Name Resolution”.

Click the Open button to accept your selected file and open it. If Wireshark doesn't recognize
the capture format, it will grey out this button.

Click the Cancel button to go back to Wireshark and not load a capture file.

Y ou can aso change the display filter and name resolution settings later while viewing the packets.
However, for very large capture files it can take a significant amount of extra time changing these
settings later, so it might be agood ideato set at least the filter in advance here.

5.2.2. Input File Formats
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The following file formats from other capture tools can be opened by Wireshark:

» libpcap, tcpdump and various other tools using tcpdump's capture format
*  Sun snoop and atmsnoop

»  Shomiti/Finisar Surveyor captures

* Novell LANalyzer captures

» Microsoft Network Monitor captures

» AlX'siptrace captures

» Cinco Networks NetXray captures

» Network Associates Windows-based Sniffer and Sniffer Pro captures

* Network General/Network Associates DOS-based Sniffer (compressed or uncompressed) cap-
tures

* AG Group/WildPackets EtherPeek/TokenPeek/AiroPeek/EtherHel p/PacketGrabber captures
« RADCOM's WAN/LAN Analyzer captures

* Network Instruments Observer version 9 captures

e Lucent/Ascend router debug output

*  HP-UX'snettl

e ToshibasISDN routers dump output

» |ISDN4BSD i4btrace utility

 tracesfrom the EyeSDN USB SO

* IPLog format from the Cisco Secure Intrusion Detection System

e pppd logs (pppdump format)

» the output from VMS's TCPI Ptrace/ TCPtrace/l UCX$TRACE utilities
» thetext output from the DBS Etherwatch VMS utility

» Visual Networks' Visual UpTimetraffic capture

» theoutput from CoSine L2 debug

» theoutput from Accellent's 5Views LAN agents

e Endace Measurement Systems ERF format captures

» Linux Bluez Bluetooth stack hcidump -w traces

+ Catapult DCT2000 .out files

—t Notel
It may not be possible to read some formats dependent on the packet types captured.
Ethernet captures are usualy supported for most file formats, but other packet types
(e.g. token ring packets) may not be possible to read from all file formats.

82



File Input / Output and Printing

5.3. Saving captured packets

Y ou can save captured packets simply by using the Save As... menu item from the File menu under
Wireshark. Y ou can choose which packets to save and which file format to be used.

5.3.1. The "Save Capture File As" dialog box

The "Save Capture File As' dialog box allows you to save the current capture to afile. Figure 5.2,
“The "Save Capture File As' dialog box” shows an example of this dialog box.

@ War ning!
Saving the captured packets will slightly reduce the amount of information, e.g. the
number of dropped packets will be lost, see Section A.1, “Capture Files’ for details.

[— Note
! i Wireshark uses the open dialog box from the version of the GTK+ toolkit that it's us-
ing. This dialog was completely redesigned in the GTK version 2.4. Depending on the
installed GTK version, your dialog box might look different. However, as the function-
ality remains almost the same, much of this description will work with your version of
Wireshark.

Figure5.2. The" Save Capture File As" dialog box
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{@ Ethereal: Save Capture File As

Marme:

Save in Folder:

Packet Range

iCaptured || Displaved |
E} all packets 120
() Selected packet only 1

() Specify a packet range:

File tvpe: | libpcap (tcpdurnp, Ethereal, etc.)

[+ Browse Far other Folders

‘ Eiave H x i_ancel |

With this dialog box, you can perform the following actions:

1. Typeinthe name of the file you wish to save the captured packetsin, as a standard file namein
your file system.

2. Select the directory to save thefileinto.

3. Select the range of the packetsto be saved, see Section 5.8, “ The Packet Range frame”

4. Specify the format of the saved capture file by clicking on the File type drop down box. You
can choose from the types, described in Section 5.3.2, “Output File Formats’.

Note!
: i Some capture formats may not be available, depending on the packet types cap-
tured.

/ Tip!
\aid
. Y ou can convert capture files from one format to another by reading in a capture
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file and writing it out using a different format.

5. Use"Browsefor other folders' to browse files and foldersin your file system.

6. Click on the Save button to accept your selected file and save to it. If Wireshark has a problem
saving the captured packets to the file you specified, it will display an error dialog box. After
clicking OK on this error dialog box, you can try again.

7. Click on the Cancel button to go back to Wireshark and not save the captured packets.

5.3.2. Output File Formats

Wireshark can save the packet data in it's "native" file format (libpcap) and in the file formats of
some other protocol analyzers, so other tools can read the capture data.

@ Warning!
The conversion to a different file format may reduce the time stamp accuracy, see the
Section 7.3, “Time Stamps’ for details.

The following file formats can be saved by Wireshark:

» libpcap, tcpdump and various other tools using tcpdump's capture format
* Novell LANalyzer

* Network Associates Sniffer

e Sun snoop

* Microsoft Network Monitor

» Visual Networks Visua UpTime traffic

* Accellent 5Views

* Networks Instruments Observer version 9

e  HP-UX'snettl

If the above tools will be more helpful than Wireshark is a different question ;-)

— Notel
Other protocol analyzers than Wireshark may require that the file has a certain suffix
in order to read the files you generate with Wireshark, e.g.:

".DMP" for Tcpdump/libpcap

" CAP" for Network Associates Sniffer Windows
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5.4. Merging capture files

5.4.1.

Sometimes you need to merge several capture files into one. For example this can be useful, if you
have captured simultaneously from multiple interfaces at once (e.g. using multiple instances of
Wireshark).

Merging capture files can be done in three ways.
* Use the menu item "Merge" from the "File" menu, to open the merge dialog, see Figure 5.3,

“The "Merge with Capture File" dialog box”. This menu item will be disabled, until you have
loaded a capturefile.

* Usedrag-and-drop to drop multiple files on the main window. Wireshark will try to merge the
packets in chronological order from the dropped files into a newly created temporary file. If you
drop only asinglefile, it will simply replace a (maybe) existing one.

* Use the mergecap tool, which is a command line tool to merge capture files. This tool provides
the most options to merge capture files, see Section D.7, “mergecap: Merging multiple capture
filesinto one”.

The "Merge with Capture File" dialog box

This dialog box let you select afile to be merged into the currently loaded file.

—h Notel
If your current data wasn't saved before, you will be asked to save it first, before this
dialog box is shown.

Figure5.3. The" Mergewith Capture File" dialog box
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(@ Ethereal: Merge with Capture File

ﬁHnme ﬁ [r_rrrr-- : [,’:Ebmn] E] [ T l [ ST ]
E Deskiop Namme ”

E Bl IRl L [T ITTTaTeeer Ty
E L,
@E:'l,
%H:'I,

.......

v ! -
(]| erppprmte v
2 - < >
Filename: test.cap
@ Filter: | | '

Farmat: libprap (tcpdump, Ethereal, ete.)

() Prepend packets to existing File Size: 15317 bytes
Packets: 1z0

(%) Merge packets chronologically
First Packet: 2004-06-22 20:02;45

() append packets to existing file Bt e | GEVATAE

‘ &Qpen H xgancel |

Prepend packetsto existing file Prepend the packets from the selected file before the currently
|oaded packets.

M er ge packets chronologically Merge both the packets from the selected and currently
loaded file in chronological order.

Append packetsto existing file Append the packets from the selected file after the currently
|loaded packets.

All other controls will work the same way as in the "Open Capture File" dialog box, see Sec-
tion 5.2.1, “The "Open Capture File" dialog box”.
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5.5. File Sets

5.5.1.

When using the "Multiple Files' option while doing a capture (see: Section 4.6, “ Capture files and
file modes’), the capture datais spreaded over several capturefiles, called afile set.

As it can become tedious to work with a file set by hand, Wireshark provides some features to
handle these file sets in a convenient way.

How does Wireshark detect the files of afile set?

A filename in afile set uses the format Prefix_Number_DateTimeSuffix which might ook
like this: "test 00001 20060420183910.pcap”. All files of a file set share the same prefix
(e.g. "test") and suffix (e.g. ".pcap") and a varying middle part.

To find the files of a file set, Wireshark scans the directory where the currently loaded file
resides and scans for files matching the same filename pattern (prefix and suffix) than the cur-
rently loaded file.

This simple mechanism usually works well, but has it's drawbacks. If several file sets were
captured with the same prefix and suffix, Wireshark will detect them as a single file set. If
files were renamed or spreaded over severa directories the mechanism will fail to find all
files of a set.

The following features in the "File Set" submenu of the "File" menu are available to work with file
setsin a convenient way:

» Thelist Filesdiaog box will list the files Wireshark has recognized as being part of the current
file set.
» Next File closesthe current and opens the next file in the file set.

» PreviousFile closesthe current and opens the previousfilein the file set.

The "List Files" dialog box

Figure5.4. The" List Files' dialog box
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Wireshark: 17 Files in S5et

Filename Created Last Modified Size
@ Etestl_ElElElEll_ZDDSDBI'BIEEISDS.pEapE 2005,08,19 15:15:03  2005.058,19 15:15:05 1067 Bytes

() testl_00002_20050619181505, pcap
() testl_0000E_20050619181505, pap
() testl_00004_Z0050819181506, pap
() teskl_0000S_Z0050819181507 . prap
() testl_00006_20050819181507 . peap
() testl_00007_20050619181508, pap
() testl_0000E_20050619181509, prap
() testl_00009_Z00S0819181510,poap
() testl_00010_20050819181512 . peap
() testl_00011_20050819181513, peap
() testl_00012_20050819181514. peap
() testl_00013_20050819181516, poap
() teskl_00014_Z00S0819181517, prap
() testl_00015_20050819181518, peap
() testl_00016_20050819181518, pcap
() testl_00017_20050819181518, peap

v i directory: Duffileset

X g |

Each line contains information about a file of the file set:

» Filename the name of the file. If you click on the filename (or the radio button left to it), the
current file will be closed and the corresponding capture file will be opened.

» Created the creation time of thefile
» Last Modified the last time the file was modified
* Sizethesize of thefile

The last line will contain info about the currently used directory where al of the files in the file set
can be found.

The content of this dialog box is updated each time a capture file is opened/closed.

The Close button will, well, close the dialog box.
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5.6. Exporting data

Wireshark provides several ways and formats to export packet data. This section describes general
ways to export data from Wireshark.

Notel

There are more specialized functions to export specific data, which will be described at
the appropriate places.

XXX - add detailed descriptions of the output formats and some sample output, too.

5.6.1. The "Export as Plain Text File" dialog box

Export packet datainto aplain ASCII text file, much like the format used to print packets.

Figure5.5. The" Export as Plain Text File" dialog box

{@ Ethereal: Export as "Plain Text" File

Expark ko file:

| & |

Packet Range Facket Format

|§aptured||gisplayed| Packet summary line
(%) all packets 191 Packet details:

() sSelected packet only 1 0 all collapsed
(¥ As displayed

) all expanded

() Specify a packet range: 1] [] Packet bytes

[] Each packet an a new page

c?gr: H xgaru:el ‘

» Export tofile: frame chooses the file to export the packet datato.

» ThePacket Range frameis described in Section 5.8, “ The Packet Range frame”.

» ThePacket Details frameis described in Section 5.9, “ The Packet Format frame”.

5.6.2. The "Export as PostScript File" dialog box

Export packet data into PostScript, much like the format used to print packets.
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y Tip!
%
- You can easily convert PostScript files to PDF files using ghostscript. For example:
export to afile named foo.ps and then call: ps2pdf foo.ps

Figure5.6. The" Export as PostScript File" dialog box

{@ Ethereal: Export as "PostScript” file

Expark ko file:
I \ = \

(PoskScript files can be easily converted to PDF files using ghostscript's ps2pdf)

Packet Range Packet Formak

| Captured || Displaved | Packet surmmary line

(%) all packets 191 Packet details:

() selected packet only 1 () all collapsed
(%) As displayed

) Al expanded
() Specify a packet range: 0 [] Packet bytes

[ ] Each packet on a new page

c?gk H xgancel ‘

» Export tofile: frame chooses the file to export the packet data to.

* ThePacket Range frame is described in Section 5.8, “ The Packet Range frame”.

» The Packet Details frameis described in Section 5.9, “ The Packet Format frame”.

5.6.3. The "Export as CSV (Comma Seperated Values)
File" dialog box

XXX - add screenshot

Export packet summary into CSV, used e.g. by spreadsheet programs to im-/export data.

» Export tofile: frame chooses the file to export the packet datato.

e ThePacket Range frameis described in Section 5.8, “ The Packet Range frame”.

5.6.4. The "Export as PSML File" dialog box
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Export packet datainto PSML. Thisisan XML based format including only the packet summary.
Figure5.7. The" Export asPSML File" dialog box

@ Ethereal: Export as "PSML™ file E|@|E|

Export ko file:
| [ B |

Packet Range

| Zapkured ” Displayed |
(*) all packets 191
() Selected packet only 1

() Specify a packet range:

CQDK H xgancel ‘

» Export tofile: frame chooses the file to export the packet data to.

» ThePacket Range frameis described in Section 5.8, “ The Packet Range frame”.

There's no such thing as a packet details frame for PSML export, as the packet format is defined by
the PSML specification.

5.6.5. The "Export as PDML File" dialog box

Export packet data into PDML. This is an XML based format including the packet details. The
PDML file specification is available at: PDML specification.

isstill in an early beta state, so please expect changes in future Wireshark versions.

a The PDML specification is not officially released and Wireshark's implementation of it

Figure5.8. The" Export asPDML File" dialog box
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(@ Ethereal: Export as "PDML" file E”E'E'

Export ko File:
| | & |

Packet Range

| iZapkured ” Displayed |
(*) all packets 191
() selected packet only 1

() Specify a packet range:

H xgann:el ‘

» Export tofile frame chooses the file to export the packet data to.

* ThePacket Range frame is described in Section 5.8, “ The Packet Range frame”.

There's no such thing as a packet details frame for PDML export, as the packet format is defined by
the PDML specification.

The "Export selected packet bytes" dialog box

Export the bytes selected in the "Packet Bytes' pane into araw binary file.

Figure5.9. The" Export Selected Packet Bytes' dialog box
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{@ Ethereal: Export Selected Packet Bytes |Z||E|[5__(|

Marme:

Save in Folder: bDebug_GTkiE

Will save 23 bytes of raw binary data to specified File,

[+ Browse For other Folders

‘ Eiave H x iCancel |

« Name: the filename to export the packet data to.
» TheSavein folder: field lets you select the folder to save to (from some predefined folders).

« Browsefor other folders provides aflexible way to choose afolder.
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5.7. Printing packets

To print packets, select the "Print..." menu item from the File menu. When you do this, Wireshark

pops up the Print dialog box as shown in Figure 5.10, “The "Print" dialog box”.

5.7.1. The "Print" dialog box

Figure5.10. The" Print" dialog box

Wireshark: Print

Printer

() Plain texti

{:} PostScript

[] output ta File:

Packet Range Facket Format

| Captured || Displayed | Packet summary line

() All packets 11 Packet details:

() selected packet only 1 O Al collapsed
(%) As displayed

) all expanded

() Specify a packet range: 1] [] Packet bytes

[ ] Each packet on a new page

EErint H xgancel ‘

The following fields are available in the Print dialog box:

Printer Thisfield contains a pair of mutually exclusive radio buttons:

« Plain Text specifies that the packet print should bein plain text.

e PostScript specifies that the packet print process should use PostScript to

generate a better print output on PostScript aware printers.

e Output to file: specifies that printing be done to a file, which name is

entered in the field or selected using the browse button.

This field is where you enter the file to print to if you have selected Print
to afile, or you can click the button to browse the filesystem. It is greyed

out if Print to afileis not selected.

¢ Print command specifies that a command be used for printing.
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Notel

These Print command fields are not available on windows
platforms.

This field specifies the command to use for printing. It is typically lpr.
Y ou would change it to specify a particular queue if you need to print to a
gueue other than the default. An example might be;

| pr - Prypostscri pt

Thisfield isgreyed out if Output to file: is checked above.

Packet Range Select the packets to be printed, see Section 5.8, “ The Packet Range frame”

Packet Format Select the output format of the packets to be printed. You can choose, how
each packet is printed, see Figure 5.12, “The "Packet Format" frame”
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5.8. The Packet Range frame

The packet range frame is a part of various output related dialog boxes. It provides options to select
which packets should be processed by the output function.

Figure5.11. The" Packet Range" frame
Packet Range

Captured ” Displayed

(%) all packets 120
() Selected packet only 1
() specify a packet range: 1]

If the Captured button is set (default), all packets from the selected rule will be processed. If the
Displayed button is set, only the currently displayed packets are taken into account to the selected
rule.

* All packetswill process all packets.

» Selected packet only process only the selected packet.

* Marked packets only process only the marked packets.

* Fromfirst tolast marked packet process the packets from the first to the last marked one.

» Specify a packet range process a user specified range of packets, e.g. specifying 5,10-15,20-

will process the packet number five, the packets from packet number ten to fifteen (inclusive)
and every packet from number twenty to the end of the capture.
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5.9. The Packet Format frame

The packet format frame is a part of various output related dialog boxes. It provides options to select
which parts of a packet should be used for the output function.

Figure5.12. The" Packet Format" frame

Packet Formak
Packet surmmary line

Packet details:
() Al collapsed
() As displayed
() Al expanded

[ ] Packet bytes

[ ] Each packet on a new page

e Packet summary line enable the output of the summary line, just asin the "Packet List" pane.
» Packet details enable the output of the packet details tree.

e All collapsed the info from the "Packet Details' panein "all collapsed” state.

« Asdisplayed the info from the "Packet Details" pane in the current state.

e All expanded theinfo from the "Packet Details' panein "all expanded" state.
» Packet bytes enable the output of the packet bytes, just asin the "Packet Bytes" pane.

» Each packet on a new page put each packet on a separate page (e.g. when saving/printing to a
text file, thiswill put aform feed character between the packets).
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Chapter 6. Working with captured
packets

6.1. Viewing packets you have captured

Once you have captured some packets, or you have opened a previously saved capture file, you can
view the packets that are displayed in the packet list pane by simply clicking on a packet in the
packet list pane, which will bring up the selected packet in the tree view and byte view panes.

You can then expand any part of the tree view by clicking on the plus sign (the symbol itself may
vary) to the left of that part of the payload, and you can select individual fields by clicking on them
in the tree view pane. An example with a TCP packet selected is shown in Figure 6.1, “Wireshark
with a TCP packet selected for viewing”. It also has the Acknowledgment number in the TCP head-
er selected, which shows up in the byte view as the selected bytes.

Figure 6.1. Wireshark with a TCP packet selected for viewing

test. pcap - Wireshark

File Edit Wiew Go Capture Analyze  Statistics  Help

B W e BEx % 8RB« »37 & BHEH &a
EEilter:| - *Expression... %;.glear Q’ﬁpplv

Mo, - Time Source Destination Protocal | Info A
£7 L.eououe LFe. iU, L Lo 1uban. e er Sdam; LR SEY-L HLR—L1D0 W
1.266628 ACK] Seq=1 Ack=
32 1.266819 ACK] Seq=1 Ack=
33 1.:2a67850 Seq=510 Ack=20
34 1.274361 ACK] Seqg=1 Ack=
35 1.274447 ) 20 A
36 1,274987 eq=2
37 1.275018 q=1591 Ack=
1.276019 ACK] Seq=26645
282181 ACK] Seq=510 Ac v
4 >
Frame 36 (60 bytes on wire, 60 bytes captured) -
Ethernet II, Src: Metgear_2d:75:9a (00:09:5h:2d:75:9a), Dst: 192.168.0.2 (00:0b:5d:20:cd:02)
Internet Protocol, Src: 192.168.0.1 (192.168.0.1), Dst: 192.168.0.2 (192.168.0.2)
= Transmission Control Protocol, Src Port: http (803, Dst Port: 3197 {319F7), Seqg: 20, Ack: 190, Len: O
Source port: http (20)
Destination port: 3197 (3197)
Sequence number: 20 (relative sequence number)
Acknowledgement number: 190 (relative ack number)
Header length: 20 bytes v
< >
000 00 Ob 5d 20 od 02 00 09 Sb 2d F5 9a 08 00 45 00 ..] -... [-u...E.

010 00 28 00 84 00 00 40 06 f8 8 c0 a8 00 01 cO ad O - T
020 00 G2 00 50 Oc 7d 00 O0 68 14 FSEEEEGEEES 50 11 Pk hOEREP.
030 Oc 00 93 ca 00 00 OD OO 00 0D 0O OO LLa.o.a. .l

hcknowledgement number (tcp. ack), 4 bytes |P: 1Z0D: 1Z0M: 0

You can also select and view packets the same way, while Wireshark is capturing, if you selected
"Update list of packetsin real time" in the Wireshark Capture Preferences dialog box.

In addition, you can view individual packets in a separate window as shown in Figure 6.2, “Viewing
a packet in a separate window”. Do this by selecting the packet you are interested in the packet list
pane, and then select "Show Packet in New Windows" from the Display menu. This allows you to
easily compare two or even more packets.
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Figure 6.2. Viewing a packet in a separ ate window

.2 TCP http > 3197 [FIN, ACK] Seq=20 Ack=

361.274987 192.168.0.1 192.168.
{ Frame tured)
Ethernet II, Src: Wetgear_z2d:7 9:5b:2d:F5:9a), Dst: 192.168.0.2 (00:0b:5d:20:cd:02)
Internet Protocol, Src: 192.168.0.1 (192.168.0.1), Dst: 192.168.0.2 (192.168.0.2)

= Transmission Control Protocol, Src Port: http (807, Dst Port: 3197 {31973, Seq: 20, Ack: 190, Len

[T S—— R P £ 1ah

<

|»
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6.2. Pop-up menus

You can bring up a pop-up menu over either the "Packet List", "Packet Details" or "Packet Bytes'
pane by clicking your right mouse button at the corresponding pane.

6.2.1. Pop-up menu of the "Packet List" pane

Figure 6.3. Pop-up menu of the" Packet List" pane

i test.pcap - Wireshark

File Edit Wew Go Capture Analyze Statistics Help
B oW e pEx % &8/8 «»» 7 32 BE &a
[Z] Filker: | S ‘3" Expression. .. Q&.glear o apply
Mo, - Time Source Diestination Protocal  Info A
e e PO PR bt e e e T —
21 1.250310 192.168.0.1 192.168.0.2 TCP http » 3196 [FIN, ACK] Segq=114 Ac
22 1. 192.168.0.2 192.162.0.1 TCP 3196 » http [ACK] Seq=257 Ack=115
23 1.251868 092.168.0. ] ACK] Seq=1 Ack=
1g _ MarkPacket (toggle) http » 3196 [FIN, ACK] 5eq-26611

.253323
. 254502
. 254532
.254p43
. 256388

(L) Set Time Reference (togale)

Apply as Filker 3

Prepare a Filker

-

Seq=0 Len=0 MSS
. ACK] Seq=0 Ack=
] Segq=1 fAck=1 Win
. ACK] Seq=1 Ack=
1 Seq=1 Ack=190 W

Selected
Mok Selected H

Conversation Filter k| ... and Selected
pte] http » 3107 ]
. ZBAGZE .0. +v oF Selecked H, ACK] Seq=1 Ack=

37 4 aLEodn AN g0 oA 4 Follaw TCP Stream ... and not Selected b nrwd cmmd el
< ... of not Selected >
+ Frame 23 (60 bytes on wire, 60 bytes capt 3% Decade As. .. L
7 Ethernet II, Src: Metgear_2d:75:%a (00:09 ; 2.0.2 (00:0b:5d:20:cd:02)

5 Internet Protocol, Src: 192.168.0.1 (192.| & Prink.. {192.168.0.2)
= Transmission Control Protocol, Src Port: Show Packet in New Window 0 (5000), Seq: 1, Ack: 1, Len: O

Source port: 1025 (1025)

Destination port: 5000 (50000

Sequence number: 1 (relatiwve sequence number)

Acknowledgement number: 1 (relative ack number)

Header length: 20 bytes w
< >
000 00 Ob 5d 20 od 02 00 09 S5b 2d F5 9a O OO0 45 00 ..] -... [-u...E.

010 00 28 00 7c 0D OO0 40 06 9 00 cO ad 00 01 cO ad P N - T
020 00 02 04 01 13 83 0D 00 &7 81 3c 37 7f a7 50 10 ........ Q.7 WP
030 Oc 00 e7 57 00 QD OO OO0 0D QD QD OO0 LLiaaaa. aaas

|File: "Diftest.pcap” 14 KB 00:00:02 P:1200; 120M: 0

The following table gives an overview which functions are available in this pane, where to find the
corresponding function in the main menu, and a short description of each item.

Table6.1. The menu items of the " Packet List" pop-up menu

Item Identical to main|Description
menu'sitem:

Mark Packet | Edit

(toggle) Mark/unmark a packet.

Set Time Refer-|Edit

ence (toggle) Set/reset atime reference.

Apply asFilter |Analyze
Prepare and apply a display filter based on the currently se-
lected item.

PrepareaFilter |Analyze

102



Working with captured packets

Item Identical to main|Description
menu'sitem:

Prepare a display filter based on the currently selected
item.

Conversation Fil-
ter This menu item applies a display filter with the address in-
formation from the selected packet. E.g. the IP menu entry
will set a filter to show the traffic between the two IP ad-
dresses of the current packet. XXX - add a new section de-
scribing this better.

SCTP -
XXX - add an explanation of this.

Follow TCP|Analyze

Stream Allows you to view al the data on a TCP stream between a
pair of nodes.

Follow SSL [Analyze

Stream Same as "Follow TCP Stream” but for SSL. XXX - add a

new section describing this better.

Decode As... Anayze
Change or apply a new relation between two dissectors.
Print... File
Print packets.
Show Packet in|View
New Window Display the selected packet in a new window.

6.2.2. Pop-up menu of the "Packet Details" pane

Figure 6.4. Pop-up menu of the" Packet Details' pane
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test. pcap - Wireshark EI[E|E|

File Edit Wew Go Capture Analyze Statistics Help

B oW e p@E x % &8/ B8 « % »F & | EBE & a
EEilter: | A 4’ Expression. .. %glear V Lpply
Mo, - Time Source Destination Protocol | Info A
21 1.250810  192.168.0.1 192.168.0.2 TCP http : 3195 [FIN, ACK] Seq-114 Ac
.1 ] ck=115

.252826

1 0.1 £5.0.2 ACK]
25 1.253323 192.168.0.2 1592.168.0.1 TCP Seq=0 Len=0 M55
26 1.254502 192.168.0.1 0.2 TCP ACK] Seq=0 Ack=
A7 1.7284532 192, 1AR.0.72 192 1AR.0.1 TR Sea=1 frk=1 Win ¥
< ¥
Frame 23 (60 bytes on wire, 60 bytes capty -
Ethernet II, Src: Metgear_2d:75:9a (00:09 i 2.0.2 (00:0b:5d:20:cd:02)
Internet Protocol, Src: 192.168.0.1 (192.1 Expand Subkrees (192.168.0.2)
= Transmission Control Protocol, Src Port: 1 Expand Al o0 (50003, Seg: 1, Ack: 1, Len: O
Sour'n?e pqr‘t: 1025 {1025) Callapse Al
Destination port: 5000 (50000
Sequence number: 1 (relatiwve sequenc Selected
Acknowl edgement number: 1 (relative Prepare a Filker b | Mot Selected
Header length: 20 bytes Follow TCP Stream ... and Selected
Flags: Ox0010 (ACK) ... or Selected
Window size: 3072 @ i ... and not Selected
Checksum: Oxef97 [correct] = Wiki Protocol Page \vv oF not Selected
@ Filker Field Reference —
Protocaol Preferences. .

Do00 b [ola] 5 [ 3% Decode As...
0010 28 40 ] o]

0020 o oo oo 2l

e GO 97 00 00 00 0o 00 00

Frame (frame), 60 bytes [P: 120D t20M: 0

The following table gives an overview which functions are available in this pane, where to find the
corresponding function in the main menu, and a short description of each item.

Table 6.2. The menu items of the " Packet Details’ pop-up menu

Item Identical to main|Description
menu'sitem:

Copy -

Copy the displayed text of the selected field to the system
clipboard.

Expand Subtrees |View
Expand the currently selected subtree.

Expand All View
Expand all subtreesin all packetsin the capture.

Collapse All View
Wireshark keeps a list of all the protocol subtrees that are
expanded, and uses it to ensure that the correct subtrees are
expanded when you display a packet. This menu item col-
lapses the tree view of all packetsin the capture list.

Apply asFilter |Anayze
Prepare and apply a display filter based on the currently se-
lected item. name.

PrepareaFilter |Anayze
Prepare a display filter based on the currently selected
item.

Follow TCP|Analyze
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Item Identical to main|Description
menu'sitem:

Stream
Allows you to view al the data on a TCP stream between a
pair of nodes.

Follow SSL |Analyze

Stream Same as "Follow TCP Stream" but for SSL. XXX - add a
new section describing this better.

Wiki Protaocol |-

Page Show the wiki page corresponding to the currently selected
protocol in your web browser.

Filter Field Ref-|-

erence Show the filter field reference web page corresponding to
the currently selected protocol in your web browser.

Protocol Prefer-|-

ences... The menu item takes you to the properties dialog and se-
lects the page corresponding to the protocol if there are
properties associated with the highlighted field. More in-
formation on preferences can be found in Figure 9.8, “The
preferences dialog box”.

Decode As... Analyze
Change or apply a new relation between two dissectors.

Resolve Name View
Causes a name resolution to be performed for the selected
packet, but NOT every packet in the capture.

Go to Corres|Go

ponding Packet

If the selected field has a corresponding packet, go to it.
Corresponding packets will usually be a request/response
packet pair or such.

6.2.3. Pop-up menu of the "Packet Bytes" pane

Figure 6.5. Pop-up menu of the" Packet Bytes' pane
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test. pcap - Wireshark

File Edit Wew Go Capture Analyze Statistics Help
B oW e B x%a8/B«s o272 BE aa
Eilter:l ¥ Expression... Clear Apply
. A
Siource Destination Protocol - Info =
O, QOOO00 192.1 : Broadcast ARP wWho has E 27 Gratuitous S
0.299139 192.168.0. 192.168.0.2 NENS Mame query MWESTAT * <005 <00 <005 <0(
1.025659 192.168.0. 224.0.0.22 IGMP W3 Membership Report
1.048652 192.168.0. 238, 255,255,250 /n] Source port: 3193 Destination pot
1.0585053 168.0. 192.168.0.2 /n] Source port: 1900 Destination pot
1.082038 165.0. 192.168.0. 255 NENS Registration NE NE1OC0E1D <00
v
| >
AT T L Oy CES O W, Se Uy TS CApTOTET ¥
Ethernet II, Src: 192.168.0.2 (00:0b:5d:20:cd:02), Dst: Broadcast (ff:ff:ff:ff:ff:Ff) =
Address Resolution Protocol (request/gratuitous ARP)
Hardware type: Ethernet (0x0001)
Protocol type: IF (Ox0800)
Hardware size: &
Protocal size: 4
Opcode: reguest (Ox0001)
Sender MAC address: 192.168.0.2 (00:0b:S5d:20:cd:02)
sender IP address: 192. L2 ({192,168 2
Target MAC address: 00:00:00_00:00:00 {00:00:00:00:00:00)
Target IP address: 192.168.0.2 (192.188.0.2) ]
o000 fF ff ff ff fF T 00 0b 5d 20 od 02 08 06 00 01 ........ T euenas
010 OF 00 06 04 0D 01 00 Ob  5d 20 cd G2 = -
020 00 00 00 OO0 00 00 cO ag 00 02 All Information
Export Selected Packet Bytes. .. Text Only
ISender IP address (arp.src.proto_ipw4), 4 bytes [P: 120D t20M: 0

The following table gives an overview which functions are available in this pane, where to find the
corresponding function in the main menu, and a short description of each item.

Table 6.3. The menu items of the " Packet Bytes' pop-up menu

Item Identical to main|Description
menu'sitem:

Copy/All Inform-
ation Copy the selected (XXX - al?) packet data to the clipboard
(XXX - inwhich format).

Copy/Text Only |-
Copy the selected packet data to the clipboard (XXX - in
which format).

Export Selected|File

Packet Bytes... This menu item is the same as the File menu item of the
same name. It allows you to export raw packet bytes to a
binary file.
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6.3. Filtering packets while viewing

Wireshark has two filtering languages: One used when capturing packets, and one used when dis-
playing packets. In this section we explore that second type of filter: Display filters. The first one
has aready been dealt with in Section 4.8, “Filtering while capturing”.

Display filters alow you to concentrate on the packets you are interested in while hiding the cur-
rently uninteresting ones. They allow you to select packets by:

* Protocol

* The presence of afield

* Thevaluesof fields

* A comparison between fields

e .. andalot more!

To select packets based on protocol type, simply type the protocol you are interested in in the Filter:
field in the filter toolbar of the Wireshark window and press enter to initiate the filter. Figure 6.6,

“Filtering on the TCP protocol” shows an example of what happens when you type tcp in the filter
field.

—t Notel
All protocol and field names are entered in lowercase. Also, don't forget to press enter
after entering the filter expression.

Figure6.6. Filtering on the TCP protocol
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test. pcap - Wireshark

File Edit Wew Go Capture Analyze Statistics Help

B oW e p@E x % &8/ B8 « % »F & | EBE & a
EEilter: |tcp W #Expression... Q@.glear Vﬂpply

Mo, - Time Source Destination Protocol | Info

uuuuuuuuu PooLrvete Soyg—a mem—a e

14 1.227451 192.168.0.2 192.168.0.1 TCP 3196 » http [PSH, ACK] Seq=1 Ack=
15 1.229309 192.168.0.1 192.168.0.2 TCP [ACK] Segq=1 Ack=256 W

1.248355 Seq=0 Len=0 M55
18 1.2483591 [5vN, ACK] Seq=0 Ack=
19 1.250171 ACK] Seq=1 Ack=
20 1.250285 ACK] Seq=256 Ac
1.250810 ACK] Seq=114 Ac
1.250842 57 Ack=115

i e

1
25 1.253323 Seq=0 Len=0 M55
26 1.254502 ACK] Seq=0 Ack=
27 1.254532

Zeq=1 Ack=1 Win .,

>
Tdentatication: C=O07C (124) A
Flags: O=00
Fragment offset: O
Time to live: &4
Protocol: TCP (Ox0&)

Header checksum: 0xf200 [correct]
SAnmras 107 168 01 (102 168 013 has

Q00 00 Ob 5d 20 od 02 00 09 S5b 2d 75 Ja OB 00 45 00 ve] wews [“Ue.oE.
010 00 28 00 Fc 00 0D 40 06 9 00 cO a8 00 01 cO a8 P N P -
020 00 02 04 01 13 83 0D 00 &7 81 3c 37 7f a7 50 10 ........ g.<7. . P
Q30 Oc 00 e” 97 00 00 00 00 OO0 0D 02 32 Laaaaeee s

|File: "Difkest.pcap” 14 KB 00:00:02 [P: 120D 103 M 0

As you might have noticed, only packets of the TCP protocol are displayed now (e.g. packets 1-10
are hidden). The packet numbering will remain as before, so the first packet shown is now packet
number 11.

Notel

When using a display filter, all packets remain in the capture file. The display filter
only changes the display of the capture file but not its content!

You can filter on any protocol that Wireshark understands. Y ou can also filter on any field that a
dissector adds to the tree view, but only if the dissector has added an abbreviation for the field. A
list of such fields is available in the Wireshark in the Add Expression... dialog box. You can find
more information on the Add Expression... dialog box in Section 6.5, “The "Filter Expression” dia-

log box”.

For example, to narrow the packet list pane down to only those packets to or from the IP address
192.168.0.1, useip.addr==192.168.0.1.

Notel

To remove thefilter, click on the Clear button to the right of the filter field.
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6.4. Building display filter expressions

6.4.1.

6.4.2.

Wireshark provides a simple but powerful display filter language that you can build quite complex
filter expressions with. You can compare values in packets as well as combine expressions into
more specific expressions. The following sections provide more information on doing this.

‘P Tip!

You will find alot of Display Filter examples at the Wireshark Wiki Display Filter
page at http://wiki.wireshark.org/DisplayFilters.
Display filter fields

Every field in the packet details pane can be used as a filter string, this will result in showing only
the packets where this field exists. For example: the filter string: tcp will show al packets contain-
ing the tcp protocol.

There is a complete list of al filter fields available through the menu item "Help/Supported Proto-
cols' in the page "Display Filter Fields" of the upcoming dialog.

XXX - add some more info here and alink to the statusbar info.

Comparing values

You can build display filters that compare values using a number of different comparison operators.
They are shown in Table 6.4, “Display Filter comparison operators’.

Tip!

You can use English and C-like terms in the same way, they can even be mixed in a
filter string!

Table 6.4. Display Filter comparison operators

English C-like Description and example
eq
== Equal
i p. addr==10.0.0.5
ne
I = Not equal
i p.addr!=10.0.0.5
gt
> Greater than
frame. pkt _len > 10
It
< Lessthan
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English C-like Description and example

frame. pkt _len < 128

ge

>= Greater than or equal to

frame. pkt _| en ge 0x100

<= Lessthan or equal to

frame. pkt _I en <= 0x20

In addition, all protocol fields are typed. Table 6.5, “Display Filter Field Types’ provides a list of

the types and example of how to express them.

Table6.5. Display Filter Field Types

Type

Example

Unsigned integer (8-bit, 16-bit, 24-bit, 32-hit)

You can express integers in decimal, octa, or
hexadecimal. The following display filters are
equivalent:

Signed integer (8-bit, 16-bit, 24-bit, 32-bit)

Boolean
A boolean field is present in the protocol decode
only if its value is true. For example,
tep.flags.syn is present, and thus true, only if the
SYN flagis present in a TCP segment header.
Thus the filter expression tcp.flags.syn will se-
lect only those packets for which this flag exists,
that is, TCP segments where the segment header
contains the SYN flag. Similarly, to find source-
routed token ring packets, use a filter expression
of tr.sr.

Ethernet address (6 bytes) eth.addr == ff:ffff:ffff:ff

IPv4 address ip.addr == 192.168.0.1

IPv6 address

IPX network number

String (text)

Double-precision floating point number

6.4.3. Combining expressions
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You can combine filter expressions in Wireshark using the logical operators shown in Table 6.6
“Display Filter Logical Operations”

Table 6.6. Display Filter Logical Operations

English C-like Description and example
and &&

Logical AND

i p. addr==10.0.0.5 and tcp.flags.fin
or [I

Logical OR

i p. addr==10.0.0.5 or ip.addr==192.1.1.1
xor A

Logical XOR

tr.dst[0:3] == 0.6.29 xor tr.src[0:3] == 0.6.29
not !

Logical NOT

not Ilc

[

Substring Oper ator

Wireshark allows you to select subsequences of a sequence in rather elab-
orate ways. After alabel you can place a pair of brackets [] containing a
comma separated list of range specifiers.

eth.src[0:3] == 00:00: 83

The example above uses the n:m format to specify a single range. In this
case n is the beginning offset and m is the length of the range being spe-
cified.

eth.src[1-2] == 00:83

The example above uses the n-m format to specify a single range. In this
case n isthe beginning offset and mis the ending offset.

eth.src[:4] == 00:00:83:00

The example above uses the :m format, which takes everything from the
beginning of a sequence to offset m. It isequivalent to O:m

eth.src[4:] == 20:20

=
[
[1%
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English C-like Description and example

The example above uses the n: format, which takes everything from offset
n to the end of the sequence.

eth.src[2] == 83

The example above uses the n format to specify asingle range. In this case
the element in the sequence at offset n is selected. This is equivaent to
n:1.

eth.src[0:3,1-2,:4,4:,2] ==
00: 00: 83: 00: 83:00: 00: 83: 00: 20: 20: 83

Wireshark allows you to string together single ranges in a comma separ-
ated list to form compound ranges as shown above.

6.4.4. A common mistake

@ War ning!
Using the != operator on combined expressions like: eth.addr, ip.addr, tcp.port,
udp.port and alike will probably not work as expected!

Often people use afilter string to display something like ip.addr == 1.2.3.4 which will display all
packets containing the IP address 1.2.3.4.

Then they useip.addr !'= 1.2.3.4 to see all packets not containing the |P address 1.2.3.4 in it. Unfor-
tunately, this does not do the expected.

Instead, that expression will even be true for packets where either source or destination IP address
equals 1.2.3.4. The reason for this, is that the expression ip.addr !'= 1.2.3.4 must be read as "the
packet contains a field named ip.addr with a value different from 1.2.3.4". As an |IP datagram con-
tains both a source and a destination address, the expression will evaluate to true whenever at least
one of the two addresses differsfrom 1.2.3.4.

If you want to filter out al packets containing IP datagrams to or from IP address 1.2.3.4, then the
correct filter is!(ip.addr == 1.2.3.4) as it reads "show me al the packets for which it is not true that
a field named ip.addr exists with a value of 1.2.3.4", or in other words, "filter out all packets for
which there are no occurrences of afield named ip.addr with the value 1.2.3.4".
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6.5. The "Filter Expression" dialog box

When you are accustomed to Wireshark's filtering system and know what labels you wish to use in
your filtersit can be very quick to simply type afilter string. However if you are new to Wireshark
or are working with a dlightly unfamiliar protocol it can be very confusing to try to figure out what
to type. The Filter Expression dialog box helps with this.

g Tip!
%
- The "Filter Expression” dialog box is an excellent way to learn how to write Wireshark
display filter strings.

Figure6.7. The" Filter Expression” dialog box

Wireshark: Filter Expression

Field name Relation

is present
JCOMENS ==
JEPP2 A11 1=
802,11 MaT
802,11 Radiotap
802,73 Slow protocols =

ap =
AaL1 conkains
AAL3 4 matches
AARP

ACAP

ACP133

ACSE

ACkrace

ADP

AFF v

HEHEEE

H EHEH

B E E

&QK H xgancel ‘

When you first bring up the Filter Expression dialog box you are shown a tree list of field names,
organized by protocol, and a box for selecting arelation.

Field Name Select a protocol field from the protocol field tree. Every protocol with filterable
fieldsis listed at the top level. By clicking on the "+" next to a protocol name you
can get alist of the field names available for filtering for that protocol.

Relation Select arelation from the list of available relation. The is present is a unary rela-
tion which is true if the selected field is present in a packet. All other listed rela-
tions are binary relations which require additional data (e.g. a Value to match) to
complete.

When you select afield from the field name list and select a binary relation (such as the equality re-
lation ==) you will be given the opportunity to enter avalue, and possibly some range information.
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Value

Predefined values

Range
OK

Cancel

You may enter an appropriate value in the Value text box. The Value
will also indicate the type of value for the field name you have selected
(like character string).

Some of the protocol fields have predefined values available, much like
enum's in C. If the selected protocol field has such values defined, you
can choose one of them here.

XXX - add an explanation here!

When you have built a satisfactory expression click OK and a filter
string will be built for you.

You can leave the Add Expression... dialog box without any effect by
clicking the Cancel
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6.6. Defining and saving filters

You can define filters with Wireshark and give them labels for later use. This can save timein re-

membering and retyping some of the more complex filters you use.

To define anew filter or edit an existing one, select the Capture Filters... menu item from the Cap-
ture menu or the Display Filters... menu item from the Analyze menu. Wireshark will then pop up
the Filters dialog as shown in Figure 6.8, “The "Capture Filters' and "Display Filters' dialog

boxes”.

Notel
: The mechanisms for defining and saving capture filters and display filters are aimost

identical. So both will be described here, differences between these two will be marked

as such.

@ Warning!
Y ou must use Save to save your filters permanently. Ok or Apply will not save the fil-

ters, so they will be lost when you close Wireshark.

Figure 6.8. The" CaptureFilters' and " Display Filters' dialog boxes

Wireshark: Display Filter
Edit Filker

S[=/e3

kpkk_long
kpkk_only
ethernet broadcast

ip broadcask

deerpc
DCERPC Fadlk

Properties
Filter name: |ip broadcask
Filter string: |ip.addr == 255,255.255.255 | ok Expression...

‘ @ Help

‘ P ox H W apply H [ save

‘ | X Close |

115




Working with captured packets

New

Delete

Filter

Filter name:

Filter string:

Add Expression...

OK

Apply

Save

Close

This button adds a new filter to the list of filters. The currently entered
values from Filter name and Filter string will be used. If any of these
fields are empty, it will be set to "new".

This button deletes the selected filter. It will be greyed out, if no filter is
selected.

You can select a filter from this list (which will fill in the filter name
and filter string in the fields down the bottom of the dialog box).

Y ou can change the name of the currently selected filter here.

—h Note!
The filter name will only be used in this dialog to identify

the filter for your convenience, it will not be used else-
where. You can add multiple filters with the same name,
but thisis not very useful.

Y ou can change the filter string of the currently selected filter here. Dis-
play Filter only: the string will be syntax checked while you are typing.

Display Filter only: This button brings up the Add Expression dialog
box which assists in building filter strings. Y ou can find more informa-
tion about the Add Expression dialog in Section 6.5, “The "Filter Ex-

pression” dialog box”

Display Filter only: This button applies the selected filter to the current
display and closes the dialog.

Display Filter only: This button applies the selected filter to the current
display, and keeps the dialog open.

Save the current settings in this dialog. The file location and format is
explained in Appendix A, Files and Folders.

Close thisdialog. Thiswill discard unsaved settings.
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6.7. Finding packets

You can easily find packets once you have captured some packets or have read in a previously saved
capture file. Simply select the Find Packet... menu item from the Edit menu. Wireshark will pop up
the dialog box shown in Figure 6.9, “The "Find Packet" dialog box”.

6.7.1. The "Find Packet" dialog box

Figure 6.9. The" Find Packet" dialog box

Wireshark: Find Packet
Find
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Y ou might first select the kind of thing to search for:

Display filter
Simply enter adisplay filter string into the Filter: field, select adirection, and click on OK.

For example, to find the three way handshake for a connection from host 192.168.0.1, use the
following filter string:

i p. addr==192. 168. 0.1 and tcp.fl ags. syn

For more details on display filters, see Section 6.3, “Filtering packets while viewing”

Hex Value

Search for a specific byte sequence in the packet data.

For example, use "00:00" to find the next packet including two null bytesin the packet data.
String

Find a string in the packet data, with various options.

The value to be found will by syntax checked while you type it in. If the syntax check of your value
succeeded, the background of the entry field will turn green, if it fails, it will turn red.
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Y ou can choose the direction to be searched for:

. Up

Search upwards in the packet list (decreasing packet numbers).

e Down

Search downwards in the packet list (increasing packet numbers).

6.7.2. The "Find Next" command

"Find Next" will continue searching with the same options like in the last "Find Packet" run.

6.7.3. The "Find Previous" command

"Find Previous" will do the same thing as"Find Next", but with reverse search direction.
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6.8. Go to a specific packet

6.8.1.

6.8.2.

6.8.3.

6.8.4.

6.8.5.

6.8.6.

You can easily jump to specific packets with one of the menu items in the Go menu.

The "Go Back" command

Go back in the packet history, works much like the page history in current web browsers.

The "Go Forward" command

Go forward in the packet history, works much like the page history in current web browsers.

The "Go to Packet" dialog box

Figure 6.10. The" Go To Packet" dialog box
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This dialog box will let you enter a packet number. When you press OK, Wireshark will jump to
that packet.

The "Go to Corresponding Packet" command

If a protocol field is selected which points to another packet in the capture file, this command will
jump to that packet.

Notel
As these protocol fields now work like links (just as in your Web browser), it's easier
to simply double-click on the field to jump to the corresponding field.

The "Go to First Packet" command

This command will simply jump to the first packet displayed.

The "Go to Last Packet" command

This command will simply jump to the last packet displayed.
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6.9. Marking packets

You can mark packets in the "Packet List" pane. A marked packet will be shown with black back-
ground, regardless of the coloring rules set. Marking a packet can be useful to find it later while ana-
lyzing in alarge capturefile.

@ War ning!
The packet marks are not stored in the capture file or anywhere else, so al packet
marks will be lost if you close the capturefile.

Y ou can use packet marking to control the output of packets when saving/exporting/printing. To do
S0, an option in the packet range is available, see Section 5.8, “ The Packet Range frame”.

There are three functions to manipul ate the marked state of a packet:

» Mark packet (toggle) toggles the marked state of a single packet.
* Mark all packets set the mark state of all packets.
* Unmark all packetsreset the mark state of all packets.

These mark function are available from the "Edit" menu, and the "Mark packet (toggle)" function is
also available from the pop-up menu of the "Packet List" pane.
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6.10. Time display formats and time
references

While packets are captured, each packet is timestamped. These timestamps will be saved to the cap-
turefile, so they will be available for later analysis.

A detailed description of timestamps, timezones and alike can be found at: Section 7.3, “Time
Stamps”.

The timestamp presentation format and the precision in the packet list can be chosen using the View
menu, see Figure 3.5, “The "View" Menu”.

The available presentation formats are:

» Date and Time of Day: 1970-01-01 01:02:03.123456 The absolute date and time of the day
when the packet was captured.

» Timeof Day: 01:02:03.123456 The absolute time of the day when the packet was captured.

» Seconds Since Beginning of Capture: 123.123456 The time relative to the start of the capture
file or the first "Time Reference" before this packet (see Section 6.10.1, “Packet time referen-

cing”).
» Seconds Since Previous Packet: 1.123456 The time relative to the previous packet.

The available precisions (aka. the number of displayed decimal places) are:

» Automatic Thetimestamp precision of the loaded capture file format will be used (the default).

» Seconds, Deciseconds, Centiseconds, Milliseconds, Microseconds or Nanoseconds The
timestamp precision will be forced to the given setting. If the actually available precision is
smaller, zeros will be appended. If the precision is larger, the remaining decimal places will be
cut off.

Precision example: If you have atimestamp and it's displayed using, " Seconds Since Previous Pack-
et", : the value might be 1.123456. This will be displayed using the "Automatic" setting for libpcap
files (which is microseconds). If you use Seconds it would show simply 1 and if you use Nano-
seconds it shows 1.123456000.

6.10.1. Packet time referencing

The user can set time references to packets. A time reference is the starting point for all subsequent
packet time calculations. It will be useful, if you want to see the time values relative to a special
packet, e.g. the start of anew request. It's possible to set multiple time references in the capture file.

@ Warning!
The time references will not be saved permanently and will be lost when you close the
capturefile.

—t Notel
Time referencing will only be useful, if the time display format is set to "Seconds
Since Beginning of Capture". If one of the other time display formats are used, time
referencing will have no effect (and will make no sense either).

121



Working with captured packets

To work with time references, choose one of the "Time Reference” items in the "Edit" menu , see
Section 3.6, “The "Edit" menu”, or from the pop-up menu of the "Packet List" pane.

e Set Time Reference (toggle) Toggles the time reference state of the currently selected packet to
on or off.

» Find Next Find the next time referenced packet in the "Packet List" pane.

e Find Previous Find the previous time referenced packet in the "Packet List" pane.

Figure 6.11. Wireshark showing atime referenced packet
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A time referenced packet will be marked with the string *REF* in the Time column (see packet
number 10). All subsequent packets will show the time since the last time reference.
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Chapter 7. Advanced Topics

7.1. Introduction

In this chapter some of the advanced features of Wireshark will be described.
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7.2. Following TCP streams

7.2.1.

If you are working with TCP based protocols it can be very helpful to see the data from a TCP
stream in the way that the application layer sees it. Perhaps you are looking for passwords in a Tel-
net stream, or you are trying to make sense of a data stream. Maybe you just need a display filter to
show only the packets of that TCP stream. If so, Wireshark's ability to follow a TCP stream will be
useful to you.

Simply select a TCP packet in the packet list of the stream/connection you are interested in and then
select the Follow TCP Stream menu item from the Wireshark Tools menu (or use the context menu
in the packet list). Wireshark will set an appropriate display filter and pop up a dialog box with all
the data from the TCP stream laid out in order, as shown in Figure 7.1, “The "Follow TCP Stream"

dialog box”.

Notel
It is worthwhile noting that Follow TCP Stream installs a display filter to select al the
packets in the TCP stream you have selected.

The "Follow TCP Stream" dialog box

Figure7.1. The" Follow TCP Stream" dialog box
Follow TCP Stream (=153

Stream Content

SUBESCRIEE Aupnp/service/LayeriForwarding HTTP 1.1

NT: upnp:ewent

ICallback: chttp: /192, 168.0.2:5000/notify s

Timeout: Second-1800

User-fgent: Mozilla/4.0 (compatible; UPnP/1.0; Windows WT/5.1)
Host: 192.168.0.1

IContent-Length: O

Pragma: no-cache

HTTP/1.0 200 OK

Connection: close

server: UPnP/1.0 UPnP-Device-Host/ 1.0
[Timeout: Second-1800

SID: uuid:cf

Entire canversation (358 bytes) w () A5CI O EBCDIC (O Hex Dump () C Arrays () Raw
@Help X Close l l 5] Fiker out This Stream

The stream content is displayed in the same sequence as it appeared on the network. Traffic from A
to B ismarked in red, while traffic from B to A is marked in blue. If you like, you can change these
colorsin the Edit/Preferences "Colors' page.

Non-printable characters will be replaced by dots. XXX - What about line wrapping (maximum line
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length) and CRNL conversions?

The stream content won't be updated while doing a live capture. To get the latest content you'll have
to reopen the dialog.

Y ou can choose from the following actions:

1. Save As Savethe stream datain the currently selected format.
2. Print Print the stream datain the currently selected format.

3. Direction Choose the stream direction to be displayed ("Entire conversation”, "data from A to
B only" or "datafrom B to A only").

4. Filter out this stream Apply a display filter removing the current TCP stream data from the
display.

5. Close Close this dialog box, leaving the current display filter in effect.

Y ou can choose to view the data in one of the following formats:

1. ASCII. Inthis view you see the data from each direction in ASCII. Obviously best for ASCI|
based protocols, e.g. HTTP.

2. EBCDIC. For the big-iron freaks out there.

3. HEX Dump. This allows you to see al the data. This will require a lot of screen space and is
best used with binary protocols.

4. C Arrays. Thisalowsyou to import the stream data into your own C program.
5. Raw. Thisalows you to load the unaltered stream data into a different program for further ex-

amination. The display will ook the same as the ASCII setting, but "Save As' will result in a
binary file.
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7.3. Time Stamps

7.3.1.

7.3.2.

7.3.3.

Time stamps, their precisions and all that can be quite confusing. This section will provide you with
information about what's going on while Wireshark processes time stamps.

While packets are captured, each packet is time stamped as it comes in. These time stamps will be
saved to the capture file, so they also will be available for (later) analysis.

So where do these time stamps come from? While capturing, Wireshark gets the time stamps from
the libpcap (WinPcap) library, which in turn get's them from the operating system kernel. If the cap-
ture data is loaded from a capture file, Wireshark obviously gets the data from that file.

Wireshark internals

The internal format that Wireshark uses to keep a packet time stamp consists of the date (in days
since 1.1.1970) and the time of day (in nanoseconds since midnight). Y ou can adjust the way Wire-
shark displays the time stamp datain the packet list, see the "Time Display Format" item in the Sec-
tion 3.7, “The "View" menu” for details.

While reading or writing capture files, Wireshark converts the time stamp data between the capture
file format and the internal format as required.

While capturing, Wireshark uses the libpcap (WinPcap) capture library which supports microsecond
resolution. Unless you are working with specialized capturing hardware, this resolution should be
adequate.

Capture file formats

Every capture file format that Wireshark knows support time stamps. The time stamp precision sup-
ported by a specific capture file format differs widely and varies from one second "0" to one nano-
second "0.123456789". Most file formats store the time stamps with a fixed precision (e.g. micro-
seconds), while some file formats are even capable to store the time stamp precision itself (whatever
the benefit may be).

The common libpcap capture file format that is used by Wireshark (and alot of other tools) supports
afixed microsecond resolution "0.123456" only.

a Notel

Writing data into a capture file format that doesn't provide the capability to store the
actual precision will lead to loss of information. Example: If you load a capture file
with nanosecond resolution and store the capture data to a libpcap file (with micro-
second resolution) Wireshark obviously must reduce the precision from nanosecond to
microsecond.

Accuracy

It's often asked: "Which time stamp accuracy is provided by Wireshark?'. Well, Wireshark doesn't
create any time stamps itself but simply get's them from "somewhere else" and displays them. So ac-
curacy will depend on the capture system (operating system, performance, ...) that you use. Because
of this, the above question is difficult to answer in a general way.

—h Notel
USB connected network adapters often provide a very bad time stamp accuracy. The
incoming packets have to take "a long and winding road" to travel through the USB
cable until they actually reach the kernel. As the incoming packets are time stamped
when they are processed by the kernel, this time stamping mechanism becomes very
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inaccurate.

Conclusion: don't use USB connected NIC's when you need precise time stamp accur-
acy! (XXX - are there any such NIC's that stamps already on the USB hardware?)
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7.4. Time Zones

If you travel across the planet, time zones can be confusing. If you get a capture file from some-
where around the world time zones can even be alot more confusing ;-)

First of all, there are two reasons why you may not need to think about time zones at all:

* You areonly interested in the time differences between the packet time stamps and don't need to
know the exact date and time of the captured packets (which is often the case).

* You don't get capture files from different time zones than your own, so there are smply no time

zone problems. For example: everyone in your team is working in the same time zone than your-
self.

What aretime zones?

People expect that the time reflects the sunset. Dawn should be in the morning maybe around
06:00 and dusk in the evening maybe at 20:00. These times will obviously vary depending on
the season. It would be very confusing if everyone on earth would use the same global time as
this would correspond to the sunset only at a small part of the world.

For that reason, the earth is split into several different time zones, each zone with alocal time
that corresponds to the local sunset.

The time zone's base time is UTC (Coordinated Universal Time) or Zulu Time (military and
aviation). The older term GMT (Greenwich Mean Time) shouldn't be used asiit is slightly in-
correct (up to 0.9 seconds difference to UTC). The UTC base time equals to O (based at
Greenwich, England) and all time zones have an offset to UTC between -12 to +14 hours!

For example: If you live in Berlin you are in a time zone one hour earlier than UTC, so you
are in time zone "+1" (time difference in hours compared to UTC). If it's 3 o'clock in Berlin
it's2 o'clock in UTC "at the same moment".

Be aware that at a few places on earth don't use time zones with even hour offsets (e.g. New
Delhi uses UTC+05:30)!

Further information can be found at: http://en.wikipedia.org/wiki/Time zone and ht-
tp://en.wikipedia.org/wiki/Coordinated Universal Time.

What is daylight saving time (DST)?

Daylight Saving Time (DST), also known as Summer Time, is intended to "save" some day-
light during the summer months. To do this, alot of countries (but not all!) add an DST hour
to the aready existing UTC offset. So you may need to take another hour (or in very rare
cases even two hours!) difference into your "time zone calculations”.

Unfortunately, the date at which DST actually takes effect is different throughout the world.
You may also note, that the northern and southern hemispheres have opposite DST's (e.g.
while it's summer in Europe it's winter in Australia).

Keep in mind: UTC remains the same all year around, regardless of DST!

Further information can be found at: http://en.wikipedia.org/wiki/Daylight_saving.

Further time zone and DST information can be found at: http://wwp.greenwichmeantime.com/ and
http://www.timeanddate.com/worldclock!/.
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7.4.1.

7.4.2.
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Set your computer's time correct!

If you work with people around the world, it's very helpful to set your computer's time and time
zoneright.

Y ou should set your computers time and time zone in the correct sequence:

1.  Setyour time zone to your current location
2. Set your computer's clock to the local time

Thisway you will tell your computer both the local time and also the time offset to UTC.

Tip!

%
If you travel around the world, it's an often made mistake to adjust the hours of your
computer clock to the local time. Don't adjust the hours but your time zone setting in-
stead! For your computer, the time is essentially the same as before, you are ssimply in
adifferent time zone with a different local timel

Tip!

\
You can use the Network Time Protocol (NTP) to automatically adjust your computer
to the correct time, by synchronizing it to internet NTP clock servers. NTP clients are
available for al operating systems that Wireshark supports (and for alot more), for ex-
amples see: http://www.ntp.org/.

Wireshark and Time Zones

So what's the relationship between Wireshark and time zones anyway?

Wireshark's native capture file format (libpcap format), and some other capture file formats, such as
the Windows Sniffer, EtherPeek, AiroPeek, and Sun snoop formats, save the arrival time of packets
as UTC values. UN*X systems, and "Windows NT based" systems (Windows NT 4.0, Windows
2000, Windows XP, Windows Server 2003, Windows Vista) represent time internally as UTC.
When Wireshark is capturing, no conversion is necessary. However, if the system time zone is not
set correctly, the system's UTC time might not be correctly set even if the system clock appears to
display correct local time. "Windows 9x based" systems (Windows 95, Windows 98, Windows Me)
represent time internally as local time. When capturing, WinPcap has to convert thetime to UTC be-
fore supplying it to Wireshark. If the system'stime zoneis not set correctly, that conversion will not
be done correctly.

Other capture file formats, such as the Microsoft Network Monitor, DOS-based Sniffer, and Net-
work Instruments Observer formats, save the arrival time of packets aslocal time values.

Internally to Wireshark, time stamps are represented in UTC; this means that, when reading capture
files that save the arrival time of packets as local time values, Wireshark must convert those local
time valuesto UTC values.

Wireshark in turn will display the time stamps aways in local time. The displaying computer will
convert them from UTC to local time and displays this (local) time. For capture files saving the ar-
rival time of packets as UTC values, this means that the arrival time will be displayed as the local
time in your time zone, which might not be the same as the arrival time in the time zone in which
the packet was captured. For capture files saving the arrival time of packets as local time values, the
conversion to UTC will be done using your time zone's offset from UTC and DST rules, which
means the conversion will not be done correctly; the conversion back to local time for display might
undo this correctly, in which case the arrival time will be displayed as the arrival time in which the
packet was captured.

130


http://www.ntp.org/

Advanced Topics

Table7.1. Time zone examplesfor UTC arrival times (without DST)

LosAngeles [New York [Madrid London Berlin Tokyo
Capture 10:00 10:00 10:00 10:00 10:00 10:00
File(UTC)
Local Offset|-8 -5 -1 0 +1 +9
toUTC
Displayed |02:00 05:00 09:00 10:00 11:00 19:00
Time (Local
Time)

An example: Let's assume that someone in Los Angeles captured a packet with Wireshark at exactly
2 o'clock local time and sents you this capture file. The capture file's time stamp will be represented
in UTC as 10 o'clock. You are located in Berlin and will see 11 o'clock on your Wireshark display.

Now you have a phone call, video conference or internet meeting with that one to talk about that
capture file. As you are both looking at the displayed time on your local computers, the one in Los
Angeles still sees 2 o'clock but you in Berlin will see 11 o'clock. The time displays are different as
both Wireshark displays will show the (different) local times at the same point in time.

Conclusion: Y ou may not bother about the date/time of the time stamp you currently look at, unless
you must make sure that the date/time is as expected. So, if you get a capture file from a different
time zone and/or DST, you'll have to find out the time zone/DST difference between the two local
times and "mentally adjust" the time stamps accordingly. In any case, make sure that every com-
puter in question has the correct time and time zone setting.
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7.5. Packet Reassembling
7.5.1. What is it?

7.5.2.

Network protocols often need to transport large chunks of data, which are complete in itself, e.g.
when transferring a file. The underlying protocol might not be able to handle that chunk size (e.g.
limitation of the network packet size), or is stream-based like TCP, which doesn't know data chunks
at all.

In that case the network protocol has to handle that chunk boundariesitself and (if required) spread-
ing the data over multiple packets. It obviously also needs a mechanism to find back the chunk
boundaries on the receiving side.

Tip!

%
Wireshark calls this mechanism reassembling, although a specific protocol specifica
tion might use a different term for this (e.g. desegmentation, defragmentation, ...).

How Wireshark handles it

For some of the network protocols Wireshark knows of, a mechanism is implemented to find, de-
code and display these chunks of data. Wireshark will try to find the corresponding packets of this
chunk, and will show the combined data as additional pagesin the "Packet Bytes' pane (for inform-
ation about this pane, see Section 3.17, “The "Packet Bytes' pane”).

Figure 7.2. The" Packet Bytes' panewith areassembled tab

0000 0% 00 06 ab 04 53 08 00 06 éb Ff bd 03 00 45 00 =T I o -~
0010 01 48 33 o7 00 00 1e 11 dd 51 bc as 0% 0a b as SHILL L Oavvnns
00z0 02 32 41 af 07 04 01 34 00 b4 04 00 2e 00 10 0O sZA et i
000 00 00 00 00 a0 de 97 &c dl 11 8¢ 71 00 57 S0 fo ....... T ...0.%W.. w

Frame (342 bytes) | Reassembled DCE(RPC {1604 bytes)

— Notel
Reassembling might take place at several protocol layers, so it's possible that multiple
tabsin the "Packet Bytes' pane appear.

_ﬁ Note!
Y ou will find the reassembled data in the last packet of the chunk.

An example: InaHTTP GET response, the requested data (e.g. a HTML page) is returned. Wire-
shark will show the hex dump of the datain a new tab "Uncompressed entity body" in the "Packet
Bytes' pane.

Reassembling is enabled in the preferences by default. The defaults were changed from disabled to
enabled in September 2005. If you created your preference settings before this date, you might ook
if reassembling is actually enabled, asit can be extremely helpful while analyzing network packets.
The enabling or disabling of the reassemble settings of a protocol typically requires two things:

1. thelower level protocol (e.g., TCP) must support reassembly. Often this reassembly can be en-
abled or disabled viathe protocol preferences.
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2. thehigher level protocol (e.g., HTTP) must use the reassembly mechanism to reassemble frag-
mented protocol data. This too can often be enabled or disabled viathe protocol preferences.

The tooltip of the higher level protocol setting will note you if and which lower level protocol set-
ting has to be considered too.
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7.6. Name Resolution

7.6.1.

7.6.2.

Name resolution tries to resolve some of the numerical address values into a human readable format.
There are two possible ways to do this conversations, depending on the resolution to be done: call-
ing system/network services (like the gethostname function) and/or evaluate from Wireshark specif-
ic configuration files. For details about the configuration files Wireshark uses for name resolution
and alike, see Appendix A, Files and Folders.

The name resolution feature can be en-/disabled separately for the protocol layers of the following
sections.

Name Resolution drawbacks

Name resolution can be invaluable while working with Wireshark and may save you even hours of
work. Unfortunately, it also hasit's drawbacks.

» Name resolution will often fail. The name to be resolved might simply be unknown by the
name servers asked or the servers are just not available and the name is also not found in Wire-
shark's configuration files.

e Theresolved names are not stored in the capture file or somewhere else. So the resolved
names might not be available if you open the capture file later or on a different machine. Each
time you open a capture file it may look "dightly different”, maybe simply because you can't
connect a name server (which you could connect before).

 DNS may add additional packetsto your capturefile. You may see packets to/from your ma-
chine in your capture file, which are caused by name resolution network services of the machine
Wireshark captures from. XXX - are there any other such packets than DNS ones?

» Resolved DNS names ar e cached by Wireshark. This is required for acceptable performance.
However, if the name resolution information should change while Wireshark is running, Wire-
shark won't notice a change to the name resolution information once it's get cached. If thisin-
formation changes while Wireshark is running, e.g. a new DHCP lease takes effect, Wireshark
won't notice it. XXX - isthistruefor al or only for DNSinfo?

Tip!

R
The name resolution in the packet list is done while the list isfilled. If a name could be
resolved after a packet was added to the list, that former entry won't be changed. As
the name resol ution results are cached, you can use "View/Reload" to rebuild the pack-
et list, this time with the correctly resolved names. However, thisisn't possible while a
captureisin progress.

Ethernet name resolution (MAC layer)

Try to resolve an Ethernet MAC address (e.g. 00:09:5b:01:02:03) to something more "human read-
able'.

ARP name resolution (system service) Wireshark will ask the operating system to convert an eth-
ernet address to the corresponding IP address (e.g. 00:09:5b:01:02:03 -> 192.168.0.1).

Ethernet codes (ethersfile) If the ARP name resolution failed, Wireshark tries to convert the ether-
net address to a known device name, which has been assigned by the user using an ethersfile (e.g.
00:09:5b:01:02:03 -> homerouter).

Ethernet manufacturer codes (manuf file) If both ARP and ethers didn't returned a result, Wire-
shark tries to convert the first 3 bytes of an ethernet address to an abbreviated manufacturer name,
which has been assigned by the IEC (e.g. 00:09:5b:01:02:03 -> Netgear_01:02:03).
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IP name resolution (network layer)

Try to resolve an | P address (e.g. 216.239.37.99) to something more "human readable”.

DNS/ADNS name resolution (system/library service) Wireshark will ask the operating system (or
the ADNS library), to convert an I P address to the hostname associated with it (e.g. 216.239.37.99 -
> www.1.google.com). The DNS service is using synchronous calls to the DNS server. So Wire-
shark will stop responding until aresponse to a DNS request is returned. If possible, you might con-
sider using the ADNS library (which won't wait for a network response).

@ Warning!
Enabling network name resolution when your name server is unavailable may signific-
antly slow down Wireshark while it waits for al of the name server requests to time
out. Use ADNS in that case.

DNS vs. ADNS here's a short comparison: Both mechanisms are used to convert an IP address to
some human readable (domain) name. The usual DNS call gethostname() will try to convert the ad-
dress to aname. To do this, it will first ask the systems hosts file (e.g. /etc/hosts) if it finds a match-
ing entry. If that fails, it will ask the configured DNS server(s) about the name.

So the real difference between DNS and ADNS comes when the system has to wait for the DNS
server about a name resolution. The system call gethostname() will wait until a name is resolved or
an error occurs. If the DNS server is unavailable, this might take quite a while (several seconds).
The ADNS service will work a bit differently. It will also ask the DNS server, but it won't wait for
the answer. It will just return to Wireshark in a very short amount of time. The actua (and the fol-
lowing) address fields won't show the resolved name until the ADNS call returned. As mentioned
above, the values get cached, so you can use View/Reload to "update” these fields to show the re-
solved values.

hosts name resolution (hosts file) If DNS name resolution failed, Wireshark will try to convert an

IP address to the hostname associated with it, using a hosts file provided by the user (e.g.
216.239.37.99 -> www.google.com).

IPX name resolution (network layer)

ipxnet name resolution (ipxnetsfile) XXX - add ipxnets name resol ution explanation.

TCP/UDP port name resolution (transport layer)

Try to resolve a TCP/UDP port (e.g. 80) to something more "human readable".

TCP/UDP port conversion (system service) Wireshark will ask the operating system to convert a
TCP or UDP port to its well known name (e.g. 80 -> http).

XXX - mention the role of the /etc/servicesfile (but don't forget the files and folders section)!
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7.7. Checksums

Several network protocols use checksums to ensure data integrity.

Tip!
N
Applying checksums as described hereis also known as redundancy check.

What ar e checksums for ?

Checksums are used to ensure the integrity of data portions for data transmission or storage.
A checksum is basically a calculated summary of such a data portion.

Network data transmissions often produce errors, such as toggled, missing or duplicated bits.
As a result, the data received might not be identical to the data transmitted, which is obvi-
oudly a bad thing.

Because of these transmission errors, network protocols very often use checksums to detect
such errors. The transmitter will calculate a checksum of the data and transmits the data to-
gether with the checksum. The receiver will calculate the checksum of the received data with
the same algorithm as the transmitter. If the received and calculated checksums don't match a
transmission error has occured.

Some checksum algorithms are able to recover (simple) errors by calculating where the ex-
pected error must be and repairing it.

If there are errors that cannot be recovered, the receiving side throws away the packet. De-
pending on the network protocol, this data loss is simply ignored or the sending side needs to
detect this loss somehow and retransmits the required packet(s).

Using a checksum drastically reduces the number of undetected transmission errors.
However, the usual checksum algorithms cannot guarantee an error detection of 100%, so a
very small number of transmission errors may remain undetected.

There are several different kinds of checksum algorithms, an example of an often used check-
sum algorithm is CRC32. The checksum algorithm actually chosen for a specific network
protocol will depend on the expected error rate of the network medium, the importance of er-
ror detection, the processor load to perform the calculation, the performance needed and
many other things.

Further information about checksums can be found at: http:/ / en.wikipedia.org/ wiki/
Checksum.

7.7.1. Wireshark checksum validation

Wireshark will validate the checksums of several potocals, e.g.: IP, TCP, ...

It will do the same calculation as a "normal receiver" would do, and shows the checksum fields in
the packet details with a comment, e.g.: [correct], [invalid, must be 0x12345678] or alike.

Checksum validation can be switched off for various protocols in the Wireshark protocol prefer-
ences, e.g. to (very dlightly) increase performance.

If the checksum validation is enabled and it detected an invalid checksum, features like packet reas-
sembling won't be processed. This is avoided as incorrect connection data could "confuse" the in-
ternal database.
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7.7.2. Checksum offloading

The checksum calculation might be done by the network driver, protocol driver or even in hardware.

For example: The Ethernet transmitting hardware calculates the Ethernet CRC32 checksum and the
receiving hardware validates this checksum. If the received checksum is wrong Wireshark won't
even see the packet, as the Ethernet hardware internally throws away the packet.

Higher level checksums are "traditionally" calculated by the protocol implementation and the com-
pleted packet is then handed over to the hardware.

Recent network hardware can perform advanced features such as IP checksum calculation, also
known as checksum offloading. The network driver won't calculate the checksum itself but simply
hand over an empty (zero or garbage filled) checksum field to the hardware.

Notel

Checksum offloading often causes confusion as the network packets to be transmitted
are handed over to Wireshark before the checksums are actually calculated. Wireshark
gets these "empty" checksums and displays them as invalid, even though the packets
will contain valid checksums when they leave the network hardware later.

Checksum offloading can be confusing and having a lot of [invalid] messages on the screen can be
quite annoying. As mentioned above, invalid checksums may lead to unreassembled packets, mak-
ing the analysis of the packet data much harder.

Y ou can do two things to avoid this checksum offloading problem:

e Turn off the checksum offloading in the network driver, if this option is available.

* Turn off checksum validation of the specific protocol in the Wireshark preferences.
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Chapter 8. Statistics

8.1. Introduction

Wireshark provides awide range of network statistics.

These statistics range from genera information about the loaded capture file (like the number of
captured packets), to statistics about specific protocols (e.g. statistics about the number of HTTP re-
quests and responses captured).

* Generd statistics:

Summary about the capturefile.

Protocol Hierarchy of the captured packets.

Endpoints e.g. traffic to and from an |P addresses.
Conversations e.g. traffic between specific |P addresses.

IO Graphs visualizing the number of packets (or similar) intime.

» Protocol specific statistics:

Service Response Time between request and response of some protocols.

Various other protocol specific statistics.

—h Note!
The protocol specific statistics requires detailed knowledge about the specific protocol.

Unless you are familiar with that protocol, statistics about it will be pretty hard to un-
derstand.
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8.2. The "Summary" window

General statistics about the current capturefile.

Figure8.1. The" Summary" window

Wireshark: Summary

File
Rlarne: D fkest, pcap
Length: 15317 bytes
Format: Wireshark/tcpdump). .. - libpcap
Packet size limit: 65535 bytes

Tirne
First packet: 2004-06-22 20:02:458
Last packet: 2004-06-22 20602:50
Elapsed: 00:00:02

Display
Display Filter:
Marked packets:

Traffic Zaptured Displayed

Between first and lask packet 2,113 sec
Packets 120

Ay, packets/sec 56,739

&g, packetk size 111,000 bykes
Bvtes 13373

avy, bytesisec G325, 662
Avg, MBiksec

(B |
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File general information about the capturefile.

Time the timestamps when the first and the last packet were capturing (and the time between
them).

Captureinformation from the time when the capture was done (only available if the packet data
was captured from the network and not loaded from afile).

Display some display related information.

Traffic some statistics of the network traffic seen. If adisplay filter is set, you will see valuesin
both columns. The values in the Captured column will remain the same as before, while the
valuesin the Displayed column will reflect the values corresponding to the packets shown in the

display.
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8.3. The "Protocol Hierarchy" window

The protocol hierarchy of the captured packets.

Figure 8.2. The" Protocol Hierarchy" window

Wireshark: Protocol Hierarchy Statistics

Protocol % Packets | Packets Bytes Mbitfs End Packets End Bytes End Mbitjs
B Frame 0
= Ethernet 100,00% 120 13373 0,051 u] u] 0,000
Address Resolution Protocol 0,83% 1 42 0,000 1 4z 0,000
= Internet Protocol 99,17%: 119 13331 0,050 0 i} 0,000
= User Diakagram Protocol 10,83%: 13 1663 0,006 u] u] 0,000
MekBIOS Mame Service 4,17% 5 585 0,002 5 585 0,002
Darmain Mame Service 5,00% 5] 566 0,002 ] S66 0,002
Daka 1,67% 2 512 0,002 2 512 0,002
Internet Control Message Protocol 0,583% 1 F00 0,000 1 70 0,000
Internet Group Management Protocol 1,67% 2 10§ 0,000 z 108 0,000
= Transmission Control Protocol 85,83% 103 11490 0,044 a0 4650 0,018
Daka 16,67% 20 ee60 0,025 20 GEE0 0,025
Malformed Packet 2,50% 3 10 0,001 3 180 0,001

Ex

Thisisatree of al the protocolsin the capture. Y ou can collapse or expand subtrees, by clicking on
the plus/ minusicons. By default, all trees are expanded.

Each row contains the statistical values of one protocol.

The following columns containing the statistical values are available:

» Protocal this protocol's name

* % Packetsthe percentage of protocol packets, relative to all packetsin the capture
» Packetsthe absolute number of packets of this protocol

* Bytesthe absolute number of bytes of this protocol

» MBIt/sthe bandwidth of this protocol, relative to the capture time

« End Packets the absolute number of packets of this protocol (where this protocol were the
highest protocol to decode)

» End Bytes the absolute number of bytes of this protocol (where this protocol were the highest
protocol to decode)

» End MBIt/s the bandwidth of this protocol, relative to the capture time (where this protocol
were the highest protocol to decode)
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W

W

[y

Notel

Packets will usually contain multiple protocols, so more than one protocol will be
counted for each packet. Example: In the screenshot IP has 99,17% and TCP 85,83%
(which istogether much more than 100%).

Notel

Protocol layers can consist of packets that won't contain any higher layer protocol, so
the sum of all higher layer packets may not sum up to the protocols packet count. Ex-
ample: In the screenshot TCP has 85,83% but the sum of the subprotocols (HTTP, ...)
is much less. This may be caused by TCP protocol overhead, e.g. TCP ACK packets
won't be counted as packets of the higher layer).

Notel

A single packet can contain the same protocol more than once. In this case, the pro-
tocol is counted more than once. For example: in some tunneling configurations the IP
layer can appear twice.
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8.4. Endpoints

8.4.1.

8.4.2.

Statistics of the endpoints captured.

Tip!

\
If you are looking for a feature other network tools call a hostlist, here is the right
place to look. The list of Ethernet or IP endpointsis usually what you're looking for.

What is an Endpoint?

A network endpoint is the logical endpoint of separate protocol traffic of a specific protocol layer.
The endpoint statistics of Wireshark will take the following endpoints into account:

» Ethernet an Ethernet endpoint isidentical to the Ethernet's MAC address.

* FibreChanne XXX - insert info here.

e FDDI aFDDI endpoint isidentical to the FDDI MAC address.

* |Pv4 anIPendpoint isidentical toits IP address.

o IPX XXX -insertinfo here.

* TCPaTCP endpoint is acombination of the |P address and the TCP port used, so different TCP
ports on the same | P address are different TCP endpoints.

» Token Ring aToken Ring endpoint isidentical to the Token Ring MAC address.

» UDP a UDP endpoint is a combination of the IP address and the UDP port used, so different
UDP ports on the same | P address are different UDP endpoints.

—a Broadcast / multicast endpoints

Broadcast / multicast traffic will be shown separately as additional endpoints. Of
course, as these endpoints are virtual endpoints, the real traffic will be received by all
(multicast: some) of the listed unicast endpoints.

The "Endpoints" window

This window shows statistics about the endpoints captured.

Figure 8.3. The" Endpoints' window
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Endpoints: test. pcap

EBroadcast

01:00:5e: 7F:ff:fa

01:00:5e:00:00:16 2

120

1

13373

108
175

GOa0 [

Ethernet: 5 IPvd: 5 TP 11 UDP: 10
Ethernet Endpoints
Address Packets Bytes Tx Packets  * Tx Bytes R Packets R Bykes
hetgear_Zd:75:9a 114 12828 Bz F313 52 5515
192,165.0.2 56

7313

Apply as Filker ¥ | Selecter
Prepare a Filter »
Find Frame k.
Colorize Host Traffic

Mok Selected
and Selected
v 0 Selecked

... and not Selected
... of not Selected

| |

Mame resolution
B

For each supported protocol, atab is shown in this window. The tab labels shows the number of en-
dpoints captured (e.g. the tab label "Ethernet: 5" tells you that five ethernet endpoints have been
captured). If no endpoints of a specific protocol were captured, the tab label will be grayed out
(although the related page can still be selected).

Each row in the list shows the statistical values for exactly one endpoint.

Name resolution will be done if selected in the window and if it is active for the specific protocol
layer (MAC layer for the selected Ethernet endpoints page). As you might have noticed, the first
row has a name resolution of the first three bytes "Netgear”, the second row's address was resolved
to an IP address (using ARP) and the third was resolved to a broadcast (unresolved this would still
be: ff:ff:ff:ff:ff:ff), the last two Ethernet addresses remain unresolved.

3 Tip!

\
This window will be updated frequently, so it will be useful, even if you open it before
(or while) you are doing alive capture.

The protocol specific "Endpoint List" windows

Before the combined window described above was available, each of its pages were shown as separ-
ate windows. Even though the combined window is much more convenient to use, these separate
windows are till available. The main reason is, they might process faster for very large capture
files. However, as the functionality is exactly the same as in the combined window, they won't be
discussed in detail here.
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8.5. Conversations

8.5.1.

8.5.2.

8.5.3.

Statistics of the captured conversations.

What is a Conversation?

A network conversation is the traffic between two specific endpoints. For example, an IP conversa-
tion is all the traffic between two | P addresses. The description of the known endpoint types can be
found in Section 8.4.1, “What is an Endpoint?’.

The "Conversations" window

Beside the list content, the conversations window work the same way as the endpoint ones, see Sec-
tion 8.4.2, “The "Endpoints’ window” for a description how it works.

Figure8.4. The" Conversations' window

Conversations: test. pcap

Ethernet: 4 IPvd: 4 TCP: @ UDP: 7
Ethetnet Conversations
Address A Address B Packets | Bytes Packets A->B Bytes A->B Packets A<-B Bytes A<-B
192.1658.0.2 01:00:5e:7F:fffa L 175 1 175 i i
192.168.0.2 01:00:5:00:00:16 2 ws oz 108 i i
192.1658.0.2 EBroadcast 3 262 3 262 1]
hetgear 2d:75:9a 192,165.0.2 31
R A Apply as Fiter v [ Selected v P
Prepare a Filker k| Mok Selected H A--=B
Find Packet »| ... and Selected KA <-B
Colorize Conversation ¥ | ... or Selected H| A - ANY
+vand not Selected b A - ANY
... of not Selected b A - ANy
ANY <->B
AMY <--B
ANY --= B
l Copy

Mame resolution

]
Ex

The protocol specific "Conversation List"

windows

Before the combined window described above was available, each of its pages were shown as separ-
ate windows. Even though the combined window is much more convenient to use, these separate
windows are till available. The main reason is, they might process faster for very large capture
files. However, as the functionality is exactly the same as in the combined window, they won't be
discussed in detail here.
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8.6. The "10 Graphs" window

User configurable graph of the captured network packets.

Y ou can define up to five differently colored graphs.

Figure8.5. The" 10 Graphs' window

Wireshark |10 Graphs: test.pcap [Z| [E| rs__(|

T T T T | T T T T | T T T | T T T T | T 0
0.50=s 1. 0s 1.50s £, 0s
¢ E
Garaphs ¥ Axis
&raph 1 | Color @ Filter: | | Style: | Line w || Tickinterval:| 0,01 sec |
Pixels per kick: Z W
araph 2| Color |E Eilter: |LI':|D | Style: | Line A

Graph 3 | Color E Filter: | | Stvle: | Line WY Axis

LIk Packets|Tick | w
Graph 4 | Color E Filter: | | Style: | Line b

Scale: 10 A
Graph 5| Color @ Filter: | | Style: | Line hd

B (%o ]

The user can configure the following things:

e Graphs
e Graph 1-5 enable the graph 1-5 (only graph 1 is enabled by default)
e Color the color of the graph (cannot be changed)

» Filter: adisplay filter for this graph (only the packets that pass this filter will be taken into
account for that graph)

e Style: the style of the graph (Line/lmpul se/FBar)

X Axis
e Tick interval aninterval in x direction lasts (10/1/0.1/0.01/0.001 seconds)
» Pixelsper tick use 10/5/2/1 pixels per tick interval

* Y Axis
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e Unit the unit for they direction (Packets/Tick, Bytes/Tick, Advanced...)
» Scalethe scale for the y unit (10,20,50,100,200,500,...)

XXX - describe the Advanced feature.
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8.7. Service Response Time

The service response time is the time between a request and the corresponding response. This in-
formation is available for many protocols.

Service response time statistics are currently available for the following protocols:

« DCE-RPC

* FibreChannéel
« H.225RAS

« LDAP

e MGCP

« ONC-RPC

+ SMB

As an example, the DCE-RPC service response timeis described in more detail.

Notel

The other Service Response Time windows will work the same way (or only slightly
different) compared to the following description.

8.7.1. The "Service Response Time DCE-RPC" window

The service response time of DCE-RPC is the time between the request and the corresponding re-
sponse.

First of all, you have to select the DCE-RPC interface:

Figure 8.6. The" Compute DCE-RPC statistics® window

Wireshark: Compute DCE-RPC 5RT statistics : E|[E|

Program: ATSMC - EPM Version:

|E} Filcer:

@Create Skat ‘ x i_ancel

Y ou can optionally set a display filter, to reduce the amount of packets.
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Figure8.7. The" DCE-RPC Statistic for ..." window

DCE-RPC Service Response Time statistics for, EPM major, version 3: test

DCE-RPC Service Response Time statiskics For EPM major version 3: test, pcap
Filter:

ndex  Procedure Zalls | MinSRT Max SRT Ayvg SRT

XK Close I

Each row corresponds to a method of the interface selected (so the EPM interface in version 3 has 7
methods). For each method the number of calls, and the statistics of the SRT timeis calcul ated.
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8.8. The protocol specific statistics windows

The protocol specific statistics windows display detailed information of specific protocols and might
be described in alater version of this document.

Some of these statistics are described at the http://wiki.wireshark.org/Statistics pages.
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Chapter 9. Customizing Wireshark
9.1. Introduction

Wireshark's default behaviour will usually suit your needs pretty well. However, as you become
more familiar with Wireshark, it can be customized in various ways to suit your needs even better.
In this chapter we explore:
e How to start Wireshark with command line parameters

How to colorize the packet list

e How to control protocol dissection

How to use the various preference settings
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9.2. Start Wireshark from the command line

Y ou can start Wireshark from the command line, but it can also be started from most Window man-
agers aswell. In this section we will look at starting it from the command line.

Wireshark supports alarge number of command line parameters. To see what they are, ssimply enter
the command wireshark -h and the help information shown in Example 9.1, “Help information
available from Wireshark” (or something similar) should be printed.

Example 9.1. Help information available from Wireshark

Version 0.99.0
Copyright 1998-2006 Gerald Conbs <geral d@u reshark. org> and contri butors.

Conpiled with GTK+ 2.6.9, with GLib 2.6.6, with WnPcap (versi on unknown),
with libz 1.2.3, with libpcre 6.4, with Net-SNWP 5.2.2, with ADNS, with Lua 5.1

Running with WnPcap version 3.1 (packet.dll version 3, 1, 0, 27), based on
i bpcap version 0.9[.x] on Wndows XP Service Pack 2, build 2600.

wireshark [ -vh ] [ -DklLnp@ ] [ -a <capture autostop condition> ]
-b <capture ring buffer option> ]

-B <capture buffer size> |

-Cc <capture packet count>] [ -f <capture filter> ]

-g <packet nunber> ] [ -i <capture interface>] [ -m<font> ]

-N <nane resolving flags>] [ -0 <preference/recent setting>1] ...

r <infile>] [ -R <read (display) filter>] [ -s <capture snaplen> ]
t <time stanp format> ] [ -w <savefile>] [ -y <capture |link type> ]
X <eXtension option>] [ -z <statistics>] [ <infile>]

We will examine each of the command line optionsin turn.

The first thing to notice is that issuing the command wireshark by itself will bring up Wireshark.
However, you can include as many of the command line parameters as you like. Their meanings are
as follows ( in alphabetical order ): XXX - is the aphabetical order a good choice? Maybe better
task based?

-a <capture autostop condition>  Specify a criterion that specifies when Wireshark is to stop
writing to a capture file. The criterion is of the form
test:value, where test is one of:

duration:value Stop writing to a capture file after
value of seconds have elapsed.
filesize:value Stop writing to a capture file after it

reaches a size of value kilobytes
(where a kilobyte is 1000 bytes, not
1024 bytes). If this option is used to-
gether with the -b option, Wireshark
will stop writing to the current capture
file and switch to the next one if files-
izeisreached.

files:value Stop writing to capture files after
value number of files were written.

-b <capturering buffer option> If a maximum capture file size was specified, cause Wire-
shark to run in "ring buffer" mode, with the specified number
of files. In "ring buffer" mode, Wireshark will write to several
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-B <capture buffer size (Win32
only)>

-c <capture packet count>

-f <capturefilter>

-g <packet number>

-h

capture files. Their name is based on the number of the file
and on the creation date and time.

When the first capture file fills up, Wireshark will switch to
writing to the next file, until it fills up the last file, at which
point it'll discard the data in the first file (unless O is spe-
cified, in which case, the number of files is unlimited) and
start writing to that file and so on.

If the optional duration is specified, Wireshark will switch
also to the next file when the specified number of seconds has
elapsed even if the current file is not completely fills up.

duration:value Switch to the next file after value
seconds have elapsed, even if the cur-
rent fileis not completely filled up.

filesize:value Switch to the next file after it reaches
asize of value kilobytes (where akilo-
byte is 1000 bytes, not 1024 bytes).

filesvalue Begin again with the first file after
value number of files were written
(form aring buffer).

Win32 only: set capture buffer size (in MB, default is IMB).
Thisisused by the the capture driver to buffer packet data un-
til that data can be written to disk. If you encounter packet
drops while capturing, try to increase this size.

This option specifies the maximum number of packets to cap-
ture when capturing live data. It would be used in conjunction
with the -k option.

Print alist of the interfaces on which Wireshark can capture,
and exit. For each network interface, a number and an inter-
face name, possibly followed by a text description of the in-
terface, is printed. The interface name or the number can be
supplied to the -i flag to specify an interface on which to cap-
ture.

This can be useful on systems that don't have a command to
list them (e.g., Windows systems, or UNIX systems lacking
ifconfig -a); the number can be useful on Windows 2000 and
later systems, where the interface name is a somewhat com-
plex string.

Note that "can capture” means that Wireshark was able to
open that device to do a live capture; if, on your system, a
program doing a network capture must be run from an ac-
count with specia privileges (for example, as root), then, if
Wireshark is run with the -D flag and is not run from such an
account, it will not list any interfaces.

This option sets the initial capture filter expression to be used
when capturing packets.

After reading in a capture file using the -r flag, go to the giv-
en packet number.

The -h option requests Wireshark to print its version and us-
age instructions (as shown above) and exit.
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-i <captureinterface>

-L

-m <font>

-N <nameresolving flags>

-0 <preference/recent settings>

Set the name of the network interface or pipe to use for live
packet capture.

Network interface names should match one of the names lis-
ted in wireshark -D (described above); a number, as reported
by wireshark -D, can also be used. If you're using UNIX,
netstat -i or ifconfig -a might also work to list interface
names, athough not all versions of UNIX support the -a flag
to ifconfig.

If no interface is specified, Wireshark searches the list of in-
terfaces, choosing the first non-loopback interface if there are
any non-loopback interfaces, and choosing the first loopback
interface if there are no non-loopback interfaces; if there are
no interfaces, Wireshark reports an error and doesn't start the
capture.

Pipe names should be either the name of a FIFO (hamed pipe)
or -" to read data from the standard input. Data read from
pipes must be in standard libpcap format.

The -k option specifies that Wireshark should start capturing
packets immediately. This option requires the use of the -i
parameter to specify the interface that packet capture will oc-
cur from.

This option turns on automatic scrolling if the packet list pane
is being updated automatically as packets arrive during a cap-
ture ( as specified by the -Sflag).

List the data link types supported by the interface and exit.

This option sets the name of the font used for most text dis-
played by Wireshark. XXX - add an example!

Disable network object name resolution (such as hostname,
TCP and UDP port names).

Turns on hame resolving for particular types of addresses and
port numbers; the argument is a string that may contain the
letters m to enable MAC address resolution, n to enable net-
work address resolution, and t to enable transport-layer port
number resolution. This overrides -n if both -N and -n are
present. The letter C enables concurrent (asynchronous) DNS
lookups.

Sets a preference or recent value, overriding the default value
and any value read from a preference/recent file. The argu-
ment to the flag is a string of the form prefname:value, where
prefname is the name of the preference (which is the same
name that would appear in the preference/recent file), and
value is the value to which it should be set. Multiple instances
of -0 <preference settings> can be given on a single com-
mand line.

An example of setting a single preference would be;
wireshark -o mgcp.display_dissect_tree TRUE
An example of setting multiple preferences would be:

wireshark -0 mgcp.display_dissect_treee TRUE -0
mgcp.udp.callagent_port:2627
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Tip!

%
You can get a list of all available preference
strings from the preferences file, see Ap-
pendix A, Files and Folders.

-p Don't put the interface into promiscuous mode. Note that the
interface might be in promiscuous mode for some other reas-
on; hence, -p cannot be used to ensure that the only traffic
that is captured is traffic sent to or from the machine on
which Wireshark is running, broadcast traffic, and multicast
traffic to addresses received by that machine.

-Q This option forces Wireshark to exit when capturing is com-
plete. It can be used with the -c option. It must be used in
conjunction with the -i and -w options.

-r <infile> This option provides the name of a capture file for Wireshark
to read and display. This capture file can be in one of the
formats Wireshark understands.

-R <read (display) filter> This option specifies a display filter to be applied when read-
ing packets from a capture file. The syntax of thisfilter is that
of the display filters discussed in Section 6.3, “Filtering pack-
ets while viewing”. Packets not matching the filter are dis-

carded.

-s <capture snaplen> This option specifies the snapshot length to use when captur-
ing packets. Wireshark will only capture <snaplen> bytes of
datafor each packet.

-S This option specifies that Wireshark will display packets as it

captures them. This is done by capturing in one process and
displaying them in a separate process. Thisisthe same as"Up-
date list of packetsin real time" in the Capture Options dialog
box.

-t <time stamp format> This option sets the format of packet timestamps that are dis-
played in the packet list window. The format can be one of:

« r relative, which specifies timestamps are displayed relat-
iveto thefirst packet captured.

e a absolute, which specifies that actual times be displayed
for all packets.

e ad absolute with date, which specifies that actual dates
and times be displayed for all packets.

« d delta, which specifies that timestamps are relative to the
previous packet.

Y The -v option requests Wireshark to print out its version in-
formation and exit.

-w <savefile> This option sets the name of the savefile to be used when sav-
ing a capturefile.

-y <capturelink type> If a capture is started from the command line with -k, set the
data link type to use while capturing packets. The values re-
ported by -L are the values that can be used.
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-X <eXtension option> Specify an option to be passed to a TShark module. The eX-
tension option is in the form extension_key:value, where ex-
tension_key can be:

lua_script:lua script_filename Tell Wireshark to load the
given script in addition to the default Lua scripts.

-z <statistics-string> Get Wireshark to collect various types of statistics and dis-
play the result in a window that updates in semi-real time.
XXX - add more details herel
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9.3. Packet colorization

A very useful mechanism available in Wireshark is packet colorization. Y ou can set-up Wireshark
so that it will colorize packets according to a filter. This allows you to emphasize the packets you
are usually interested in.

4 Tip!
\d
-' You will find alot of Coloring Rule examples at the Wireshark Wiki Coloring Rules
page at http://wiki.wireshark.org/ColoringRules.

To colorize packets, select the Coloring Rules... menu item from the View menu, Wireshark will
pop up the "Coloring Rules" dialog box as shown in Figure 9.1, “The "Coloring Rules' dialog box”.

Figure9.1. The" Coloring Rules" dialog box

Wireshark: Coloring Rules |Z| |E| fE

Edit Filker Crder

[List is processed in order until match is Found]
e
Marne Skring

tep.analysis.flag: tepoanalysisflags :
caktp cotp
tpkk_long tpkk.length = 519

smb smb || nbss || nbrs || nbipx || ipxsap || netbios Mowe )
htkp hkkp || bop, part == 80 selected Filker
Manage uninterested ipx || stp || hsrp || gigrp || cdp up or dawn
deerpc deerpc
tep svn tep.flags.syn == 1 || tcp.Flags.fin == 1 || tepoflags.reset == 1
tcp tcp
Q Import... udp udp %
nbss nbss
e b
@Uelp l @QK ] [ of apply l l Qﬁave [ X dose

Once the Coloring Rules dialog box is up, there are a number of buttons you can use, depending on
whether or not you have any color filtersinstalled already.

Notel

©

You will need to carefully select the order the coloring rules are listed (and thus ap-
plied) as they are applied in order from top to bottom. So, more specific rules need to
be listed before more genera rules. For example, if you have a color rule for UDP be-
fore the one for DNS, the color rule for DNS will never be applied (as DNS uses UDP,
so the UDP rule will be matching first).

If thisis the first time you have used Coloring Rules, click on the New button which will bring up
the Edit color filter dialog box as shown in Figure 9.2, “The "Edit Color Filter" dialog box”.

Figure 9.2. The" Edit Color Filter" dialog box
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Wireshark: Edit Color Filter M=
Filter
Marne: | Elfd
Skring: |arp | + Expression... ‘

Display Colors

Foreground Color, .. [Backgrn:uund Zolor, .. ]

‘ g ()4 | x Cancel

In the Edit Color dialog box, ssimply enter a name for the color filter, and enter afilter string in the
Filter text field. Eigure 9.2, “The "Edit Color Filter" dialog box” shows the values arp and arp
which means that the name of the color filter is arp and the filter will select protocols of type arp.
Once you have entered these values, you can choose a foreground and background color for packets
that match the filter expression. Click on Foreground color... or Background color... to achieve
this and Wireshark will pop up the Choose foreground/background color for protocol dialog box as
shown in Figure 9.3, “The "Choose color" dialog box”.

Figure 9.3. The" Choose color" dialog box

Wireshark: Choose background color for “arp™

oer (214 |8 e [z19 |3
Saturation: : Sreen: :
Yalue: | 100 | Blue: | 255 |,

Color Mame: | #DEETFF

2]
95 ) [xime

Select the color you desire for the selected packets and click on OK.

Notel

You must select a color in the colorbar next to the colorwheel to load values into the
RGB values. Alternatively, you can set the values to select the color you want.
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Figure 9.4, “Using color filters with Wireshark” shows an example of severa color filters being
used in Wireshark. Y ou may not like the color choices, however, feel free to choose your own.

If you are uncertain which coloring rule actually took place for a specific packet, have a look at the
[Coloring Rule Name: ...] and [Coloring Rule String: ...] fields.

Figure 9.4. Using color filterswith Wireshark
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= Frame 1 (42 on wire, 42 captured)
Arrival Time: Jun 22, 2004 20:02:48.863096000
[Time delta from previous packet: 0.000000000 seconds]
[Time since reference or first frame: 0.000000000 seconds])
Frame Number: 1
Packet Length: 42 bytes
Capture Length: 42 bytes
[Frame 15 marked: False]
[Protocols in frame: eth:iarp)
[Coloring Rule Mame: arp] —
[Caloring Rule String: arp]
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9.4. Control Protocol dissection

9.4.1.

The user can control how protocols are dissected.

Each protocol has its own dissector, so dissecting a complete packet will typically involve several
dissectors. As Wireshark tries to find the right dissector for each packet (using static "routes’ and
heuristics "guessing™), it might choose the wrong dissector in your specific case. For example, Wire-
shark won't know if you use a common protocol on an uncommon TCP port, e.g. using HTTP on
TCP port 800 instead of the standard port 80.

There are two ways to control the relations between protocol dissectors: disable a protocol dissector
completely or temporarily divert the way Wireshark calls the dissectors.

The "Enabled Protocols" dialog box

The Enabled Protocols dialog box lets you enable or disable specific protocols, al protocols are en-
abled by default. When a protocol is disabled, Wireshark stops processing a packet whenever that
protocol is encountered.

a Note!

Disabling a protocol will prevent information about higher-layer protocols from being
displayed. For example, suppose you disabled the IP protocol and selected a packet
containing Ethernet, IP, TCP, and HTTP information. The Ethernet information would
be displayed, but the IP, TCP and HTTP information would not - disabling IP would
prevent it and the other protocols from being displayed.

Figure 9.5. The" Enabled Protocols’ dialog box
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Wireshark: Enabled Protocols

Enabled Protocols

Status Protocol Description
[v] Zdparityfec Pro-MPEG Code of Practice #3 release 2 FEC
(] SCOMEMS 3Com ¥M3 Encapsulation
[v] JEPPE A1l JEPPE A1l
[«] o211 MGT IEEE 802.11 wireless LAM management Frame
] 0211 Radiotap IEEE 802,11 Radiotap Capture header
4 8023 Slow protocols Slow Prokacols
[ op Plan 9 9P
[ aaLt BTM AALL
[ aaL34 ATM AAL3/4
]  aarp Appletalk Address Resolution Protocol
] acap application Configuration Access Protocol
[v] ACP133 ACP133 Attribute Svntaxes
[ BC5E 150 8650-1 031 Association Control Service
4 ACtrace AudioCodes Trunk Trace
]  app aruba - Aruba Discovery Protocol
[«]  aFp Apple Filing Protocol
[«]  aFs (R} Andrew File System (AFT)
] aH Authentication Header
[ AIM A0l Inskant Messenger
4] aIM Administration ATM Adrminiskr akive:

< >

Disabling a protocol prevents higher layer protocols from being displayed
| Enable all | | Disable Al | | Invvert |
(9 ][ Voo ][ @or ][ Xom ]

To disable or enable a protocol, ssimply click on it using the mouse or press the space bar when the
protocol is highlighted.

Q

Y ou can choose from the following actions:

War ning!

You have to use the Save button to save your settings. The OK or Apply buttons will
not save your changes permanently, so they will be lost when Wireshark is closed.

1. EnableAll Enable all protocolsinthelist.

2. Disable All Disable all protocolsin thelist.

w

Invert Toggle the state of all protocolsin thelist.

>

OK Apply the changes and close the dialog box.
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5. Apply Apply the changes and keep the dialog box open.

6. Save Save the settings to the disabled_protos, see Appendix A, Files and Folders for details.

7. Cancel Cance the changes and close the dialog box.

9.4.2. User Specified Decodes

The "Decode As' functionality let you temporarily divert specific protocol dissections. This might
be useful for example, if you do some uncommon experiments on your network.

Figure 9.6. The" Decode As" dialog box

Wireshark: Decode As

Linik, Netwurk| Transpork |

(default)

ap

ACAP

ARG

source (31961 % | pork(s) as | ax4000

BEEFP

BGP

CAST

iZIGlI

| Clear | CIMD w

| {5 el ‘ &P ox H W apply || X Close |

The content of this dialog box depends on the selected packet when it was opened.

() Do not decode

| Shaow Current |

@ Warning!
The user specified decodes can not be saved. If you quit Wireshark, these settings will
be lost.

1. Decode Decode packets the selected way.
2. Do not decode Do not decode packets the selected way.

3. Link/Network/Transport Specify the network layer at which "Decode As' should take place.
Which of these pages are available, depends on the content of the selected packet when this
dialog box was opened.

4. Show Current Open adialog box showing the current list of user specified decodes.
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5.
6.
7.

OK Apply the currently selected decode and close the dialog box.
Apply Apply the currently selected decode and keep the dialog box open.

Cancel Cancel the changes and close the dialog box.

9.4.3. Show User Specified Decodes

This dialog box shows the currently active user specified decodes.

Figure 9.7. The" Decode As. Show" dialog box

1
2.

Wireshark: Decode As: Show [ZI[EI[‘S_TI

Table Yalue Inikial Current

UDP port 3193 (none) ADP

OK Close this dialog box.

Clear Removes all user specified decodes.
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9.5. Preferences

There are a number of preferences you can set. Simply select the Preferences... menu item from the
Edit menu, and Wireshark will pop up the Preferences dialog box as shown in Figure 9.8, “The pref-
erences dialog box”, with the "User Interface" page as default. On the l€eft side is a tree where you
can select the page to be shown.

Notel

Preference settings are added frequently. For a recent explanation of the preference
pages and their settings have a look at the Wireshark Wiki Preferences page at ht-
tp://wiki.wireshark.org/Preferences.

@ Warning!
The OK or Apply button will not save the preference settings, you'll have to save the
settings by clicking the Save button.

» The OK button will apply the preferences settings and close the dial og.
* The Apply button will apply the preferences settings and keep the dialog open.

» The Save button will apply the preferences settings, save the settings on the harddisk and keep
the dialog open.

» The Cancel button will restore all preferences settings to the last saved state.

Figure 9.8. The preferences dialog box
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Directory:
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Appendix A. Files and Folders
A.l. Capture Files

A.1.1.

A.l1.2.

To understand which information will remain available after the captured packets are saved to a cap-
turefile, it's helpful to know abit about the capture file contents.

Wireshark uses the libpcap file format as the default format to save captured packets, this format ex-
ists for along time and it's pretty simple. However, it has some drawbacks: it's not extensible and
lacks some information that would be really helpful (e.g. being able to add a comment to a packet
"the problems start here" would be really nice).

In addition to the libpcap format, Wireshark supports several different capture file formats.
However, the problems described above also applies for these formats too.

A new capture file format "PCAP Next Generation Dump File Format" is currently under develop-

ment, which will fix these drawbacks. However, it still might take a while until the new file format
isready and Wireshark can useit.

Libpcap File Contents

At the start of each libpcap capture file some basic information is stored like a magic number to
identify the libpcap file format. The most interesting information of this file start is the link layer
type (Ethernet, Token Ring, ...).

Thefollowing datais saved for each packet:

» thetimestamp with millisecond resolution
» the packet length asit was "on the wire"

» the packet length asit's saved in thefile

» the packet's raw bytes

A detailed description of the libpcap file format can be found at: http://wiki.wireshark.org/Devel op-
ment/L ibpcapFileFormat

Not Saved in the Capture File

Probably even more interesting for the everyday Wireshark usage is to know the things that are not
saved in the capture file:

e current selections (selected packet, ...)

* name resolution information, see Section 7.6. “Name Resolution” for details

@ War ning!
The name resolution information is rebuild each time Wireshark is restarted so this
information even might change when the capture file is reopened on the same ma-
chine later!

» the number of packets dropped while capturing

» packet marks set with "Edit/Mark Packet"
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» time references set with "Edit/Time Reference”

» thecurrent display filter
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A.2. Configuration Files and Folders

Wireshark uses a number of files and folders while it is running. Some of these reside in the person-
al configuration folder and are used to maintain information between runs of Wireshark, while some
of them are maintained in system aress.

} Tip

A list of the folders Wireshark actually uses can be found under the Folderstab in the
dialog box coming up, when you select About Wireshark from the Help menu.
The content format of the configuration files is the same on al platforms. However, to match the

different policies for unix and windows platforms, different folders for these files are used.

Table A.1. Configuration filesand folders overview

File/Folder Description Unix/Linux Windows folders
folders
preferences Settings from the|/ %WIRESHARK %\wireshark.conf,
Preferences dialog |etc/wire- %APPDATA%\Wireshark\preferences
box. shark.conf,
$HOME/ .wireshar
k/preferences
recent Recent GUI set- [ $HOME/.wireshar |%APPDATAY\Wireshark\recent
tings (eg. recent|k/recent
fileslists).
cfilters Capture filters. $HOME/.wireshar | %WIRESHARK %\cfilters,
kicfilters %APPDATAY\Wireshark\cfilters
dfilters Display filters. $HOME/ .wireshar |%WIRESHARK%\dfilters,
k/dfilters %APPDATAY\Wireshark\dfilters
colorfilters Coloring rules. $HOME/.wireshar | %WIRESHARK%\colorfilters,
ki/colorfilters %APPDATAY\Wireshark\colorfilters
dis Disabled  proto-|$HOME/.wireshar | %WIRESHARK %\disabled_protos,
abled_protos |cols. k/disabled_protos |%APPDATA%%\Wireshark\disabled_prot
0s
ethers Ethernet name res- | /etc/ethers, %WIRESHARK%\ethers,
olution. $HOME/ .wireshar |%APPDATA%\Wireshark\ethers
k/ethers
manuf Ethernet name res- |/etc/manuf, %WIRESHARK %\manuf,
olution. $HOME/ .wireshar |%APPDATA%\Wireshark\manuf
k/manuf
hosts IPv4 and |Pv6|/etc/hosts, %WIRESHARK%\hosts,
name resolution. |$HOME/.wireshar |%APPDATA%\Wireshark\hosts
k/hosts
ipxnets IPX name resolu- |/etc/ipxnets, %WIRESHARK%\i pxnets,
tion. $HOME/ .wireshar | %APPDATAY\Wireshark\ipxnets
k/ipxnets
plugins Plugin directories. |/ %WIRESHARK%\plugins\<version>,
usr/ %APPDATA%%\Wireshark\plugins
share/wire-
shark/plugins, /
usr/loc-
al
share/wire-
shark/plugins,
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File/Folder Description

Unix/Linux Windows folders
folders

$SHOME/.wireshar
k/plugins

temp Temporary files.

Environment: Environment: TMPDIR or TEMP
TMPDIR

— = Windowsfolders
%APPDATA% points to the personal configuration folder, typicaly C: \ Docunent s

and Settings\<usernane>\ Application Data (for further details, have a
look at Section A.3.1, “Windows profiles’), %WIRESHARK% points to the Wire-

shark program folder, typically C. \ Program Fi | es\ W r eshar k

W

Unix/Linux folders

The/ et c folder isthe global Wireshark configuration folder. The folder actually used

on your system may vary, maybe something like: / usr/ | ocal / et c.

pr efer ences/wir eshark.conf

recent

cfilters

dfilters

This file contains your Wireshark preferences, including de-
faults for capturing and displaying packets. It is a simple text
file containing statements of the form:

vari abl e: val ue

The settings from this file are read in at program start and
written to disk when you press the Save button in the "Prefer-
ences' dialog box.

This file contains various GUI related settings like the main

window position and size, the recent files list and such. Itisa
simple text file containing statements of the form:

vari abl e: val ue

It isread at program start and written at program exit.

This file contains al the capture filters that you have defined
and saved. It consists of one or more lines, where each line
has the following format:

"<filter name>" <filter string>

The settings from this file are read in at program start and
written to disk when you press the Save button in the "Cap-
ture Filters" dialog box.

This file contains al the display filters that you have defined

and saved. It consists of one or more lines, where each line
has the following format:

"<filter nanme>" <filter string>
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The settings from this file are read in a program start and
written to disk when you press the Save button in the "Dis-
play Filters' dialog box.

colorfilters This file contains all the color filters that you have defined
and saved. It consists of one or more lines, where each line
has the following format:

@filter name>@filter string>
@ <bg RGB(16-bit)>][<fg RGB(16-bhit)>]

The settings from this file are read in at program start and
written to disk when you press the Save button in the "Color-
ing Rules’ dialog box.

disabled_protos Each line in this file specifies a disabled protocol name. The
following are some examples:

tcp
udp

The settings from this file are read in at program start and
written to disk when you press the Save button in the "En-
abled Protocols' dialog box.

ethers When Wireshark is trying to translate Ethernet hardware ad-
dresses to names, it consults the files listed in Table A.1
“Configuration files and folders overview”. If an address is
not found in /etc/ethers, Wireshark looks in
$HOME/.wireshark/ethers

Each line in these files consists of one hardware address and
name separated by whitespace. The digits of hardware ad-
dresses are separated by colons (:), dashes (-) or periods(.).
The following are some examples:

ff-ff-ff-ff-ff-ff Br oadcast
cO-00-ff-ff-ff-ff TR _br oadcast
00. 2b. 08. 93. 4b. a1l Freds_machi ne

The settings from this file are read in at program start and
never written by Wireshark.

manuf Wireshark uses the files listed in Table A.1, “Configuration
files and folders overview” to trandlate the first three bytes of
an Ethernet address into a manufacturers name. This file has
the same format as the ethers file, except addresses are three
bytes long.

Anexampleis:

00: 00: 01 Xer ox # XEROX CORPCRATI ON
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hosts

ipxnets

plugins folder

temp folder

The settings from this file are read in at program start and
never written by Wireshark.

Wireshark uses the files listed in Table A.1, “Configuration
files and folders overview” to transate IPv4 and IPv6 ad-
dresses into names.

This file has the same format as the usual /etc/hosts file in
unix systems.

Anexampleis:

# Comments nust be prepended by the # sign
192.168. 0.1 honeserver

The settings from this file are read in at program start and
never written by Wireshark.

Wireshark uses the files listed in Table A.1, “Configuration
files and folders overview” to translate IPX network numbers
into names.

An exampleis:

C0. A8. 2C. 00 HR
c0-a8-1c-00 CEO

00: 00: BE: EF I T _Serverl
110f Fi |l eServer3

The settings from this file are read in at program start and
never written by Wireshark.

Wireshark searches for plugins in the directories listed in Ta-
ble A.1, “Configuration files and folders overview”. They are
searched in the order listed.

If you start a new capture and don't specify a filename for it,
Wireshark uses this directory to place that file in, see Sec-
tion 4.6, “ Capturefiles and file modes”.
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A.3. Windows folders

A.3.1.

A.3.2.

A.3.3.

Here you will find some details about the folders used in Wireshark on different Windows versions.

As aready mentioned, you can find the currently used foldersin the About Wireshark dialog.

Windows profiles

Windows uses some specia directories to store user configuration files in, named the user profile.
This can be confusing, as the default directory location changed from version to version and might
also be different for english and internationalized versions of windows.

_ﬁ Notel
If you upgraded to a new windows version, your profile might be kept in the former
location, so the defaults mentioned here might not apply.

The following will try to guide you to the right place where to look for Wiresharks profile data

95/98/ME The default in Windows 95/98/ME is: all users work with the
same profile, which is located at:
C. \ wi ndows\ Appl i cati on Data\Wreshark

98/ME (with enabled user pro- In Windows 98 and ME you can enable separate user profiles.

files) In that case, something like:

C.\wi ndows\ Profi | es\ <usernanme>\ Applicatio
n Dat a\ Wr eshar Kk isused.

NT 4 C:\ W NNT\ Pr of i | es\ <user nane>\ Appl i cation
Dat a\ Wr eshark

2000/XP C.\ Docunent s and Set -
tings\ <usernane>\ Application Data, "Docu-
ments and Settings' and "Application Data' might be interna-
tionalized.

Windows NT/2000/XP roaming profiles

The following will only be applicable if you are using roaming profiles. This might be the casg, if
you work in a Windows domain environment (used in huge company networks). The configurations
of all programs you use won't be saved on the local harddrive of the computer you are currently
working on, but on the domain server.

As Wireshark is using the correct places to store it's profile data, your settings will travel with you,
if you logon to adifferent computer the next time.

There is an exception to this: The "Loca Settings' folder in your profile data (typically something

like: C: \ Docunent s and Settings\<usernane>\Local Settings) will notbe trans-
ferred to the domain server. Thisisthe default for temporary capture files.

Windows temporary folder

Wireshark uses the folder which is set by the TMPDIR or TEMP environment variable. This vari-
able will be set by the windows installer.

The default location for temporary fileson NT 4 isjust C. \ TEMP, and in 2000 the default location
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is some directory under your profile directory but it might have "Temporary Files' in the path name.
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Appendix B. Protocols and Protocol
Fields

Wireshark distinguishes between protocols (e.g. tcp) and protocol fields (e.g. tcp.port).

A comprehensive list of all protocols and protocol fields can be found at: ht-
tp://www.wireshark.org/docs/dfref/
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Appendix C. Wireshark Messages

Wireshark provides you with additional information generated out of the plain packet data or it may
need to indicate dissection problems. Messages generated by Wireshark are usually placed in [] par-
entheses.

C.1. Packet List Messages

C.1.1.

C.1.2.

These messages might appear in the packet list.

[Malformed Packet]

Maformed packet means that the protocol dissector can't work out the contents of the packet any
further. This can have various reasons:

*  Wrong dissector Wireshark errorneously has chosen the wrong protocol dissector for this pack-
et. This will happen e.g. if you are using a protocol not on it's well known TCP or UDP port.
Y ou may try Analyze|Decode Asto circumvent this problem.

» Packet not reassembled The packet islonger than a single frame and it is not reassembled, see
Section 7.5, “Packet Reassembling” for further details.

e Packet is malformed The packet is actually wrong (malformed), meaning that a part of the
packet is just not as expected (not following the protocol specifications).

» Dissector isbuggy The corresponding protocol dissector is simply buggy or still incomplete.

Any of the above is possible. You'll have to look into the specific situation to determine what it is.
You could disable the dissector by disabling the protocol on the Analyze menu and check how
Wireshark displays the packet then. Y ou could (if it's TCP) enable reassembly for TCP and the spe-
cific dissector (if possible) in the Edit|Preferences menu. Y ou could check the packet contents your-
self by reading the packet bytes and comparing it to the protocol specification. This could reveil a
dissector bug. Or you could find out that the packet is indeed wrong.

[Packet size limited during capture]

The packet size was limited during capture, see "Limit each packet to n bytes' at the Section 4.5
“The "Capture Options' dialog box”. While dissecting, the current protocol dissector was simply
running out of packet bytes and had to give up. There's nothing else you can do now, except to re-
peat the whole capture process again with a higher (or no) packet size limitation.
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C.2. Packet Details Messages

These messages might appear in the packet details.

C.2.1. [Response in frame: 123]

The current packet is the request of a detected request/response pair. You can directly jump to the
corresponding response packet just by double clicking on this message.

C.2.2. [Request in frame: 123]

Same as "Responsein frame: 123" above, but the other way round.

C.2.3. [Time from request: 0.123 seconds]

The time between the request and the response packets.

179



Wireshark Messages

180



Appendix D. Related command line
tools

D.1. Introduction

Beside the Wireshark GUI application, there are some command line tools, which can be helpful for
doing some more specialized things. These tools will be described in this chapter.
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D.2. tshark: Terminal-based Wireshark

TShark is aterminal oriented version of Wireshark designed for capturing and displaying packets
when an interactive user interface isn't necessary or available. It supports the same options as wir e-
shark. For more information on tshark, see the manual pages (man tshark).
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D.3. tcpdump: Capturing with tcpdump for
viewing with Wireshark

There are occasions when you want to capture packets using tcpdump rather than wireshark, espe-
cially when you want to do a remote capture and do not want the network load associated with run-
ning Wireshark remotely (not to mention all the X traffic polluting your capture).

However, the default tcpdump parameters result in a capture file where each packet is truncated,
because tcpdump, by default, does only capture the first 68 bytes of each packet.

To ensure that you capture complete packets, use the following command:
tcpdunmp -i <interface> -s 1500 -w <sone-file>

You will have to specify the correct interface and the name of afile to save into. In addition, you
will have to terminate the capture with ~C when you believe you have captured enough packets.

—h Notel
tcpdump is not part of the Wireshark distribution. You can get it from: ht-
tp://www.tcpdump.org for various platforms.
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D.4. dumpcap: Capturing with dumpcap for
viewing with Wireshark

Dumpcap is a network traffic dump tool. It lets you capture packet data from a live network and
write the packets to a file. Dumpcap's native capture file format is libpcap format, which is aso the
format used by Wireshark, tcpdump and various other tools.

Without any options set it will use the pcap library to capture traffic from the first available network
interface and writes the received raw packet data, along with the packets time stamps into a libpcap
file.

Packet capturing is performed with the pcap library. The capture filter syntax follows the rules of
the pcap library.

Example D.1. Help infor mation available from dumpcap

Dunpcap 0.99.0

Capture network packets and dunp theminto a |ibpcap file.
See http://wwww. w reshark.org for nore information.

Usage: dunpcap [options]

Capture interface:

-i <interface> nanme or idx of interface (def: first none | oopback)

-f <capture filter> packet filter in libpcap filter syntax

-s <snapl en> packet snapshot |ength (def: 65535)

-p don't capture in prom scuous node

-B <buffer size> size of kernel buffer (def: 1MB)

-y <link type> link |ayer type (def: first appropriate)

-D print list of interfaces and exit

-L print list of link-1ayer types of iface and exit
Stop conditions:

-c <packet count> stop after n packets (def: infinite)

-a <autostop cond.> ... duration:NUM- stop after NUM seconds

filesize:NUM - stop this file after NUM KB
files:NUM - stop after NUMfiles
Qut put (files):
-w <fil enane> nane of file to save (def: tenpfile)
-b <ringbuffer opt.> ... duration:NUM- switch to next file after NUM secs
filesize:NUM - switch to next file after NUM KB
files:NUM - ringbuffer: replace after NUMfiles
M scel | aneous:
-V print version information and exit
-h di splay this help and exit

Exanpl e: dunpcap -i ethO -a duration: 60 -w out put. pcap
"Capture network packets frominterface ethO until 60s passed into output.pcap"

Use Crl-Cto stop capturing at any tine.
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D.5. capinfos: Print information about
capture files

Included with Wireshark is a small utility called capinfos, which is a command-line utility to print
information about binary capture files.

Example D.2. Help infor mation available from capinfos

$ capinfos -h
Usage: capinfos [-t] [-c] [-s] [-d] [- U] [-a] [-e] [-VY]
[-i] [-z] [-h] <capfil
where -t display the capture type of <capf|le>
-c count the nunber of packets
-s display the size of the file
-d display the total length of all packets in the file
(in bytes)
-u display the capture duration (in seconds)
-a display the capture start tine
-e display the capture end tine
-y display average data rate (in bytes)
i display average data rate (in bits)
-z display average packet size (in bytes)
-h produces this help listing.

If no data flags are given, default is to display all statistics
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D.6. editcap: Edit capture files

Included with Wireshark is a small utility called editcap, which is a command-line utility for work-
ing with capture files. Its main function is to remove packets from capture files, but it can also be
used to convert capture files from one format to another, as well as print information about capture
files.

Example D.3. Help infor mation available from editcap

$ editcap.exe -h

Editcap 0.99.3

Edit and/or translate the format of capture files.
See http://ww. wi reshark.org for nore information

Usage: editcap [options] ... <infile> <outfile> [ <packet#>[-<packet #>]

A single packet or a range of packets can be sel ected.

Packet s:
- C <chopl en> chop each packet at the end by <chopl en> bytes
-d renove duplicate packets
-E <error probability> set the probability (between 0.0 and 1.0 incl.)
that a particul ar packet byte will be randomy changed
-r keep the sel ected packets, default is to delete them
-s <snapl en> truncate packets to max. <snapl en> bytes of data

-t <time adjustnent> adjust the timestanp of sel ected packets,

<tinme adjustment> is in relative seconds (e.g.
-A <start tine> don't output packets whose tinestanp is before the

given time (format as YYYY-MM DD hh: mm ss)

-B <stop tine> don't output packets whose tinmestanp is after the

given tinme (format as YYYY-MM DD hh: nm ss)

Qutput File(s):
-c <packets per file> split the packet output to different files,
wi th a maxi num of <packets per file> each

-F <capture type> set the output file type, default is |ibpcap
an enpty "-F" option wll list the file types
-T <encap type> set the output file encapsul ation type,
default is the sanme as the input file
an enpty "-T" option will list the encapsul ation types
M scel | aneous:
-h di splay this help and exit
-V ver bose out put
$ editcap.exe -F
edi tcap.exe: option requires an argument -- F
edi tcap. exe: The avail able capture file types for "F"
i bpcap - Wreshark/tcpdunp/... - |ibpcap
nsecl i bpcap - Wreshark - nanosecond |ibpcap
nodl i bpcap - Modified tcpdunmp - 1ibpcap
noki al 1 bpcap - Nokia tcpdunp - |ibpcap
rhé_1li bpcap - RedHat 6.1 tcpdunp - |ibpcap
suse6_3l 1 bpcap - SuSE 6.3 tcpdump - |ibpcap

5views - Accellent 5Views capture

dct 2000 - Catapult DCT2000 trace (.out format)
nettl - HP-UX nettl trace

netmonl - M crosoft NetMn 1.x

netmon2 - M crosoft NetMn 2.x

ngsniffer - NA Sniffer (DOS)

ngwsniffer 1 1 - NA Sniffer (Wndows) 1.1
ngwsniffer_2 0 - NA Sniffer (Wndows) 2.00x

ni observerv9 - Network Instrunments Cbserver (V9)
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| anal yzer - Novell LANal yzer

snoop - Sun snoop

rf5 - Tektronix Kl2xx 32-bit .rf5 format
visual - Visual Networks traffic capture

$ editcap.exe -F

edi tcap.exe: option requires an argunent -- T

edi t cap. exe: The avail abl e encapsul ation types for "T":
et her - Ethernet
tr - Token Ring

slip - SLIP
ppp - PPP
fddi - FDD

fddi - swapped - FDDI with bit-swapped MAC addresses
rawvip - Raw I P

arcnet - ARCNET

arcnet _|inux - Linux ARCNET

atmrfcld483 - RFC 1483 ATM

[inux-atmclip - Linux ATM CLIP

| apb - LAPB

at m pdus - ATM PDUs

at m pdus-untruncated - ATM PDUs - untruncated

nul | - NULL
ascend - Lucent/Ascend access equi pnent
isdn - | SDN

i p-over-fc - RFC 2625 | P-over-Fi bre Channe
ppp-with-direction - PPP with Directional Info

I eee-802-11 - | EEE 802.11 Wrel ess LAN

prism- |EEE 802.11 plus Prism Il nonitor node header

i eee-802-11-radio - | EEE 802.11 Wreless LAN with radio information
i eee-802-11-radiotap - | EEE 802.11 plus radi otap W.AN header
i eee-802-11-avs - | EEE 802. 11 plus AVS W.AN header

[ inux-sll - Linux cooked-node capture

frelay - Frame Rel ay

frelay-with-direction - Frame Relay with Directional Info
chdlc - G sco HDLC

ios - Cisco IOS interna

I[talk - Localtalk

pflog-old - OpenBSD PF Firewall |ogs, pre-3.4

hhdl ¢ - H Path HDLC

docsis - Data Over Cable Service Interface Specification
cosine - CoSine L2 debug | og

whdlc - Wellfleet HDLC

sdlc - SDLC

tzsp - Taznen sniffer protocol

enc - OpenBSD enc(4) encapsul ating interface

pflog - OpenBSD PF Firewal | | ogs

chdlc-with-direction - Csco HDLC with Directional Info
bl uet oot h-h4 - Bluetooth H4

ntp2 - SS7 MIP2

ntp3 - SS7 MIP3

irda - IrDA

user0 - USER
userl - USER
user?2 - USER
user3 - USER
user4 - USER
user5 - USER

user6 - USER
user7 - USER
user8 - USER
user9 - USER
user10 - USER 10
userl1ll - USER 11
userl1l2 - USER 12
user13 - USER 13
user14 - USER 14
user15 - USER 15
symantec - Symantec Enterprise Firewal

OCO~NOUPWNEFLO
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apl394 - Apple |IP-over
bacnet-ns-tp - BACnet
raw-i cnp-nettl - Raw |

- | EEE 1394
VS/ TP
CMP with nettl headers

rawi cnpv6-nettl - Raw ICMPv6 with nettl headers

gprs-llc - GPRS LLC

juni per-atnl - Juni per ATML

juni per-atn2 - Juni per ATM?

redback - Redback Smart Edge

rawi p-nettl - Raw [P with nettl headers

ether-nettl - Ethernet with nettl headers

tr-nettl - Token Ring with nettl headers

fddi-nettl - FDDI with nettl headers

unknown-nettl - Unknown |ink-layer type with nettl headers

nt p2-w t h-phdr - MIP2

wi t h pseudoheader

j uni per - pppoe - Juni per PPPoE

gcomtiel - GCOM Tl El
gcomserial - GCOM Ser

i al

x25-nettl - X25 with nettl headers
k12 - K12 protocol analyzer
juni per-m ppp - Juni per M.PPP

juniper-mfr - Juniper

M_FR

j uni per-ether - Juni per Ethernet

j uni per-ppp - Juni per

PPP

juniper-frelay - Juniper Frane-Rel ay
j uni per-chdl ¢ - Juni per CHDLC

j uni per-ggsn - Juni per
| apd - LAPD

GGSN

dct 2000 - Catapult DCT2000
ber - ASN. 1 Basic Encoding Rul es

Where each option has the following meaning:

-T {encap type}

-F {capturetype}

-s{snaplen}

-t {time adjustment}

{infile}

{outfile}

This option specifies that the frames listed should be kept, not
deleted. The default isto delete the listed frames.

This option provides help.

This option specifies verbose operation. The default is silent
operation.

This option specifies the frame encapsul ation type to use.

It is mainly for converting funny captures to something that
Wireshark can deal with.

The default frame encapsulation type is the same as the input
encapsulation.

This option specifies the capture file format to write the out-
put filein.

The default is libpcap format.

Specifies that packets should be truncated to {snaplen} bytes
of data.

Specifies the time adjustment to be applied to selected pack-
€ets.

This parameter specifies the input file to use. It must be
present.

This parameter specifies the output file to use. It must be
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present.

[record#{-][record# ...]] This optional parameter specifies the records to include or ex-
clude (depending on the -r option. Y ou can specify individual
records or arange of records.
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D.7. mergecap: Merging multiple capture files
Into one

Mergecap is a program that combines multiple saved capture files into a single output file specified
by the -w argument. Mergecap knows how to read libpcap capture files, including those of tcpdump.
In addition, Mergecap can read capture files from snoop (including Shomiti) and atmsnoop, LanA-
lyzer, Sniffer (compressed or uncompressed), Microsoft Network Monitor, AlIX's iptrace, NetXray,
Sniffer Pro, RADCOM's WAN/LAN analyzer, Lucent/Ascend router debug output, HP-UX's nettl,
and the dump output from Toshiba's ISDN routers. There is no need to tell Mergecap what type of
file you are reading; it will determine the file type by itself. Mergecap is also capable of reading any
of these file formats if they are compressed using gzip. Mergecap recognizes this directly from the
file; the'.gz' extension is not required for this purpose.

By default, it writes the capture file in libpcap format, and writes all of the packets in both input
capture files to the output file. The -F flag can be used to specify the format in which to write the
capture file; it can write the file in libpcap format (standard libpcap format, a modified format used
by some patched versions of libpcap, the format used by Red Hat Linux 6.1, or the format used by
SUSE Linux 6.3), snoop format, uncompressed Sniffer format, Microsoft Network Monitor 1.x
format, and the format used by Windows-based versions of the Sniffer software.

Packets from the input files are merged in chronological order based on each frame's timestamp, un-
less the -a flag is specified. Mergecap assumes that frames within a single capture file are aready
stored in chronological order. When the -a flag is specified, packets are copied directly from each
input file to the output file, independent of each frame's timestamp.

If the -s flag is used to specify a snapshot length, frames in the input file with more captured data
than the specified snapshot length will have only the amount of data specified by the snapshot
length written to the output file. This may be useful if the program that is to read the output file can-
not handle packets larger than a certain size (for example, the versions of snoop in Solaris 2.5.1 and
Solaris 2.6 appear to reject Ethernet frames larger than the standard Ethernet MTU, making them in-
capable of handling gigabit Ethernet capturesif jumbo frames were used).

If the -T flag is used to specify an encapsulation type, the encapsulation type of the output capture
file will be forced to the specified type, rather than being the type appropriate to the encapsulation
type of the input capture file. Note that this merely forces the encapsulation type of the output file to
be the specified type; the packet headers of the packets will not be translated from the encapsulation
type of the input capture file to the specified encapsulation type (for example, it will not translate an
Ethernet capture to an FDDI capture if an Ethernet capture isread and '-T fddi' is specified).

Example D.4. Help infor mation available from mergecap

$ mergecap. exe -h

ner gecap version 0.10.5

Usage: nergecap [-hva] [-s <snaplen>] [-T <encap type>]
[-F <capture type>] -w <outfile> <infile> [...]

where -h produces this help listing.
-v verbose operation, default is silent
-a files should be concatenated, not nerged
Def ault nmerges based on frame tinmestanps
-s <snapl en>: truncate packets to <snapl en> bytes of data
-w <outfile> sets output filename to <outfile>
-T <encap type> encapsul ati on type to use:
et her - Ethernet
tr - Token Ring

slip - SLIP
ppp - PPP
fddi - FDDI

fddi - swapped - FDDI with bit-swapped MAC addresses
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rawvip - Raw I P

arcnet - ARCNET

arcnet _|inux - Linux ARCNET

atmrfclda83 - RFC 1483 ATM

[inux-atmclip - Linux ATM CLIP

| apb - LAPB

atm pdus - ATM PDUs

at m pdus-untruncated - ATM PDUs - untruncated

nul I - NULL
ascend - Lucent/Ascend access equi pnent
i sdn - | SDN

i p-over-fc - RFC 2625 | P-over-Fi bre Channel
ppp-with-direction - PPP with Directional Info

i eee-802-11 - | EEE 802.11 Wrel ess LAN

prism- |EEE 802.11 plus Prism Il nonitor node header

I eee-802-11-radio - | EEE 802.11 Wreless LAN with radio informatio
i eee-802-11-bsd - | EEE 802.11 plus BSD W.AN header

i eee-802-11-avs - | EEE 802.11 plus AVS W.AN header

[ i nux-sll - Linux cooked-nmode capture

frelay - Frame Rel ay

frelay-with-direction - Frame Relay with Directional Info
chdlc - G sco HDLC

ios - Cisco IOS interna

I[talk - Localtalk

pflog-old - OpenBSD PF Firewall |ogs, pre-3.4

hhdl c - H Path HDLC

docsis - Data Over Cable Service Interface Specification
cosine - CoSine L2 debug | og

whdlc - Wellfleet HDLC

sdlc - SDLC

tzsp - Tazmen sniffer protocol

enc - OpenBSD enc(4) encapsul ating interface

pflog - OpenBSD PF Firewal | | ogs

chdlc-with-direction - Csco HDLC with Directional Info
bl uet oot h-h4 - Bluetooth H4

ntp2 - SS7 MIP2

ntp3 - SS7 MIP3

irda - IrDA

user8 - USER
user9 - USER
user10 - USER 10
user1ll - USER 11
user12 - USER 12
user13 - USER 13
user14 - USER 14
user15 - USER 15
symantec - Symantec Enterprise Firewal
apl394 - Apple IP-over-1EEE 1394
bacnet-ns-tp - BACnet M5/ TP
default is the same as the first input file

-F <capture type> capture file type to wite:
1 bpcap - |ibpcap (tcpdunp, Wreshark, etc.)
rhé_1l1 bpcap - RedHat Linux 6.1 |ibpcap (tcpdump)
suse6_3l 1 bpcap - SuSE Linux 6.3 |ibpcap (tcpdunp)
nodl i bpcap - nodified |ibpcap (tcpdunp)
noki al 1 bpcap - Nokia |ibpcap (tcpdunp)
| anal yzer - Novell LANalyzer
ngsni ffer - Network Associates Sniffer (DOS-based)
snoop - Sun snoop
netmonl - M crosoft Network Mnitor 1.x
netnmon2 - Mcrosoft Network Mnitor 2.Xx

user0 - USER O
userl - USER 1
user2 - USER 2
user3 - USER 3
user4 - USER 4
user5 - USER 5
user6 - USER 6
user7 - USER 7

8

9
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ngwsniffer 1 1 - Network Associates Sniffer (Wndows-based) 1.1
ngwsniffer 2 0 - Network Associates Sniffer (W ndows-based) 2.00x
visual - Visual Networks traffic capture

5views - Accellent 5Views capture

ni observerv9 - Network Instruments Cbserver version 9

default is libpcap

-h  Prints the version and options and exits.

-v  Causes mergecap to print a number of messages whileit's working.

-a  Causes the frame timestamps to be ignored, writing all packets from the first input file fol-
lowed by all packets from the second input file. By default, when -a is not specified, the con-
tents of the input files are merged in chronological order based on each frame's timestamp.
Note: when merging, mergecap assumes that packets within a capture file are already in chro-
nological order.

-s  Setsthe snapshot length to use when writing the data.

-w  Setsthe output filename.

-T  Setsthe packet encapsulation type of the output capture file.

-F  Setsthefile format of the output capturefile.

A simple example merging dhcp-capture. | i bpcap and i nap-1.1i bpcap into out -
file.libpcap isshown below.

Example D.5. Simple example of using mer gecap

$ nergecap -w outfile.libpcap dhcp-capture.libpcap i map-1.1ibpcap
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D.8. text2pcap: Converting ASCIl hexdumps

to network captures

There may be some occasions when you wish to convert a hex dump of some network traffic into a
libpcap file.

Text2pcap is a program that reads in an ASCIl hex dump and writes the data described into a libp-
cap-style capture file. text2pcap can read hexdumps with multiple packets in them, and build a cap-
ture file of multiple packets. text2pcap is also capable of generating dummy Ethernet, IP and UDP
headers, in order to build fully processable packet dumps from hexdumps of application-level data
only.

Text2pcap understands a hexdump of the form generated by od -A x -t x1. In other words, each byte
isindividually displayed and surrounded with a space. Each line begins with an offset describing the
position in the file. The offset is a hex number (can also be octal - see -0), of more than two hex di-
gits. Here is a sample dump that text2pcap can recognize:

000000 00 e0 1e a7 05 6f 00 10 ........
000008 5a a0 b9 12 08 00 46 00 ........
000010 03 68 00 00 00 00 Oa 2e ........
000018 ee 33 Of 19 08 7f Of 19 ........
000020 03 80 94 04 00 00 10 01 ........
000028 16 a2 Oa 00 03 50 00 Oc ........
000030 01 01 Of 19 03 80 11 01 ........

There is no limit on the width or number of bytes per line. Also the text dump at the end of the line
isignored. Bytes’/hex numbers can be uppercase or lowercase. Any text before the offset is ignored,
including email forwarding characters '>'. Any lines of text between the bytestring lines is ignored.
The offsets are used to track the bytes, so offsets must be correct. Any line which has only bytes
without a leading offset is ignored. An offset is recognized as being a hex number longer than two
characters. Any text after the bytes is ignored (e.g. the character dump). Any hex numbers in this
text are also ignored. An offset of zero is indicative of starting a new packet, so a single text file
with a series of hexdumps can be converted into a packet capture with multiple packets. Multiple
packets are read in with timestamps differing by one second each. In general, short of these restric-
tions, text2pcap is pretty liberal about reading in hexdumps and has been tested with a variety of
mangled outputs (including being forwarded through email multiple times, with limited line wrap
etc.)

There are a couple of other specia features to note. Any line where the first non-whitespace charac-
ter is '# will be ignored as a comment. Any line beginning with #TEXT2PCAP is a directive and
options can be inserted after this command to be processed by text2pcap. Currently there are no dir-
ectives implemented; in the future, these may be used to give more fine grained control on the dump
and the way it should be processed e.g. timestamps, encapsulation type etc.

Text2pcap also allows the user to read in dumps of application-level data, by inserting dummy L2,
L3 and L4 headers before each packet. The user can elect to insert Ethernet headers, Ethernet and

IP, or Ethernet, IP and UDP headers before each packet. This allows Wireshark or any other full-
packet decoder to handle these dumps.

Example D.6. Help information available for text2pcap

$ text2pcap.exe -h

Usage: text2pcap.exe [-h] [-d] [-q] [-0 h|o] [-I typenun] [-e |3pid] [-i

pr ot o]

[-m max- packet] [-u srcp,destp] [-T srcp,destp] [-s srcp, destp,tag]
[-S srcp,destp,tag] [-t tinmefnt] <input-filenane> <output-fil enane>
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where <input-filenane> specifies input filenane (use - for standard input)
<out put-fil ename> specifies output filenane (use - for standard output)

[options] are one or nore of the follow ng

-h
-d
-0 hex| oct
-1 typenum

_q .
-e | 3pid

-i proto

- m nmax- packet
-u srcp, destp

-T srcp, destp

-s srcp, dstp,tag:

-S srcp, dstp, ppi:

-t tinefnm

-w <filename>

-0 hex|oct

Di splay this hel p nessage

Cenerate detail ed debug of parser states

Parse of fsets as (h)ex or (o)ctal. Default is hex
Specify link-1ayer type nunber. Default is 1 (Ethernet).
See net/bpf.h for list of nunbers.

CGenerate no output at all (automatically turns off -d)
Plrzi)pend dunmy Et hernet Il header with specified L3PID (in
H

Exanpl e: -e 0x800

Prepend dunmy | P header with specified IP protocol (in

DECI MAL) .
Automatical |y prepends Ethernet header as well.
Example: -i 46

Max packet length in output, default is 64000

Prepend dummy UDP header with specified dest and source port:

(i n DECI MAL) .

Automatically prepends Ethernet and | P headers as well

Exanpl e: -u 30, 40

Prepend dunmy TCP header with specified dest and source port:

(in DECI MAL) .

Automatical ly prepends Ethernet and | P headers as well

Exampl e: -T 50, 60

Prepend dunmy SCTP header with specified dest/source ports

and verification tag (in DECI NMAL) .

Automatical ly prepends Ethernet and |IP headers as well

Exanpl e: -s 30, 40, 34

Prepend dummy SCTP header with specified dest/source ports

and verification tag 0. It also prepends a dummy SCTP DATA

chunk header with payl oad protocol identifier ppi

Exanpl e: -S 30, 40, 34

Treats the text before the packet as a date/tinme code; the

specified argunent is a format string of the sort supported

by strptine.

Exanpl e: The tine "10:15: 14. 5476" has the format code

" o4 ot 9B, "

NOTE: The subsecond conponent delimter rmust be specified
(.) but no pattern is required; the remaining numbe
is assuned to be fractions of a second.

Write the capture file generated by text2pcap to <filename>. The de-
fault isto write to standard output.

Display the help message

Displays debugging information during the process. Can be used
multiple times to generate more debugging information.

Be completely quiet during the process.

Specify the radix for the offsets (hex or octal). Defaults to hex. This
corresponds to the -A option for od.

Specify the link-layer type of this packet. Default is Ethernet(1). See
net/bpf.h for the complete list of possible encapsulations. Note that
this option should be used if your dump is a complete hex dump of
an encapsulated packet and you wish to specify the exact type of en-
capsulation. Example: -I 7 for ARCNet packets.
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-e|3pid

-u srcport destport

Include a dummy Ethernet header before each packet. Specify the
L3PID for the Ethernet header in hex. Use this option if your dump
has Layer 3 header and payload (e.g. |P header), but no Layer 2 en-
capsulation. Example: -e 0x806 to specify an ARP packet.

For IP packets, instead of generating a fake Ethernet header you can
also use -l 12 to indicate a raw |P packet to Wireshark. Note that -|
12 does not work for any non-1P Layer 3 packet (e.g. ARP), whereas
generating a dummy Ethernet header with -e works for any sort of L3
packet.

Include dummy UDP headers before each packet. Specify the source
and destination UDP ports for the packet in decimal. Use this option
if your dump is the UDP payload of a packet but does not include
any UDP, IP or Ethernet headers. Note that this automatically in-
cludes appropriate Ethernet and 1P headers with each packet. Ex-
ample: -u 1000 69 to make the packets look like TFTP/UDP packets.
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D.9. idl2wrs: Creating dissectors from
CORBA IDL files

D.9.1.

D.9.2.

D.9.3.

In an ideal world idl2wrs would be mentioned in the users guide in passing and documented in the
developers guide. As the developers guide has not yet been completed it will be documented here.

What is it?

As you have probably guessed from the name, idl2wr s takes a user specified IDL file and attempts
to build a dissector that can decode the IDL traffic over GIOP. The resulting file is "C" code, that
should compile okay as a Wireshark dissector.

idl2wr s basically parses the data struct given to it by the omniidl compiler, and using the GIOP API
available in packet-giop.[ch], generates get CDR_xxx calls to decode the CORBA traffic on the
wire.

It consists of 4 main files.

README. i dl 2wr s This document
wi reshar k_be. py  Themain compiler backend
wi reshar k_gen. py A helper class, that generates the C code.

idl 2ws A simple shell script wrapper that the end user should use to generate the
dissector from the IDL file(s).

Why do this?

It is important to understand what CORBA traffic looks like over GIOP/IIOP, and to help build a
tool that can assist in troubleshooting CORBA interworking. This was especially the case after see-
ing alot of discussions about how particular IDL types are represented inside an octet stream.

| have also had comments/feedback that this tool would be good for say a CORBA class when
teaching students what CORBA traffic looks like "on the wire".

It is also COOL to work on a great Open Source project such as the case with "Wireshark" ( ht-
tp://www.wireshark.org )

How to use idl2wrs
To usethe idl2wrs to generate Wireshark dissectors, you need the following:

Prerequisitesto using idl2wrs

1. Python must be installed. See http://python.org/

2. omniidl from the the omniORB package must be available. See http://omniorb.sourceforge.net/

3. Of course you need Wireshark installed to compile the code and tweak it if required. idl2wrsis
part of the standard Wireshark distribution

To useidli2wrsto generate an Wireshark dissector from an idl file use the following procedure:
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Procedurefor convertinga CORBA idl fileinto a Wireshark dissector

1. Towritethe C code to stdout.
idl2ws <your file.idl>
€g:

idl 2wrs echo.idl

2. Towriteto afile, just redirect the output.
idl2ws echo.idl > packet-test-idl.c
You may wish to comment out the register_giop_user_module() code and that will leave you
with heuristic dissection.

If you don't want to use the shell script wrapper, then try steps 3 or 4 instead.

3. Towritethe C code to stdout.

Usage: omiidl -p ./ -b wireshark_be <your file.idl>
€g:
omiidl -p ./ -b wireshark _be echo.idl

4. Towriteto afile, just redirect the output.
omiidl -p ./ -b wireshark_be echo.idl > packet-test-idl.c

You may wish to comment out the register_giop_user_module() code and that will leave you
with heuristic dissection.

5. Copy the resulting C code to your Wireshark src directory, edit the two make files to include
the packet-test-idl.c

cp packet-test-idl.c /dir/where/w reshark/lives/
edit Makefile.am
edit Makefil e. nmake

6. Run configure

./configure (or ./autogen.sh)

7. Compilethe code

make
8. Good Luck!!
D.9.4. TODO
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1. Exception code not generated (yet), but can be added manually.
2. Enums not converted to symbolic values (yet), but can be added manually.
3. Add command line options etc

4. Morel amsure:-)

D.9.5. Limitations

Seethe TODO listinside packet - gi op. ¢

D.9.6. Notes

1. The"-p ./" option passed to omniidl indicates that the wireshark_be.py and wireshark_gen.py
are residing in the current directory. This may need tweaking if you place these files some-
where else.

2. If it complains about being unable to find some modules (eg tempfile.py), you may want to
check if PYTHONPATH is set correctly. On my Linux box, it is PYTHON-
PATH=/usr/lib/pythonl1.5/
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Appendix E. This Document's License
(GPL)

As with the origina licence and documentation distributed with Wireshark, this document is
covered by the GNU General Public Licence (GNU GPL).

If you haven't read the GPL before, please do so. It explains all the things that you are allowed to do
with this code and documentation.

GNU GENERAL PUBLI C LI CENSE
Version 2, June 1991

Copyright (C 1989, 1991 Free Software Foundation, Inc.

59 Tenple Place, Suite 330, Boston, MA 02111-1307 USA
Everyone is permtted to copy and distribute verbatim copies
of this license docunent, but changing it is not allowed.

Pr eanbl e

The |icenses for nost software are designed to take away your
freedomto share and change it. By contrast, the GNU General Public
Li cense is intended to guarantee your freedomto share and change free
software--to make sure the software is free for all its users. This
General Public License applies to nost of the Free Software
Foundation's software and to any ot her program whose authors conmit to
using it. (Some other Free Software Foundation software is covered by
the GNU Library General Public License instead.) You can apply it to
your programs, too.

When we speak of free software, we are referring to freedom not
price. Qur GCeneral Public Licenses are designed to nake sure that you
have the freedomto distribute copies of free software (and charge for
this service if you wish), that you receive source code or can get it
if you want it, that you can change the software or use pieces of it
in new free prograns; and that you know you can do these things.

To protect your rights, we need to nake restrictions that forbid
anyone to deny you these rights or to ask you to surrender the rights.
These restrictions translate to certain responsibilities for you if you
distribute copies of the software, or if you nodify it.

For exanple, if you distribute copies of such a program whether
gratis or for a fee, you nust give the recipients all the rights that
you have. You nust make sure that they, too, receive or can get the
source code. And you nust show themthese ternms so they know their
rights.

We protect your rights with two steps: (1) copyright the software, and
(2) offer you this Ilicense which gives you | egal pernission to copy,
di stribute and/or nodify the software.

Al so, for each author's protection and ours, we want to nmake certain
t hat everyone understands that there is no warranty for this free

software. |If the software is nodified by soneone el se and passed on, we
want its recipients to know that what they have is not the original, so
that any problens introduced by others will not reflect on the origina

aut hors' reputations.

Finally, any free programis threatened constantly by software
patents. We wish to avoid the danger that redistributors of a free
programwi || individually obtain patent licenses, in effect naking the
program proprietary. To prevent this, we have nade it clear that any
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patent nust be licensed for everyone's free use or not licensed at all

The precise terns and conditions for copying, distribution and
nodi fication foll ow.

GNU GENERAL PUBLI C LI CENSE
TERVS AND CONDI TI ONS FOR COPYI NG, DI STRI BUTI ON AND MCDI FI CATI ON

0. This License applies to any program or other work which contains
a notice placed by the copyright hol der saying it may be distributed
under the terms of this General Public License. The "Progran, bel ow,
refers to any such programor work, and a "work based on the Progrant
neans either the Program or any derivative work under copyright |aw
that is to say, a work containing the Programor a portion of it,
either verbatimor with nodifications and/or translated i nto another
| anguage. (Hereinafter, translation is included without limtation in
the term"nodification".) Each |icensee is addressed as "you".

Activities other than copying, distribution and nodification are not
covered by this License; they are outside its scope. The act of
running the Programis not restricted, and the output fromthe Program
is covered only if its contents constitute a work based on the
Program (i ndependent of having been nade by running the Program

Whet her that is true depends on what the Program does.

1. You may copy and distribute verbatimcopies of the Program s
source code as you receive it, in any nmedium provided that you
conspi cuously and appropriately publish on each copy an appropriate
copyright notice and disclainer of warranty; keep intact all the
notices that refer to this License and to the absence of any warranty;
and give any other recipients of the Programa copy of this License
along with the Program

You may charge a fee for the physical act of transferring a copy, and
you nmay at your option offer warranty protection in exchange for a fee.

2. You nay nodi fy your copy or copies of the Programor any portion
of it, thus form ng a work based on the Program and copy and
di stribute such nodifications or work under the terns of Section 1
above, provided that you also neet all of these conditions:

a) You nust cause the nodified files to carry pronmi nent notices
stating that you changed the files and the date of any change.

b) You nust cause any work that you distribute or publish, that in
whole or in part contains or is derived fromthe Program or any
part thereof, to be Iicensed as a whole at no charge to all third
parties under the terns of this License.

c) If the nodified programnnornally reads conmands interactively
when run, you nust cause it, when started running for such
interactive use in the nost ordinary way, to print or display an
announcemrent includi ng an appropriate copyright notice and a
notice that there is no warranty (or el se, saying that you provide
a warranty) and that users may redistribute the program under
these conditions, and telling the user howto view a copy of this
Li cense. (Exception: if the Programitself is interactive but
does not nornmally print such an announcenent, your work based on
the Programis not required to print an announcenent.)

These requirements apply to the nodified work as a whole. |If
identifiable sections of that work are not derived fromthe Program
and can be reasonably considered i ndependent and separate works in

t hensel ves, then this License, and its ternms, do not apply to those
sections when you distribute them as separate works. But when you

di stribute the sane sections as part of a whole which is a work based
on the Program the distribution of the whole nust be on the terns of
this License, whose permissions for other |icensees extend to the

entire whole, and thus to each and every part regardl ess of who wote it.
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Thus, it is not the intent of this section to claimrights or contest
your rights to work witten entirely by you; rather, the intent is to
exercise the right to control the distribution of derivative or
col l ective works based on the Program

In addition, nere aggregation of another work not based on the Program
with the Program (or with a work based on the Progranm) on a vol une of
a storage or distribution nedium does not bring the other work under

t he scope of this License.

3. You may copy and distribute the Program (or a work based on it,
under Section 2) in object code or executable formunder the terms of
Sections 1 and 2 above provided that you al so do one of the follow ng:

a) Acconpany it with the conplete correspondi ng machi ne-readabl e
source code, which nust be distributed under the terms of Sections
1 and 2 above on a medium custonmarily used for software interchange;

b) Acconpany it with a witten offer, valid for at |least three
years, to give any third party, for a charge no nore than your
cost of physically perfornm ng source distribution, a conplete
nmachi ne-r eadabl e copy of the correspondi ng source code, to be

di stributed under the terns of Sections 1 and 2 above on a nedi um
customarily used for software interchange; or

c) Acconpany it with the information you received as to the offer
to distribute corresponding source code. (This alternative is
all owed only for nonconmercial distribution and only if you

recei ved the programin object code or executable formwth such
an offer, in accord with Subsection b above.)

The source code for a work neans the preferred formof the work for
maki ng nodifications to it. For an executable work, conplete source
code neans all the source code for all nopdules it contains, plus any
associated interface definition files, plus the scripts used to
control conpilation and installation of the executable. However, as a
speci al exception, the source code distributed need not include
anything that is nornally distributed (in either source or binary
form wth the major conponents (conpiler, kernel, and so on) of the
operating system on which the executable runs, unless that conponent
itsel f acconpani es the executabl e.

If distribution of executable or object code is made by offering
access to copy froma designated place, then offering equival ent
access to copy the source code fromthe sanme place counts as
distribution of the source code, even though third parties are not
conpel l ed to copy the source along with the object code.

4. You may not copy, nodify, sublicense, or distribute the Program
except as expressly provided under this License. Any attenpt
otherwi se to copy, nodify, sublicense or distribute the Programis
void, and will automatically term nate your rights under this License.
However, parties who have received copies, or rights, fromyou under
this License will not have their licenses termnated so | ong as such
parties remain in full conpliance.

5. You are not required to accept this License, since you have not
signed it. However, nothing else grants you perm ssion to nodify or
distribute the Programor its derivative works. These actions are
prohibited by law if you do not accept this License. Therefore, by
nodi fying or distributing the Program (or any work based on the
Program, you indicate your acceptance of this License to do so, and
all its terms and conditions for copying, distributing or nodifying
t he Program or works based on it.

6. Each time you redistribute the Program (or any work based on the
Program, the recipient automatically receives a license fromthe
original licensor to copy, distribute or nodify the Program subject to
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these terns and conditions. You may not inpose any further
restrictions on the recipients' exercise of the rights granted herein
You are not responsible for enforcing conpliance by third parties to
this License

7. If, as a consequence of a court judgment or allegation of patent
i nfringement or for any other reason (not linmted to patent issues),
conditions are inposed on you (whether by court order, agreenment or
ot herwi se) that contradict the conditions of this License, they do not
excuse you fromthe conditions of this License. |I|f you cannot
distribute so as to satisfy sinultaneously your obligations under this
Li cense and any other pertinent obligations, then as a consequence you
may not distribute the Programat all. For exanmple, if a patent
license would not pernmt royalty-free redistribution of the Program by
all those who receive copies directly or indirectly through you, then
the only way you could satisfy both it and this License would be to
refrain entirely fromdistribution of the Program

If any portion of this section is held invalid or unenforceabl e under
any particular circunstance, the balance of the section is intended to
apply and the section as a whole is intended to apply in other

Cl rcumst ances.

It is not the purpose of this section to induce you to infringe any
patents or other property right clains or to contest validity of any
such clains; this section has the sole purpose of protecting the
integrity of the free software distribution system which is

i npl enented by public license practices. Many people have made
generous contributions to the wi de range of software distributed

t hrough that systemin reliance on consistent application of that
system it is up to the author/donor to decide if he or she is willing
to distribute software through any other system and a |icensee cannot

i mpose that choice.

This section is intended to nmake thoroughly clear what is believed to
be a consequence of the rest of this License.

8. If the distribution and/or use of the Programis restricted in
certain countries either by patents or by copyrighted interfaces, the
original copyright holder who places the Programunder this License
may add an explicit geographical distribution limtation excluding
those countries, so that distribution is permtted only in or anobng
countries not thus excluded. In such case, this License incorporates
the limtation as if witten in the body of this License.

9. The Free Software Foundati on may publish revised and/ or new versions
of the General Public License fromtime to tinme. Such new versions will
be simlar in spirit to the present version, but may differ in detail to
address new probl ens or concerns.

Each version is given a distinguishing version nunber. |f the Program
specifies a version nunber of this License which applies to it and "any

| ater version", you have the option of following the ternms and conditions

ei ther of that version or of any later version published by the Free
Software Foundation. |[If the Program does not specify a version nunber of
thideicense, you may choose any version ever published by the Free Software
Foundati on.

10. If you wish to incorporate parts of the Programinto other free
progranms whose distribution conditions are different, wite to the author
to ask for pernission. For software which is copyrighted by the Free
Sof t ware Foundation, wite to the Free Software Foundation; we sonetines
nmake exceptions for this. Qur decision will be guided by the two goals
of preserving the free status of all derivatives of our free software and
of pronmoting the sharing and reuse of software generally.

NO WARRANTY
11. BECAUSE THE PROGRAM | S LI CENSED FREE OF CHARGE, THERE IS NO WARRANTY
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FOR THE PROGRAM TO THE EXTENT PERM TTED BY APPLI CABLE LAW EXCEPT WHEN
OTHERW SE STATED | N WRI TI NG THE COPYRI GHT HOLDERS AND/ OR OTHER PARTI ES
PROVI DE THE PROGRAM "AS | S* W THOUT WARRANTY OF ANY KI ND, ElI THER EXPRESSED
OR | MPLI ED, | NCLUDI NG, BUT NOT LIM TED TO, THE | MPLI ED WARRANTI ES OF
MERCHANTABI LI TY AND FI TNESS FOR A PARTI CULAR PURPCSE. THE ENTI RE RI SK AS
TO THE QUALI TY AND PERFOCRVMANCE OF THE PROGRAM | S WTH YOU. SHOULD THE
PROGRAM PROVE DEFECTI VE, YOU ASSUME THE COST OF ALL NECESSARY SERVI Cl NG,
REPAI R OR CORRECTI ON.

12. I N NO EVENT UNLESS REQUI RED BY APPLI CABLE LAW OR AGREED TO I N WRI TI NG
WLL ANY COPYRI GHT HOLDER, OR ANY OTHER PARTY WHO MAY MODI FY AND/ OR
REDI STRI BUTE THE PROGRAM AS PERM TTED ABOVE, BE LI ABLE TO YOU FOR DAMAGES,
I NCLUDI NG ANY GENERAL, SPECI AL, | NCI DENTAL OR CONSEQUENTI AL DAMAGES ARI SI NG
QUT OF THE USE OR | NABI LI TY TO USE THE PROGRAM (I NCLUDI NG BUT NOT LI M TED
TO LOSS OF DATA OR DATA BEI NG RENDERED | NACCURATE OR LOSSES SUSTAI NED BY
YOU OR THI RD PARTIES OR A FAI LURE OF THE PROGRAM TO OPERATE W TH ANY OTHER
PROGRAMS), EVEN | F SUCH HOLDER OR OTHER PARTY HAS BEEN ADVI SED OF THE
PCSSI Bl LI TY OF SUCH DANVAGES.

END OF TERMS AND CONDI TI ONS
How to Apply These Terns to Your New Prograns

If you devel op a new program and you want it to be of the greatest
possi bl e use to the public, the best way to achieve this is to nmake it
free software which everyone can redistribute and change under these terns.

To do so, attach the followi ng notices to the program It is safest
to attach themto the start of each source file to nost effectively
convey the exclusion of warranty; and each file should have at |east
the "copyright" line and a pointer to where the full notice is found.

<one line to give the programis nane and a brief idea of what it does.>
Copyright (C <year> <nane of author>

This programis free software; you can redistribute it and/or nodify
it under the ternms of the GNU General Public License as published by
the Free Software Foundation; either version 2 of the License, or
(at your option) any later version.

This programis distributed in the hope that it will be useful,
but W THOUT ANY WARRANTY; wi thout even the inplied warranty of
MERCHANTABI LI TY or FI TNESS FOR A PARTI CULAR PURPOSE. See the
G\U General Public License for nore details.

You shoul d have received a copy of the GNU General Public License
along with this program if not, wite to the Free Software
Foundation, Inc., 59 Tenple Place, Suite 330, Boston, MA 02111-1307 USA

Al so add informati on on how to contact you by electronic and paper mail .

If the programis interactive, make it output a short notice like this
when it starts in an interactive node:

Ghonovi si on version 69, Copyright (C year nane of author

Gnonovi si on cones with ABSOLUTELY NO WARRANTY; for details type "show w .
This is free software, and you are welcone to redistribute it

under certain conditions; type show c' for details.

The hypot heti cal commands “~show w and “show ¢' shoul d show the appropriate
parts of the General Public License. O course, the comrands you use nay
be call ed sonething other than “show w and “~show c'; they could even be
nouse-clicks or menu itens--whatever suits your program

You shoul d al so get your enployer (if you work as a progranmer) or your
school, if any, to sign a "copyright disclaimer” for the program if
necessary. Here is a sanple; alter the names:
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Yoyodyne, Inc., hereby disclains all copyright interest in the program
“Gnonovi sion' (which nakes passes at conpilers) witten by James Hacker.

<signature of Ty Coon>, 1 April 1989
Ty Coon, President of Vice

This General Public License does not permt incorporating your programinto
proprietary progranms. |If your programis a subroutine library, you nay
consider it nmore useful to permt linking proprietary applications with the
l[ibrary. If this is what you want to do, use the GNU Library GCeneral

Publ i c License instead of this License.
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